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Welcome

Welcome to the Claris Emailer application from Claris Corporation. 
Claris Emailer is designed to help you create, send, receive, and manage 
electronic mail easily and effectively. 

This user’s guide describes how to use Claris Emailer. With 
Claris Emailer, you can:

1 send and receive messages and files using America Online, the 
AppleLink communication network, Claris OfficeMail software, 
CompuServe, an Internet service provider, or RadioMail

1 schedule automated connections to email services, which can reduce 
costs by connecting during off-peak hours

1 quickly change and store the local access numbers and connection 
information you need to use when you travel

1 store sent and received messages and files

1 keep an address book of individuals and groups

1 automatically file, prioritize, reply to, or forward messages

What’s new?
We’ve made some great improvements to Claris Emailer with this 
release. The following list summarizes feature additions and 
enhancements that make Claris Emailer the very best way to manage 
your email.

1 The look and feel of Claris Emailer has been completely redesigned, 
making it more consistent and easier to use.

1 Claris Emailer now includes a comprehensive context-sensitive 
onscreen Help system.

1 Messages are now stored in a single database, saving you disk space. 
(You can still save individual messages as text files, if you want.)

1 A spelling checker has been added, making it quick and easy for you 
to locate and correct any spelling errors before sending outgoing 
messages.

1 Hierarchical folders (subfolders nested within folders) now let you 
set up an organizational structure for your saved messages.
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1 Mail actions are more powerful than ever. You can now apply 
multiple mail actions to a single message, set up automatic replies 
that include enclosures, and automatically run AppleScript 
application programs using mail actions.



Chapter 1:  Getting help

This user’s guide provides everything you need to know about using and 
getting the most out of Claris Emailer. This chapter describes how to: 

1 register your copy of Claris Emailer by phone or mail

1 get information from customer support at Claris Corporation

1 find out where to begin, if you’re new to Claris Emailer or if you have 
used previous versions of Claris Emailer

1 use the Claris Emailer Help system

1 get additional help from other documentation

Registration and customer support
Please take the time to complete and mail the product registration card 
that is included in this package. To register by phone, from the U.S. call 
1 (800) 356-6657 or from Canada call 1 (800) 361-6075.

For information about customer support, refer to our Web site at 
http://www.claris.com. U.S. and Canadian customers can also refer to 
the Claris Service Directory included with the software or contact Claris 
at 1 (800) 965-9090. For customers outside of the U.S. or Canada, refer 
to the Technical Support brochure included with the software.

How to begin
This user’s guide is designed to get you started fast, whether you’re a 
new or experienced Claris Emailer user.

If Do this

You’re new to 
Claris Emailer

Become familiar with Macintosh techniques, such as using the mouse 
and saving documents. Refer to the documentation that came with your 
computer for this information.

Read the rest of this chapter to learn how to use this user’s guide and 
Claris Emailer software’s new Help system together.

Then read chapter 2, “Background and basics” for overviews of both the 
Internet and how Claris Emailer works. Start Claris Emailer (see 
“Starting Claris Emailer” on page 2-9 if you need help) and use Easy 
Setup to configure your account and connection information. Then refer 
to onscreen Help or chapters 3 through 10 for instructions on using 
Claris Emailer. You can look up technical terms you don’t recognize in 
the glossary.
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Using Claris Emailer Help
Claris Emailer Help is comprehensive, completely documenting all 
Claris Emailer features, keyboard shortcuts, and glossary terms. When 
you use Help, you work in two windows: the Help navigator window 
and the Help topic window.

The Help navigator window gives you quick access to the Help contents, 
the index, and a Find feature that lets you search onscreen Help for 
specific words or phrases.

The Help topic window displays information that helps you use 
Claris Emailer. For convenience, the Help topic window also contains a 
navigation bar to make it easy to move from topic to topic.

Opening Claris Emailer Help
To open Help when Claris Emailer is running, choose a menu item from 
the  menu:

You’ve used 
Claris Emailer 
before

Read the Welcome chapter, to find out what’s new in Claris Emailer.

Read the rest of this chapter to learn how to use this user’s guide and the 
new Claris Emailer Help system.

Start Claris Emailer. Then review the second half of chapter 2 beginning 
on page 2-8 to see an overview of improvements we’ve made to 
Claris Emailer.

As necessary, review onscreen Help topics and the chapters in this book 
to learn more about specific procedures, and use the glossary to look up 
technical terms you don’t recognize.

Choose To see

Claris Emailer Help Contents Topic titles in an expandable table of contents

Context-sensitive Help A topic that describes the active window in Claris Emailer. 
If no onscreen Help topic exists for the active window, you 
see the onscreen Help Contents.

Claris Emailer Help Index An alphabetical list of index keywords

If Do this
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When you first open onscreen Help, the Help topic window is large. You 
can make it smaller (and easier to use side-by-side with the 
Claris Emailer application) by dragging the size box in the lower-right 
corner of the window.

Managing Claris Emailer Help
Here are some ways to work with Claris Emailer Help and the windows 
on your screen:

Using the Help Contents
The Claris Emailer Help Contents in the Help navigator window is a 
list of Help topics organized in logical sections, like the table of 
contents in a book. 

To use the Help Contents:

1. If you are not viewing Help, choose Claris Emailer Help Contents from 
the  menu.

If you are viewing a topic, click the Contents button in a Help topic 
window.

If you are viewing the Help navigator window, click the Contents tab.

  

To Do this

Go back to work in 
Claris Emailer while Help is 
running

Click a Claris Emailer window, or choose Claris Emailer 
from the application menu (at the right of the menu bar).

Move a window Drag the window’s title bar.

Switch between the Help topic 
window and a Claris Emailer 
window

Click the window you want to work with.

Hide onscreen Help and leave it 
running

Click a Help window, and then choose Hide QuickHelp from 
the application menu (at the right of the menu bar). To 
show Help again, choose QuickHelp from the application 
menu.

Quit onscreen Help Click the close box in all open Help windows or choose 
Quit from the File menu.

Click to display the Help Contents
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2. In the Contents screen, you can double-click section titles to see any 
subtopics, and then double-click a subtopic title to display a Help 
topic window containing the information you want.

Using the Help index
Claris Emailer Help comes with a list of keywords to help you find the 
topics containing the information you want. Keywords are significant 
words and phrases that identify the subject matter of a topic. 

To use the Help index:

1. If you are not viewing Help, choose Claris Emailer Help Index from 
the  menu.

If you are viewing a Help topic, click the Index button in the Help 
topic window.

If you are viewing the Help navigator window, click the Index tab in 
the Help navigator window.

  

2. In the Index screen, type all or part of the keyword to find.

  

You see the topics associated with the keyword in the list. 

Double-click to display
this topic

Double-click to display
a list of Help topics

Click to close the Help
navigator window when
a Help topic is displayed

Click to print a topic
without opening it

Click to display the 
highlighted topic

Drag to scroll through the 
section and topic list

Click to display the Help index

Type the first few letters of
the entry you’re looking for
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3. Double-click the topic you want (or select the topic you want and 
click Display).

Finding topics with specific text
You can search for onscreen Help topics that contain a specific word or 
phrase or a combination of words.

To search for text in the Help system:

1. If you are viewing the Help navigator window, skip to step 2.

If Help is not running, choose Claris Emailer Help Contents or 
Claris Emailer Help Index from the  menu to display the Help 
navigator window. 

If you are viewing a Help topic, click the Contents or Index button in 
the Help topic window to display the Help navigator window.

2. Click the Find tab in the Help navigator window.

  

Double-click the topic you want To browse the index, scroll 
through the alphabetical list

Click to close the Help
navigator window when
a Help topic is displayed

Click to display the 
highlighted topic

Click to display the Find screen
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3. Construct your Find statement by choosing operators from the pop-up 
menus and typing a word for the operator to act on in the text boxes.

  

For example, you can find topics that contain a specific word or 
topics that do not contain a specific word. You can also specify that 
the characters you type occur anywhere in a word or at the beginning 
of a word.

Important Make sure you type only one word in each text box. 
Quotation marks (“ ‘) and asterisk (*) characters are not allowed.

4. Click More Choices or Fewer Choices to make your Find statement as 
specific as you like.

  

5. Click Options to:

1 set the number of words Claris Emailer Help should search as a set 
when you use the Nearby operator in your Find statement

1 sort the results of your Find statement

1 ignore word stemming (different grammatical forms of a word)

1 choose additional files to search besides Claris Emailer Help

Type the word you 
want to search for

Choose an operator
from the pop-up menu

Choose an operator
from the pop-up menu

Type additional words 
to specify your Find 
statement further

Click to expand the entry area
to specify more conditions Click to set options for 

Find statementsClick to collapse the entry area 
and specify fewer conditions
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6. Click Search.

Note To activate the Search button, you must close any empty 
Choices fields by clicking Fewer Choices.

Claris Emailer Help displays a list of topics that meet your Find 
statement criteria.

  

7. Scroll through the list to find a topic title that contains the information 
you are looking for.

8. Select a topic and click Display (or double-click the topic) to view the 
topic.

The words you specified in your Find statement are highlighted in the 
topic.

Click to display a list of 
topics that meets this 
criteria

Double-click to display
the topic

Click to display the 
highlighted topic

Click to close the Help
navigator window when a

Help topic is displayed
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Using the Help topic window
You can also navigate in Claris Emailer Help by clicking buttons and 
underlined text in the Help topic window.

To return to any topic you viewed during a Help session, click in a Help 
topic window, choose History Window from the Options menu, and then 
double-click the topic title you want to see (or select a topic in the list 
and click View Topic).

To remove topics from the History window list, click Clear.

The title of the
current topic

Drag the note 
icon into a 
topic and 
type your 
own notes

Click to print the current topic

Click to display the Help index

Type a 
word you 
want to find 
in the index 
and press 
Return

Click to return to the last topic viewed

Click solid
underlined text to

jump to a topic
related to the
current topic

Click to display the
Help contents

Click to move to the next or previous topic

Drag to resize 
the onscreen 
Help window

Click dotted
underlined text to

see a glossary
definition
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Displaying toolbar buttons and reading definitions
When a toolbar button is described in an onscreen Help topic, the name 
of the button has a dotted underline. Click the underlined text to display 
a picture of the button.

When a word is defined in a Help topic, it has a dotted underline. To 
display the definition of a word, click the text with a dotted underline.

 

Claris Emailer Help displays a pop-up definition.

  

The pop-up definition stays open until you click again anywhere on your 
screen.

To display an alphabetical list of all glossary terms, click the Glossary 
topic title in the onscreen Help contents.

Displaying Help for a dialog box or window
You can quickly access a Help topic about the currently displayed 
window of the Claris Emailer application.

To see the Help topic for a window, make sure the dialog box or window 
that you need help with is selected, and then press 2-? or the Help key, 
or choose Context-sensitive Help from the  menu.

If no context-sensitive Help exists for the active window, you see the 
onscreen Help Contents.
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Using tool tips
In the Claris Emailer application, tool tips display labels for buttons in 
the toolbar.

To display tool tips, position the mouse pointer over a button in the tool 
bar and pause for a few seconds. (Do not click the mouse button.)

A descriptive label appears below the button.

Displaying keyboard shortcuts
You can display keyboard shortcuts for commonly used buttons in the 
Claris Emailer application and onscreen Help. Keyboard shortcuts are 
key sequences that you can press instead of choosing, selecting, and 
clicking software items with your mouse.

To display keyboard shortcuts, make sure that a Claris Emailer 
application dialog box or Help window is selected and hold down the 
2 key.

In a few seconds, keyboard shortcuts appear on commonly used buttons 
in the dialog box or window.

To use a keyboard shortcut, hold down the keys simultaneously, not in 
sequence. For example, to enter , hold down the Option, 2, and K 
keys at the same time.

This symbol Means

2 Press the 2 key

Press the Shift key

Press the Option key

Position the mouse
pointer and pause

Tool tip

When you hold down the 2 key, 
you see keyboard shortcuts
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For a summary of keyboard shortcuts, see the end of this guide. For a list 
of all keyboard shortcuts, see onscreen Help.

Getting additional help
Use Claris Emailer Help to get information on these additional tasks.

Use the following additional documentation when installing and using 
Claris Emailer. 

For information on
Choose Claris Emailer Help Index from 
the  menu, and then type

Printing an onscreen Help topic printing
     onscreen Help topics

Adding your own notes or instructions to 
a topic

notes, adding to onscreen Help topics

Creating bookmarks for topics you use 
often

bookmarks, in onscreen Help

Copying all or part of a topic to an 
application that supports text, to gather 
onscreen Help information you use often

topics
     onscreen Help:copying content

Setting Help preferences to customize the 
way you use onscreen Help

preferences
     in onscreen Help

Use the To

Glossary in this user’s guide Look up technical terms that you don’t recognize

Claris Emailer Getting Started 
guide

Learn how to install Claris Emailer and get an overview of 
working with the application

Important Information file in the 
Claris Emailer Folder

See late-breaking information about Claris Emailer

Claris Emailer FAQ files in the 
Support Files folder in the 
Claris Emailer Folder

See a list of answers to frequently asked questions about 
Claris Emailer



Chapter 2:  Background and basics

Claris Emailer is an electronic mail (email) application that lets you 
send, receive, and manage email messages. You can exchange email 
with other email users across the hall or around the globe. This chapter 
provides brief background information about the Internet—the 
worldwide network of computers over which email travels. It also gives 
you an overview of the Claris Emailer application. (See the glossary for 
more definitions of Internet terms.)

Note You need not understand the Internet background concepts 
presented here to use Claris Emailer. However, if you are new to the 
Internet, you might find the discussion in this chapter interesting and 
informative.

What is the Internet?
The Internet is an enormous network of computers joined by data lines 
that communicate using a common software standard. These computers 
are located all over the world. Computers use a client/server architecture 
to communicate with each other over the Internet.
















Client

Client
Server stores 

information

Response to request

Request for information

Client requests 

information
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A server (or host) computer stores or processes information and 
“serves” other computers connected through a network. A client 
computer requests information or services from a server computer. 
When you access the Internet—for example, by browsing the World 
Wide Web or by sending and receiving email—your computer is a client 
to the Internet server computer that you are accessing.

What is an email service?
An email service sends and receives Internet email messages. 
Claris Emailer works with two types of services:

1 online services, which maintain and manage their own databases of 
proprietary information that you can access. These services also link 
you to the Internet. Examples of online services are America Online 
and CompuServe.

1 Internet service providers (ISPs), which only provide access to the 
Internet. Examples of Internet service providers are Netcom and the 
ClarisLink service (available with Claris OfficeMail software).

Understanding how computers communicate
Computers linked by the Internet use protocols to communicate. 
Protocols are conventions for communication between computers. 
Protocols define how messages are passed on the Internet and make it 
possible for different platforms (for example, a Macintosh running the 
Mac OS and a PC running Windows) to communicate with each other. 

Online services often use proprietary protocols. Internet service 
providers use two standard protocols for electronic mail transfer: 
SMTP (Simple Mail Transfer Protocol) and POP (Post Office Protocol). 

Simple Mail Transfer Protocol (SMTP)
SMTP is a protocol for exchanging email between Internet servers. Most 
mail servers on the Internet use this protocol to communicate with each 
other. 
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SMTP servers use the domain name system to route email on the 
Internet. (For more information about domain names, see “How do 
computers find each other?” on page 2-4.) Outgoing messages that you 
send from Claris Emailer go directly to the SMTP server at your Internet 
service provider. The SMTP server then transfers your messages to 
SMTP servers at other locations on the Internet.

Post Office Protocol (POP)
POP is a protocol for client computers, such as your Macintosh or a PC, 
to access a POP server that manages your email account information. 
The POP server software has no awareness of the Internet.

How SMTP and POP servers work together
The SMTP server software transfers your outgoing email to other SMTP 
servers on the Internet. It also receives incoming messages addressed to 
you and stores them in a file. After the SMTP server software stores your 
incoming messages in a file, the POP server software can also access 
them.

When you log in to your Internet service provider with Claris Emailer, 
you communicate with your POP server. The POP server collects your 
messages from the storage area and lets Claris Emailer download them 
to your computer.










SMTPSMTP

Internet service provider

POPPOPPOPPOP SMTPSMTP

POPPOPSMTPSMTP

Internet service 

provider

Internet service 

provider

Your computer
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Sometimes the SMTP server software and POP server software at your 
Internet service provider are located on different computers and 
sometimes they are located on the same computer. 

When you set up Claris Emailer for use with an Internet service 
provider, you must specify both your SMTP and POP server information 
so that your messages can be routed correctly.

How do computers find each other?
Each computer linked by the Internet has a unique address identification 
number. Because it’s difficult to remember numbers, the Internet uses a 
domain name system to associate words with these identification 
numbers. For example, the email address for the electronic product 
announcement list server at Claris Corporation is:

announce@claris.com

The SMTP servers on the Internet need each part of an email address to 
determine where to send a message. 

How Claris Emailer retrieves and sends email
The way Claris Emailer retrieves and sends email depends on how you 
access email—using an email service provider or Claris OfficeMail. 

Note For a connection to work, you must turn on your computer (and 
modem, if applicable) and start Claris Emailer. If you schedule a 
connection for a time you’ll be away from the computer, be sure to leave 
your computer and modem on and leave Claris Emailer running.

This part of the 
sample address Identifies

announce The account name or “user identification” for the list server

@ The at sign, which indicates “at the following location”

claris.com The domain name of the destination
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Communicating with email services
You send and receive email through a connection to one or more email 
services, such as America Online, CompuServe, or an Internet service 
provider. The two most common types of connections use a modem or 
a network. You can set a connection schedule and have Claris Emailer 
connect periodically to retrieve any messages waiting for you, or you 
can connect manually at any time. After Claris Emailer downloads your 
messages from your email service provider, it disconnects so your time 
connected to a service provider is kept to a minimum.

For more information about modem connections to your Internet service 
provider, see “Setting up your modem-based TCP/IP connection” on 
page 3-21, the FAQ files located in the Support Files folder (in the 
Claris Emailer Folder), and the Important Information file in the Claris 
Emailer Folder.

You can connect manually, or set up regularly scheduled connections.

For more information about See

Connecting to services Chapter 4, “Connecting to email services”

Setting up connection 
information for email service 
providers

Chapter 3, “Setting up Claris Emailer”

Setting up connection schedules “Scheduling account connections” on page 4-3

Outgoing mail

Incoming mail

CompuServeCompuServe

InternetInternet

AppleLinkAppleLink

RadioMailRadioMail

Modem

America OnlineAmerica Online



2-6 Claris Emailer User’s Guide
Claris Emailer sends your messages to the email service providers that 
you specify. Those service providers forward the messages to one or 
more destinations. For example, if you have an account with 
CompuServe, you can send a message to another CompuServe user or to 
recipients at other destinations, such as America Online.

Communicating with Claris OfficeMail
Claris OfficeMail is LAN-based email server software. Local email 
clients (users on the physical OfficeMail network) access the OfficeMail 
server through the SMTP and POP protocols. Claris OfficeMail 
communicates with ClarisLink and other email services through the 
UUCP protocol.

Claris OfficeMail collects your email from other local OfficeMail users 
and from the Internet. Your messages wait on the Claris OfficeMail 
server until Claris Emailer downloads them to your computer.

If Claris Emailer is running, it automatically collects your messages 
from Claris OfficeMail as soon as they are received by OfficeMail.

Outgoing mail

InternetInternet

CompuServeCompuServe

America OnlineAmerica Online

AppleLinkAppleLink

RadioMailRadioMail




Your Service

MyAccount@compuserve.com

Recipient's 

service or

"destination"

Recipients

Jane Smith

Michelle 

Cannon

Yumiko Kitagawa

Sophie 

Tang

Elfriede Lechner

Kentaro Ogawa

Daniel 

Bradbury
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Note In some situations, Claris Emailer cannot collect your messages 
automatically. For more information, see “Receiving mail via 
Claris OfficeMail” on page 6-10.

When you use Claris Emailer with Claris OfficeMail, you send 
messages to other Claris OfficeMail users by entering only their 
Claris OfficeMail user names in the address area. If you have 
Claris OfficeMail set up to access the Internet as well, you send and 
receive Internet mail through Claris OfficeMail software’s own Internet 
service provider, ClarisLink, or your own UUCP service provider.

When addressing messages bound for the Internet, you must specify a 
full Internet address. You can store these addresses in the Claris Emailer 
Address Book for quick access.

Claris Emailer







Claris Emailer

Claris Emailer




Claris Emailer







Claris OfficeMail

(server with modem)




Internet 
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How message enclosures are sent
Because of limitations of some Internet email servers, email messages 
can reliably transfer only text, or, more specifically, a limited ASCII 
character set. Electronic mail applications, like Claris Emailer, provide 
encoding formats to transfer your spreadsheet, graphics, word 
processing, or multimedia files with their original text and formatting 
instructions intact. Claris Emailer also compresses your files to save 
dial-up time and disk storage space.

Working with Claris Emailer
The following sections provide an overview of Claris Emailer. For 
detailed information on any of the Claris Emailer features described in 
these sections, see the remaining chapters in this guide and the 
Claris Emailer onscreen Help system.

Note Before you can use Claris Emailer to work with email, you must 
set up your service and account information. For more information about 
service and account settings, see chapter 3, “Setting up Claris Emailer.”

Backing up your message database
Claris Emailer stores your email messages in a database. You should 
periodically back up this database to make sure that you can access your 
messages, should you experience a failure on your computer. 

To back up your message database:

1. Quit Claris Emailer.

2. Locate the Mail folder in the Claris Emailer Files folder in the 
Claris Emailer Folder.

3. Select the Mail folder, and then copy it by choosing Duplicate from the 
File menu in the Finder system software.

4. Store your duplicate in a safe place.

To restore your messages from a backup:

1. Quit Claris Emailer.

For more information about See

Encoding formats Appendix A, “Encoding enclosures”

File compression Appendix B, “Compressing enclosures”
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2. Drag the old Mail folder to the trash.

3. Select your Mail folder backup, and then choose Duplicate from the 
File menu in the Finder operating system to copy it.

4. Rename the copy Mail and drag it into the Claris Emailer Files 
folder.

5. Start Claris Emailer.

Starting Claris Emailer
To start Claris Emailer, double-click the Claris Emailer icon.

The toolbar, Browser window, and Connection Status window appear.

Working with the Browser
The Browser is where you access messages that you have sent and 
received. You can close the Browser while you work in other 
applications, leaving Claris Emailer running in the background. Later, 
you can open the Browser to check incoming mail.

When you click a folder in the Browser, you see all the messages 
contained in that folder. Several folders appear by default, and you can 
create your own folders. All folders can contain both incoming and 
outgoing messages. 

Click to close the Browser

Scroll to see 
more information

List of folders for
message storage

Messages in a
selected folder are

displayed here

Click any column to sort messages
Drag to widen the

folder list
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Icons on the folders give you information about the contents of the 
folders.

Working with the toolbar
The toolbar is a collection of buttons that are shortcuts for the most 
common tasks in Claris Emailer. Tool tips identify the toolbar buttons.

To display tool tips, position the mouse pointer over a toolbar button and 
pause briefly. 

You can display the toolbar in two sizes. Claris Emailer displays 
the large toolbar by default. To display the small toolbar, click the 
zoom box on the toolbar.

Tip You can display keyboard shortcuts for toolbar buttons (and other 
buttons in Claris Emailer windows) by selecting the toolbar or a window 
and holding down the 2 key. For more information, see “Displaying 
keyboard shortcuts” on page 1-10.

The action of each toolbar button is described in the following table.

This icon Indicates

There are unread or unsent messages in the folder or there is an unread 
connection log or auto-file log in the Logs folder.

There are unread or unsent messages in the Deleted Mail folder.

This button Does this

Connects to an email service to send or retrieve messages

Displays a pop-up menu of folders that contain unread or unsent 
messages. You can choose a folder from the list to display its messages 
in the Browser.

Click to close 
toolbar

Position pointer 
and pause to 
display tool tipsClick to shrink or

expand toolbar
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Toolbar buttons with triangles contain menus of commands. 

1 If you click a button with a triangle, Claris Emailer performs the 
default action for the button. The default action is displayed in bold 
text in the menu. For example, if you click the  button in the 
toolbar, you see the Connect Now dialog box.

1 If you hold down the mouse button on a toolbar button containing a 
triangle, you see a menu of commands. For example, if you want to 
connect with the same settings as you did during your last connection 
(bypassing the Connect Now dialog box), you choose Connect Again 
from the Connect Now button menu.

Opens the current error log (the  icon flashes when a connection error 
is received or generated by Claris Emailer)

Creates a new message

Replies to a message that someone sent you

Forwards a message to another person

Files a message in a different folder

Opens the Address Book

Prints the selected open message or one or more messages selected in a 
message list

Finds a message in a list, a list of messages that contain text that you 
specify, or specified text in an open message

Deletes a selected item

This button Does this

Choose to connect with
the same settings used
for the last connection



2-12 Claris Emailer User’s Guide
Working with outgoing messages
You can create a new message, reply to a message that someone has sent 
to you, or forward an existing message.

Click the  button in the toolbar or choose New Message in the Mail 
menu to create a new message. Use the message window to compose and 
address new messages and to reply to and forward existing messages.

You can use the spelling checker to correct spelling errors in your 
messages. The spelling checker compares words in an outgoing message 
to a dictionary of correctly spelled words. When the spelling checker 
finds a word that is not in the selected dictionaries, it suggests 
alternatives. For more information about the spelling checker, see 
“Using the spelling checker” on page 5-15.

You can enclose files with messages you send by clicking the triangle 
next to the  icon (to expand the file enclosure area), and then choosing 
a file to enclose. For more information about enclosures, see “Enclosing 
files” on page 5-8.

When you’re finished composing your message, you can use the buttons 
in the upper-right area of the message window to send or save it. You 
can click the Send Now button to close the message and send it right 
away. Or, you can click the  button and then click the Queue Message 
button to close and save the message. When you save a message to the 
message queue, it will be sent at the next connection. 

Click to open the
file enclosure area

Click to send the
message right away

Click to switch button at right between
Queue Message and Save As Draft
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Note The Queue Message button appears by default, so you might not 
need to click the  button to use it. 

If you’re not finished with your message, you can click the  button, 
and then click the Save As Draft button to save the message without 
sending it or scheduling it to be sent at the next connection.

When you save a message to the message queue or as a draft, status icons 
appear next to the message in the message list.

For detailed information about the outgoing message status column and 
icons, see “Checking the status of messages you send” on page 5-21.

Speeding address entry using destinations
Because Internet addressing can be confusing, Claris Emailer lets you 
define destinations that help you enter recipient addresses in messages 
and create or change contact entries in the Address Book. Destinations 
also make Internet addresses more readable when viewed in 
Claris Emailer.

For example, aol.com is the Internet address for America Online. You 
can choose the America Online destination from a pop-up menu instead 
of typing the actual Internet address in your message or Address Book. 
Claris Emailer substitutes the correct address for America Online when 
it sends your message.

Claris Emailer comes with a variety of common destinations, but you’ll 
find it helpful to create more destinations for the places to which you 
frequently send electronic mail. For more information about creating 
your own destinations, see “Customizing the destinations list” on 
page 10-1.

These icons give you 
information on the status of 
the message
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Viewing your messages
When new messages are received by Claris Emailer, you hear a tone (by 
default). Incoming messages are stored in the In Box folder in the 
Browser by default, but you can save messages to any folder. You can 
also direct messages to folders by creating mail actions that 
automatically file incoming messages.

Whenever you have new mail, you see changes in the Browser’s folder 
list:

1 The name of the folder in which the incoming message is filed is 
typeset in bold to indicate that there are one or more unread messages 
in the folder.

1 An icon appears on the folder icon telling you that new email is in that 
folder.

You can view a message by clicking a folder to open it (if its contents 
are not already displayed) and then double-clicking the message in the 
Browser.

For more information about filing messages, see “Filing messages from 
a message list” on page 7-8. For more information about mail actions, 
see the next section and chapter 9, “Using mail actions.”

Double-click 
to display a 
message

Click a folder once
to see the messages

it contains

Click a triangle to
see sub-folders
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Working with mail actions
You can use mail actions to manage incoming messages automatically. 
Mail actions can be useful if you receive large volumes of email, 
because they organize incoming messages for you before you read them.

Mail actions execute tasks, such as filing messages, based on criteria 
you specify. For example, you can create mail actions to:

1 set incoming messages to different priorities

1 file messages containing specific text in a particular folder

1 automatically reply to specific messages with text you prepare in 
advance, such as a note saying that you’re on vacation and will reply 
when you return

Claris Emailer comes with a preset mail action named “Vacation” to 
help you get started. You can use this mail action as it is or study it and 
then create custom mail actions of your own. For more information 
about mail actions, see chapter 9, “Using mail actions.”
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Working with the Address Book
The Address Book stores addresses for individual contacts and groups. 
You can use these addresses to quickly address outgoing messages.

You can also consolidate several addresses in the Address Book into a 
group. When you send a message to a group, every recipient in the group 
receives the message.

You can find specific addresses in the Address Book by typing a few 
characters in the Filter text box. Claris Emailer finds only those addresses 
that contain the specified characters in the recipient’s name, description, 
or address fields. For more information, see “Selecting entries in the 
Address Book” on page 8-14.

Printing one or more messages
To print messages, first select them in the Browser or open them. Then 
click the  button in the toolbar or choose Print from the File menu. 
For more information, see “Printing messages” on page 7-10.

Contact with one address

Group address

Contact with more than one
address (click the triangle to

show or hide additional
addresses)
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Filing incoming and outgoing messages
You can file both incoming and outgoing messages by:

1 using the  button in the toolbar to file one or more selected 
messages in an existing folder or create a folder in which to file the 
message(s)

1 using the  button in the message window to file the open message 
in an existing folder or create a folder in which to file the message

1 dragging messages to a folder in the Browser

1 using a mail action to file messages automatically

 

For more information about filing and viewing filed messages, see 
“Filing messages from a message list” on page 7-8.

Working with Macintosh drag and drop
Claris Emailer supports Macintosh drag and drop, a technique you can 
use to move a copy of an item (such as an address or enclosure) to 
another area on your computer. For example, with Macintosh drag and 
drop, you can drag an address from the Address Book to the address area 
of an outgoing message.

Macintosh drag and drop comes with System 7.5. If you are using an 
earlier system version, Macintosh drag and drop is installed 
automatically when you install Claris Emailer.

Drag a message to a folder to file it
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If your system has the System 7.5 Clipping Extension installed, you can 
also drag an address from Claris Emailer to your desktop to create a 
text clipping. A text clipping is a file that you can drag from the desktop 
into another document, such as an outgoing message. You can rename 
text clippings to reflect their content. 

Tip You can use text clippings to save and reuse addresses or message 
text.

You can use drag and drop in Claris Emailer to drag the following items.

You can drag For more information, see

Addresses 1 “Addressing messages using Macintosh drag and drop” on page 5-6

1 “Dragging an address to the Address Book” on page 8-5

1 “Dragging addresses to a group” on page 8-12

1 “Converting addresses in your Address Book to URLs” on 
page 8-16

Text 1  “Dragging text in an outgoing message” on page 5-14

Enclosures 1 “Dragging an enclosure to a message” on page 5-10

1 “Moving an enclosure” on page 6-6

1 “Deleting an enclosure” on page 6-6

Messages 1 “Filing messages from a message list” on page 7-8



Chapter 3:  Setting up Claris Emailer 

Before you can send and receive email with Claris Emailer, you must set 
up your service and account information. The best way to set up or 
change your service or account settings is by using the Easy Setup 
assistant in the Setup menu.

The Easy Setup assistant prompts you for your service information, 
helps you set up account information, and lets you define a connection 
schedule. This chapter describes the email service and account 
information that you enter as you work through the Easy Setup screens. 

You can also choose Service Providers from the Setup menu to add or 
modify service information, or you can choose Accounts from the Setup 
menu to add or modify account information.

Note You cannot use Easy Setup to set up AppleLink service and 
account information. Instead, you must use the Service Providers and 
Accounts items in the Setup menu for setting up AppleLink.

For information about setting up a service connection schedule, see 
chapter 4, “Connecting to email services.”

Understanding email service setup
There are six types of email service providers that you can connect to 
using Claris Emailer:

Type of service Description

America Online An online service that offers access to its own proprietary 
databases of information and provides Internet email service.

AppleLink An online service. The Easy Setup assistant is not available for 
setting up AppleLink service and account information.

Claris OfficeMail A local area network-based email service that works with 
Claris Emailer. You can use Claris OfficeMail alone to send and 
receive messages to other OfficeMail users connected to the 
local network, and you can use Claris OfficeMail with 
ClarisLink or another UUCP service provider to send and 
receive Internet mail.

CompuServe An online service that offers access to its own proprietary 
databases of information and provides Internet email service.
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Important Claris Emailer does not provide email service by itself. You 
must have an account with a service in order to connect to it to send and 
receive email.

Claris Emailer needs two kinds of service information:

1 The service settings tell Claris Emailer how to reach the selected 
email service provider. For example, for some services you must 
provide information about your modem and the phone number to dial. 
You might have multiple connections to a service if you connect to 
the service from more than one location, such as at home and at work.

1 The account settings store your email user name, password, and 
account options, if applicable. You might have more than one account 
with a particular service if more than one person uses this copy of 
Claris Emailer to connect to the service, or if you manage more than 
one account with the service.

Setting up service information
The best way to enter or change your email service information in 
Claris Emailer is by using the Easy Setup assistant. Easy Setup leads you 
through the required service and account setup information for each 
service you select. 

Easy Setup appears the first time you start Claris Emailer, or you can use 
it later by choosing Easy Setup from the Setup menu.

To set up service information without Easy Setup:

1. Choose Service Providers from the Setup menu.

Internet service provider A service that offers access to the Internet, providing a dial-up 
number for you to call when you want to connect. These 
organizations typically do not provide any proprietary databases 
of information, but you can send and receive email messages 
through them.

RadioMail An online service that offers access to Internet email service.

Type of service Description
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You see the Services List window.

2. In the Services List window, double-click the entry for the service 
you want to set up.

You see the Service Entry dialog box for the selected service.

Note In this example, you see the America Online Service Entry dialog 
box. The Service Entry dialog box is unique for each email service; 
some Service Entry dialog boxes require fewer connection settings than 
America Online.

3. Add a connection or change an existing connection setup as follows:

1 To add a new connection click Add, and type the name for a new 
connection.

1 To change a connection, click the connection name in the list.

Double-click a service
type to set it up

Click next to the
connection you want
used by default when

you connect to America
Online

Select to activate this service 
during connections

Click to add a new
connection to this service

Change connection 
settings as described in 
the service-specific 
sections that follow
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4. Type or change the connection settings as needed (see the table at the 
end of this section).

5. Click in the  column in the Connection list to indicate the default 
connection settings that you want Claris Emailer to use when 
connecting to the service. 

6. Click Done.

To disable an email service, uncheck Connect to this service in the Service 
Entry dialog box.

Use the information in the following table to locate the required 
connection information for your service provider.

Setting up account information
The best way to enter or change your account information in 
Claris Emailer is by using the Easy Setup assistant. Easy Setup leads you 
through the required service and account setup information for each 
service you select. 

Easy Setup appears the first time you start Claris Emailer, or you can use 
it later by choosing Easy Setup from the Setup menu.

To set up account information without Easy Setup:

1. Choose Accounts from the Setup menu.

You see the Account List window. 

For information about 
this service See

America Online “Setting up America Online service information” on page 3-6

AppleLink “Setting up AppleLink service information” on page 3-8

Claris OfficeMail “Setting up Claris OfficeMail service information” on 
page 3-10

CompuServe “Setting up CompuServe service information” on page 3-14

Internet service providers “Setting up Internet service provider service information” on 
page 3-17

RadioMail “Setting up RadioMail service information” on page 3-20
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Note If you have not yet created any accounts, the Account List 
window is empty.

2. Add an account or edit an existing account as follows:

1 To add a new account, click New, choose a service type from the 
Service pop-up menu, and then click OK. 

1 To change an existing account, double-click an account name in 
the Account List window.

3. Enter or change your account information for your email service (see 
the table at the end of this section).

4. Click Save.

5. Choose an account name in the Default send via pop-up menu, if you 
have more than one account. Your messages will be sent through this 
account unless you specify a different account in an outgoing 
message window.

6. Drag account names in the list to arrange your accounts in the order 
you want them to connect (if you have more than one).

7. Close the Account List window.

Use the information in the following table to locate the required account 
information for your service provider.

For information about 
this service See

America Online “Setting up America Online accounts” on page 3-8

AppleLink “Setting up AppleLink accounts” on page 3-10

Claris OfficeMail “Setting up Claris OfficeMail accounts” on page 3-11

CompuServe “Setting up CompuServe accounts” on page 3-16

Click to add a
new account

Double-click to
edit an account

entry

Choose a default 
account for sending 
messages, if you 
have more than one
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Setting the connection order for accounts
When you have more than one account for a service and you want 
Claris Emailer to connect to multiple accounts during a connection, you 
specify the order in which they connect in the Account List window. 
Claris Emailer connects to the first account in the list, then the second 
account, and so on.

Note If you are connecting manually, you specify which accounts to 
connect to in the Connect Now Setup window. If you are connecting 
through a schedule, you specify which accounts you connect to in the 
Schedule Entry window. For more information about setting up 
connections, see chapter 4, “Connecting to email services.”

To change the order in which Accounts connect, drag account names in 
the Accounts List window.

Deleting accounts
To delete an account, select the account name in the Accounts List 
window and click the  button in the toolbar or press Delete.

Setting up Claris Emailer for an America Online account
To access your America Online email account, you should first set up 
your America Online service information and then set up your account 
information.

Setting up America Online service information
There are two methods for setting up Claris Emailer to connect to the 
America Online service.

1 You can set up a standard America Online connection, which 
accesses only your America Online account when Claris Emailer 
connects.

Internet service providers “Setting up Internet service provider accounts” on 
page 3-17

RadioMail “Setting up RadioMail accounts” on page 3-21

For information about 
this service See
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1 You can set up a connection to America Online through a TCP 
connection, which accesses your America Online account and any 
other designated accounts you have with Internet services when 
Claris Emailer connects.

For a standard America Online connection
The following table describes entries you make in Easy Setup or the 
Service Entry dialog box when setting up Claris Emailer for a standard 
America Online connection.

For an America Online TCP/IP connection
To configure an America Online account for a TCP/IP connection:

1. If you are setting up a network TCP/IP connection, skip to step 2.

If you are setting up a dial-in connection, set up your PPP or SLIP 
software as described in “Setting up your modem-based TCP/IP 
connection” on page 3-21.

2. In the America Online Service Entry dialog box, choose 
MacTCP from the Connection file pop-up menu.

3. Click Done to close the Service Entry window.

For more information about setting up TCP/IP connection information, 
see the Claris Emailer FAQ files located in the Support Files folder in 
the Claris Emailer Folder.

In this text box or pop-up menu Type or choose

Connection name The name of the connection you want to set up or 
change. If you access Claris Emailer while 
traveling, you might name your service connection 
for the city in which you use this connection (for 
example, Chicago).

Connection file The name of the network you use to access America 
Online (for example, AOLnet).

Modem type The kind of the modem you use. Choose 
Generic MNP v.32, if your modem is not in the list.

Modem port The name of the port your modem is connected to.

Modem speed The highest speed modem that your modem can 
connect with. In most configurations, you need not 
adjust this setting.

Phone number The local access number for America Online. For 
example, if you are setting up this account for 
access in a remote city, you can enter the local 
phone number for America Online in that city.
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Setting up America Online accounts
The following table describes entries you make in Easy Setup or the 
Account Entry dialog box when setting up Claris Emailer for an 
America Online account.

Setting up Claris Emailer for an AppleLink account
To access your AppleLink email account, you should first set up your 
AppleLink service information and then set up your account 
information.

Setting up AppleLink service information
Note You cannot use Easy Setup to set up AppleLink service and 
account information. Instead, you must use the Service Providers and 
Accounts items in the Setup menu for setting up AppleLink.

In this text box or 
pop-up menu Type or choose

Account name A name for this America Online account in Claris Emailer. The 
account name is strictly descriptive, to help you differentiate between 
accounts. When you set up a new account, it is named 
New AOL account by default but you can change this name.

Screen name Your America Online account screen name. Screen names are 10 
characters or less including spaces (for example, DBradbury).

Password The password you use to access America Online. To prevent other 
users from seeing your password, Claris Emailer displays dots 
instead of characters when you type your password.

Default signature A signature you have defined. This signature will be used for every 
message sent from this account. You compose signatures in the 
Signatures window. For more information, see “Setting up your 
signatures” on page 10-6.

Choose None if you do not want to have a default signature for this 
account. Choose Random to have Claris Emailer randomly select a 
signature from the signatures you have set up. Choose Internet Config 
to use the default signature you defined in your system-wide Internet 
Config setup. For more information, see the documentation that 
comes with Internet Config.

Note Internet Config does not come with Claris Emailer. For 
information about where to obtain Internet Config, see the Claris 
Emailer FAQ files located in the Support Files folder in the Claris 
Emailer Folder.
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The following table describes entries you make in Easy Setup or the 
Service Entry dialog box when setting up Claris Emailer for a Global 
Campus AppleLink connection.

Choosing an AppleLink connection file
The connection file tells your computer how to communicate across the 
network, either through your modem or with another communication tool. 

Important Only the connection files that come with Claris Emailer have 
been tested for use with the product. Use of other connection files is not 
supported.

Use this decision tree to choose a connection file.

In this text box or pop-up menu Type or choose

Connection name The name of the connection you want to set up or 
change.

Connection file The name of your connection file. For more 
information about specifying a connection file, see 
the following section.

Choose Global Campus
Yes

Choose Global Village

High Speed

Choose Modem (USA)

Yes

Yes

Yes

No

No

No

No

Do you have a

Global Village modem


?

Choose Mac 

Comm Toolbox

Does it work

?

Does it work

?

You're Done !

Are you on 

the Apple Campus


?
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Setting up AppleLink accounts
The following table describes entries you make in Easy Setup or the 
Account Entry dialog box when setting up Claris Emailer for an 
AppleLink account.

Setting up Claris Emailer for a Claris OfficeMail account
To access your Claris OfficeMail email account, you configure 
Claris Emailer to connect to Claris OfficeMail when you set up your 
Claris OfficeMail account information.

Setting up Claris OfficeMail service information
When you set up Claris Emailer to send and receive email through 
Claris OfficeMail, you need only specify the name of your Claris 
OfficeMail server, which you do during the account setup process.

In this text box or 
pop-up menu Type or choose

Account name A name for this AppleLink account in Claris Emailer. The account 
name is strictly descriptive, to help you differentiate between 
accounts. When you set up a new account, it is named 
New AppleLink account by default, but you can change this name.

Account ID Your AppleLink account ID. This ID is typically your last name and 
first initial, separated by a period (for example, KITAGAWA.Y).

Password The password you use to access AppleLink. To prevent other users 
from seeing your password, Claris Emailer displays dots instead of 
characters when you type your password.

System number The number that identifies the type of AppleLink account you have.

Default signature A signature you have defined. This signature will be used by default 
for every message sent from this account. You compose signatures in 
the Signatures window. For more information, see “Setting up your 
signatures” on page 10-6.

Choose None if you do not want to have a default signature for this 
account. Choose Random to have Claris Emailer randomly select a 
signature from the signatures you have set up. Choose Internet Config 
to use the default signature you defined in your system-wide Internet 
Config setup. For more information, see the documentation that 
comes with Internet Config.

Note Internet Config does not come with Claris Emailer. For 
information about where to obtain Internet Config, see the Claris 
Emailer FAQ files located in the Support Files folder in the Claris 
Emailer Folder.



Setting up Claris Emailer 3-11
Setting up Claris OfficeMail accounts
The following table describes entries you make in the Account Info screen 
of Easy Setup or the Account Entry dialog box when setting up 
Claris Emailer for a Claris OfficeMail account.

To choose a Claris OfficeMail server:

1. Click Choose Server. 

You see a dialog box that contains a list of network zones on the left. 
On the right are the names of email servers available in the selected 
zone. 

2. Select the appropriate server and click OK.

The name of your Claris OfficeMail server appears in the Server name 
field in the Account Info screen.

Changing your Claris OfficeMail password
When you change your Claris OfficeMail account password, you make 
the change in the Claris Emailer application and it is automatically 
updated on the Claris OfficeMail server. 

Tip You should change your password every few weeks to ensure 
security. Be sure to include non-alphanumeric characters, like $ or % in 
your password.

If you forget your password See your server administrator. Your server 
administrator can reset your password to the original default.

In this text box Type

Account name A name for the account. The account name is strictly descriptive, to 
help you differentiate between accounts. When you set up a new 
account, it is named New OfficeMail Account by default, but you can 
change this name.

Full name Your name.

Email name The name used for your account on Claris OfficeMail. Your 
Claris OfficeMail server administrator can give you this name, which 
is typically your first name.

Password The password you use to access Claris OfficeMail. To prevent other 
users from seeing your password, Claris Emailer displays dots 
instead of characters when you type your password.

Your Claris OfficeMail administrator will give you a default 
password. You should change this password as soon as possible. For 
more information about passwords, see “Changing your 
Claris OfficeMail password” below.
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To change your Claris OfficeMail account password:

1. Display the Claris OfficeMail Account Entry window and then click 
Change Password.

You see the Change Password dialog box.

2. Type your old password in the Old password text box.

3. Type a new password in the New password text box. 

The new password appears as dots, to prevent anyone from reading 
your password. 

4. Type the new password again in the Re-enter new password text box to 
confirm it. 

5. Click OK. 

Setting Claris OfficeMail mail handling options
To set the mail handling options for your Claris OfficeMail account, 
click the Options tab in the Claris OfficeMail Account Entry window.

The following table describes entries you make in the Options screen of 
Easy Setup or the Account Entry dialog box when setting up 
Claris OfficeMail mail handling options.

Select or choose from a 
pop-up menu If you want Claris Emailer to

A default signature Use a signature by default at the end of every message sent 
from this account. You compose signatures in the 
Signatures window. For more information, see “Setting up 
your signatures” on page 10-6.

Choose None if you do not want to have a default signature 
for this account. Choose Random to have Claris Emailer 
randomly select a signature from the signatures you have set 
up. Choose Internet Config to use the default signature you 
defined in your system-wide Internet Config setup. For 
more information, see the documentation that comes with 
Internet Config.

Note Internet Config does not come with Claris Emailer. 
For information about where to obtain Internet Config, see 
the Claris Emailer FAQ files located in the Support Files 
folder in the Claris Emailer Folder.

A default encoding format Use BinHex, Base 64, or UUEncode for your enclosures. 
Claris Emailer uses BinHex by default. Use BinHex or 
Base 64 if you send messages most often to people who use 
the Macintosh operating system. Use Base 64 or UUEncode 
if you send messages most often to people who use other 
operating systems. For more information about encoding 
formats, see appendix A, “Encoding enclosures.”
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Setting Claris OfficeMail new mail notifier options
To set the new mail notifier options for your Claris OfficeMail account, 
click the Notifier tab in the Claris OfficeMail Account Entry window. 
The following table describes entries you make in the Notifier screen of 
Easy Setup or the Account Entry dialog box when setting up 
Claris OfficeMail new mail notifier options.

Leave messages on server for 
__ days

Store messages on the server for the number of days you 
specify. Claris Emailer usually deletes messages from the 
server after it has downloaded them to your computer. 
Generally, you should leave this option unchecked so that 
your mail does not take up too much space on the server. If 
you check this box, consider also enabling the Remove 
messages from server when permanently deleted from 
Claris Emailer option (see below).

Get all messages from server Download all messages at the next connection that have 
been stored on the server since you activated Leave messages 
on server for _ days and/or Remove messages from server when 
permanently deleted from Claris Emailer.

Partially retrieve messages 
larger than __ K

Download a portion of large messages (typically the header 
information and the first few lines of the message text) from 
the server if they are larger than the specified size. This 
option allows you to view a portion of a large message or 
enclosure before retrieving it. For more information, see 
“Working with partially downloaded messages” on 
page 6-2.

Remove messages from server 
when permanently deleted 
from Claris Emailer

Delete any messages that have been stored on the server 
after downloading, but which you have since permanently 
deleted from Claris Emailer on your computer. This option 
works with the Leave messages on server for _ days option, 
preventing Claris Emailer from downloading messages 
again when you have already deleted them from your 
computer.

Select If you want Claris Emailer to

Get mail Retrieve mail automatically when it arrives at the server 
while Claris Emailer is running. If you deselect this option, 
you must use a schedule or Connect Now to retrieve your 
mail from the server.

Play sound Play a tone when new mail arrives on the server while 
Claris Emailer is not running. Choose the tone you want 
from the pop-up menu.

Blink icon in menu bar Show the Claris Emailer icon in the menu bar when new 
mail arrives on the server while Claris Emailer is not 
running.

Select or choose from a 
pop-up menu If you want Claris Emailer to
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Setting up Claris Emailer for a CompuServe account
To access your CompuServe email account, you should first set up your 
CompuServe service information and then set up your account 
information.

Setting up CompuServe service information
There are two ways to set up Claris Emailer to connect to the 
CompuServe service.

1 You can set up a standard CompuServe connection, which accesses 
only your CompuServe account when Claris Emailer connects.

1 You can set up a connection to CompuServe through a TCP 
connection, which accesses your CompuServe account as well as any 
other designated accounts you have with Internet services when 
Claris Emailer connects.

For a standard CompuServe connection
The following table describes entries you make in Easy Setup or the 
Service Entry dialog box when setting up Claris Emailer for a standard 
CompuServe connection.

Note If the port you use to connect to your modem is called anything 
other than Modem Port or Printer Port (as it is with many internal 
PowerBook modems) you must use the Mac Comm Toolbox Connection as 
your connection type. You cannot use a standard CompuServe 
connection.

In this field or pop up menu Type or choose

Connection name The name of the connection you want to set up or 
change. If you access Claris Emailer while 
traveling, you might name your service connection 
for the city in which you use this connection (for 
example, Chicago).

Connection type Standard CompuServe Connection

Modem port The name of the port your modem is connected to.

Modem type The name of the modem you use. Choose 
Generic MNP v.32, if your modem is not in the list.

Modem init string The string of characters that initialize your modem. 
AT&F is the most common initialization string.

Modem speaker On or Off to hear or suppress the dial tones when 
your modem attempts a connection.
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For a CompuServe TCP/IP connection
To configure a CompuServe account for a TCP/IP connection:

1. If you are setting up a network TCP/IP connection, skip to step 2.

If you are setting up a dial-in connection, set up your PPP or SLIP 
software as described in “Setting up your modem-based TCP/IP 
connection” on page 3-21.

2. In the CompuServe Service Entry dialog box, choose Mac Comm 
Toolbox Connection from the Connection type file pop-up menu.

3. Choose Internet in the Network pop-up menu.

4. Click the Configure button that appeared when you chose the 
connection type.

You see the Connection Settings dialog box.

5. Choose a TCP/IP-compatible connection tool from the Method 
pop-up menu.

Note You must obtain a TCP/IP connection tool that is compatible 
with CompuServe. The configuration information you enter will vary 
depending on the connection tool you use. For more information 
about settings in the Connection Settings dialog box, see the Claris 
Emailer FAQ files located in the Support Files folder in the Claris 
Emailer Folder.

6. Click OK, and then click Done to close the Service Entry window.

Phone number The local access number for CompuServe. For 
example, if you are setting up this account for 
access in a remote city, you can enter the local 
phone number for CompuServe in that city.

Baud rate The speed at which your modem transmits 
information.

Network The type of network you use to access 
CompuServe. CompuServe is the most common 
network type.

Retries The number of times you want Claris Emailer to 
re-dial if the CompuServe line is busy or a 
connection cannot be made.

In this field or pop up menu Type or choose
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Setting up CompuServe accounts
The following table describes entries you make in Easy Setup or the 
Account Entry dialog box when setting up Claris Emailer for a 
CompuServe account. 

Setting CompuServe account options
To set the mail handling and surcharge options for your CompuServe 
account, click the Options tab in the CompuServe Account Entry 
window. 

The following table describes entries you make in the Options screen of 
Easy Setup or the Account Entry dialog box when setting up 
CompuServe account options.

In this text box Type

Account name A name for this CompuServe account in Claris Emailer. 
The account name is strictly descriptive, to help you 
differentiate between accounts. When you set up a new 
account, it is named New CompuServe account by default but 
you can change this name.

User name Your name.

User ID Your account user identification number (for example, 
76666,4321).

Password The password you use to access CompuServe. To prevent 
other users from seeing your password, Claris Emailer 
displays dots instead of characters when you type your 
password.

Select or choose from a 
pop-up menu If you want Claris Emailer to

A default signature Use a signature by default at the end of every message sent 
from this account. You compose signatures in the 
Signatures window. For more information, see “Setting up 
your signatures” on page 10-6.

Choose None if you do not want to have a default signature 
for this account. Choose Random to have Claris Emailer 
randomly select a signature from the signatures you have set 
up. Choose Internet Config to use the default signature you 
defined in your system-wide Internet Config setup. For 
more information, see the documentation that comes with 
Internet Config.

Note Internet Config does not come with Claris Emailer. 
For information about where to obtain Internet Config, see 
the Claris Emailer FAQ files located in the Support Files 
folder in the Claris Emailer Folder.
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Setting up Claris Emailer for an Internet service provider account
To access your Internet service provider email account, you should first 
configure or verify your Claris Emailer Internet service connection 
information and then set up your account information.

Setting up Internet service provider service information
When you set up Claris Emailer to send and receive email through an 
Internet service provider, all of the configuration settings are stored 
outside of Claris Emailer.

1 If you access your Internet service provider through a dial-up 
connection, your service setup information is stored in your PPP or 
SLIP software. For more information about setting up PPP or SLIP, 
see “Setting up your modem-based TCP/IP connection” on 
page 3-21. 

1 If you access your Internet service provider through a network, your 
service setup information is stored in the MacTCP or TCP/IP control 
panel. For more information about the settings in your MacTCP or 
TCP/IP control panels, consult your network administrator.

Setting up Internet service provider accounts
The following table describes entries you make in the Account Info screen 
of Easy Setup or the Account Entry dialog box when setting up 
Claris Emailer for an Internet account.

Leave read mail on server Store messages on the server. Claris Emailer usually deletes 
messages from the server after it has downloaded them to 
your local machine. Generally, you should leave this option 
unchecked so that your mail does not take up too much 
space on the server machine.

Ignore surcharge warnings Prevent CompuServe surcharge warnings from appearing 
during your connection session.

Select or choose from a 
pop-up menu If you want Claris Emailer to
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Important Depending on your Internet service provider, the entries you 
make in the Email account, Email password, and SMTP server fields might 
be case sensitive.

Select the Use Internet Config settings option if you want Claris Emailer to 
use any settings you have made in the Internet Config software. For 
example, if you check this box, you can attach signatures that you have 
defined in Internet Config to outgoing messages. 

Note Internet Config does not come with Claris Emailer. For 
information about where to obtain Internet Config, see the Claris 
Emailer FAQ files located in the Support Files folder in the Claris 
Emailer Folder.

Setting Internet service provider account options
To set the mail handling and connection options for each Internet 
account, click the Options tab in the Internet Account Entry window. 

In this text box Type

Account name A name for this Internet account in Claris Emailer. The account 
name is strictly descriptive, to help you differentiate between 
accounts. When you set up a new account, it is named 
New internet account by default but you can change this name.

User name Your name.

Email account The full address of your POP account, including the name of your 
POP server. This address must be in the following format: 
your_account_name@POP_server_name.host_name.com

Depending on your Internet service provider, your email account 
name might be case sensitive.

Email password The password you use to access your email. Depending on your 
Internet service provider, your password might be case sensitive. 
To prevent other users from seeing your password, Claris Emailer 
displays dots instead of characters when you type your password.

SMTP server The name of your email server. This is usually the host computer’s 
domain name (for example, smtp_name.host_name.com). Ask 
your Internet service provider if you are unsure of your SMTP 
server name. Depending on your Internet service provider, your 
SMTP server name might be case sensitive.

Email address Another address if you want replies sent to a different address than 
the one specified in the Email account field. You can leave this entry 
blank if you have only one Internet address.
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The following table describes entries you make in the Options screen of 
Easy Setup or the Account Entry dialog box when setting up your 
Internet account options.

Select or choose from a 
pop-up menu If you want Claris Emailer to

A default signature Use a signature by default for every message sent from this 
account. You compose signatures in the Signatures window. 
For more information, see “Setting up your signatures” on 
page 10-6.

Choose None if you do not want to have a default signature 
for this account. Choose Random to have Claris Emailer 
randomly select a signature from the signatures you have set 
up. Choose Internet Config to use the default signature you 
defined in your system-wide Internet Config setup. For more 
information, see the documentation that comes with Internet 
Config.

A default encoding format Use BinHex, Base 64, or UUEncode for your enclosures. 
Claris Emailer uses BinHex by default. Use BinHex or 
Base 64 if you send messages most often to people who use 
the Macintosh operating system. Use Base 64 or UUEncode 
if you send messages most often to people who use other 
operating systems. For more information about encoding 
formats, see appendix A, “Encoding enclosures.”

Leave messages on server for 
__ days

Store messages on the server for the number of days you 
specify. Claris Emailer usually deletes messages from the 
server after it has downloaded them to your local machine. 
Generally, you should leave this option unchecked so that 
your mail does not take up too much space on the server 
machine. If you check this box, consider also enabling the 
Remove messages from server when permanently deleted from 
Claris Emailer option (see below).

Get all messages from server Download all messages at the next connection that have 
been stored on the server since you activated Leave messages 
on server for _ days and/or Remove messages from server when 
permanently deleted from Claris Emailer.

Partially retrieve messages 
larger than __ K

Download a portion of large messages (typically the header 
information and the first few lines of the message text) from 
the server if they are larger than the specified size. This 
option allows you to view a portion of a large message or 
enclosure before retrieving it. For more information, see 
“Working with partially downloaded messages” on 
page 6-2.

Remove messages from server 
when permanently deleted 
from Claris Emailer

Delete any messages that have been stored on the server 
after downloading, but which you have since permanently 
deleted from Claris Emailer on your computer. This option 
works with the Leave messages on server for _ days option, 
preventing Claris Emailer from downloading messages 
again when you have already deleted them from your 
computer.
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Some Internet service providers allow you to change your account 
password through the Claris Emailer client. If your provider does 
support password modification, click the Change Password button to 
modify your password.

Setting up Claris Emailer for a RadioMail account
To access your RadioMail email account, you should first configure or 
verify your Claris Emailer RadioMail service connection information 
and then set up your account information.

Setting up RadioMail service information
When you set up Claris Emailer to send and receive email through 
RadioMail, all of the configuration settings are stored in the RadioMail 
application setup files. For more information about RadioMail, see the 
Important Information file in the Claris Emailer Folder.

Important Claris Emailer does not automatically install the necessary 
support files for the RadioMail service. To use Claris Emailer with 
RadioMail, you must use the Claris Emailer installer to do a Custom 
Install and choose the proper RadioMail network.

Connect using APOP Use APOP authentication. APOP is way of providing a 
higher level of security for your password. Instead of 
sending your password as text over the Internet, APOP 
encrypts the password before sending it. However, not all 
POP servers support APOP. For more information about 
APOP support, consult your Internet service provider.

Select or choose from a 
pop-up menu If you want Claris Emailer to
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Setting up RadioMail accounts
The following table describes entries you make in Easy Setup or the 
Account Entry dialog box when setting up Claris Emailer for a 
RadioMail account.

Setting up your modem-based TCP/IP connection
You can use PPP or SLIP networking software to make a TCP 
connection with your modem to America Online, CompuServe, or an 
Internet service provider. Before you can set up PPP or SLIP, you must 
obtain connection information from one of the email services listed 
above.

If you have accounts with more than one email service, you can use your 
TCP/IP connection to access messages on multiple email services with 
one phone call. 

Important This section is applicable only if you are using a modem and 
TCP/IP to connect to your email service provider. If you are using 
AOLnet, Sprintnet, a CompuServe network, or have a direct connection 
to the Internet, this information does not apply to you.

In this text box or 
pop-up menu Type or choose

Account ID Your RadioMail account address (for example, 
MichelleB@radiomail.net). When you set up a new 
account, it is named RadioMail account.

Reply-To Address Your return email address.

Default signature A signature you have defined. This signature will be used 
by default for every message sent from this account. You 
compose signatures in the Signatures window. For more 
information, see “Setting up your signatures” on page 10-6.

Choose None if you do not want to have a default signature 
for this account. Choose Random to have Claris Emailer 
randomly select a signature from the signatures you have 
set up. Choose Internet Config to use the default signature 
you defined in your system-wide Internet Config setup. For 
more information, see the documentation that comes with 
Internet Config.

Note Internet Config does not come with Claris Emailer. 
For information about where to obtain Internet Config, see 
the Claris Emailer FAQ files located in the Support Files 
folder in the Claris Emailer Folder.
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If you are using a modem and TCP/IP to dial in to your email service 
provider, you need to have either PPP or SLIP software. This software 
is sometimes composed of two pieces (a system extension and either a 
control panel or an application) and is sometimes only a control panel 
(Apple Open Transport PPP).

Your PPP or SLIP software must be configured with the following 
information:

In addition, you must select your PPP or SLIP connection in your 
MacTCP application or TCP/IP control panel. (The MacTCP 
application or TCP/IP control panel comes with your system software.)

For information about hanging up a PPP or SLIP connection, see 
“Setting TCP control preferences” on page 10-15.

If you have the 
PPP or SLIP 

Make sure

Extension It is in the Extensions folder in your System Folder. For best 
performance, you should have only one PPP or SLIP extension in your 
Extensions folder.

Control panel It is in the Control Panels folder in your System Folder.

Application It is not in your System Folder.

This type of information Obtain from your Required?

Your user name Email service provider Yes

Phone number to dial Email service provider Yes

Connect script, which must be 
configured with your password

Email service provider Not always

Modem port Documentation that came with your 
computer

Yes

Modem initialization string Documentation that came with your modem Yes



Chapter 4:  Connecting to email services

You send and receive messages during a connection to an email service 
such as Claris OfficeMail, America Online, CompuServe, or your 
Internet service provider.

Connecting to your email accounts right away
You can connect to one or more of your email accounts immediately or 
at your next scheduled connection. For more information about 
scheduling a connection, see the next section, “Scheduling account 
connections.”

To connect to one or more of your email accounts immediately:

1. Perform one of the following actions:

1 If an outgoing message is open, click Send Now in the message 
window.

1 If no outgoing messages are open, click the  button in the 
toolbar or choose Connect Now from the Mail menu. 

You see the connection setup dialog box.

If you have only one account, you see this dialog box:
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If you have more than one account, you see this dialog box:

2. Select from among these options in the connection setup dialog box:

3. To connect to your accounts, click Connect.

The next time you want to connect using the same settings, hold down 
the mouse button on the  button in the toolbar and choose 
Connect Again from the pop-up menu that appears. Or, choose 
Connect Again from the Mail menu. Claris Emailer connects without 
presenting a dialog box.

To Do this

Specify the accounts you 
want to connect to

Place a checkmark next to the accounts you want to 
connect to, by clicking in the  column of the accounts 
list. (If you have only one account, the accounts list does 
not appear.) 

Claris Emailer connects to each account in sequence.

Retrieve incoming messages 
during the connection

Select Get.

Send messages during 
the connection

Select Send. 

If you clicked Send Now in an open message, choose an 
option from the pop-up menu. Choose Specified message 
only to send only the message that you have open, or 
choose All pending messages to send all of your unsent 
messages for the selected accounts.

Place a checkmark next to the
account(s) you want to use

during this connection Shows the number 
of outgoing 
messages waiting 
to be sent
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Scheduling account connections
You can set when Claris Emailer sends and receives your mail by 
creating schedules. Schedules help you automate connections to service 
providers. 

Important You must have your computer and modem on and the 
Claris Emailer application running for schedules to run. Schedules do 
not start Claris Emailer. If you schedule a connection for a time when 
you’ll be away from the computer, be sure to leave your computer and 
modem on and leave Claris Emailer running. 

Creating or changing a schedule
You can create schedules to send and receive your mail. Schedules can 
help you control connections to different services at various times 
during the day. For example, you might create one schedule to retrieve 
your mail once a day and another schedule to send mail once an hour. 

Note A schedule that only sends mail does not execute if there are no 
outgoing messages to send.

You can designate particular times of the day and days of the week to 
connect (a timed connection), or you can set up Claris Emailer to 
connect at specified intervals (a repeating connection).

Claris Emailer staggers the connection times within the intervals you 
can choose for a schedule. This relieves peak congestion at online 
services, helping you avoid connection errors. 

Note You might want to consider the monthly costs of connecting to 
your services when you create a schedule. For example, if you create a 
schedule to connect once every 30 minutes to a service, you’ll connect 
1,440 times per month. If Claris Emailer used one minute per 
connection, you would accumulate 24 hours of connect time.

Type of connection Example

Timed Monday through Friday, at 15 and 45 minutes past each hour from 
9AM to 5PM

Repeating Every half hour
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To create or change a schedule:

1. Choose Schedules from the Setup menu.

You see the Schedules List window.

Note If you have not created a schedule yet, the Schedules List 
window is empty.

2. To create a schedule, click New. To change an existing schedule, 
double-click the name of the schedule.

You see the Schedule Entry dialog box. 

Click to create a new schedule

Click to place a checkmark
next to the schedules you

want to enable

Deselect if you do not want
the schedule to run

Enter 
a name 
for the 
schedule
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3. Type the new or changed name for the schedule.

It’s a good idea to name the schedule so that it is easily recognizable. 
For example, if a schedule connects only on weekends, you might call 
it “Weekend Schedule.”

4. Select the tasks to perform during the connection. You can select 
Get mail, Send mail, or both.

Note If you want to get your mail at one time and send it at another, 
you must create a schedule for each task.

5. Place a  next to the account(s) that you want to make a scheduled 
connection to, by clicking in the  column next to the account name.

You can connect to several accounts with one schedule.

6. Choose either a timed or repeating connection from the Connection 
type pop-up menu.

Note The scheduling options in the Schedule Entry dialog box 
change depending on which type of connection you choose from the 
Connection type pop-up menu.

7. If you chose a timed connection, select the days, hours, and times that 
you want the schedule to run. You must select at least one day, hour, 
and time to activate the schedule.

If you chose a repeating connection, choose how often the schedule 
will run from the Frequency pop-up menu.

8. If you are using SLIP or PPP software to connect to your service 
provider and you want to make sure that your modem hangs up when 
the connection is finished, select Use TCP control.

For more information, see “Setting TCP control preferences” on 
page 10-15.

9. Click Save.
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Executing a schedule right away
In some situations, you might want to connect immediately using the 
same settings as a scheduled connection. 

For instance, if you have set up a schedule that connects while you are 
away from your computer, you might want to execute the schedule once 
while you are at your computer, to make sure your schedule works as 
you intended.

To execute a schedule immediately, choose Execute Schedule from the 
Mail menu and choose the desired schedule from the submenu that 
appears. The submenu contains all the schedules you have set up.

If the schedule executes a connection, Claris Emailer connects to the 
accounts you have designated in the Schedule Entry dialog box and 
performs the tasks you have designated (getting and/or sending mail). 

If the schedule executes an AppleScript document, Claris Emailer runs 
the designated script.

Enabling and disabling schedules
Schedules are enabled by default when you create them. A schedule is 
enabled when you see the checkmark in the  column in the 
Schedules List window, and disabled when the  column is empty. 
Click in the  column to enable and disable schedules.

Important You can set a preference to run a schedule at startup (see 
“Setting defaults preferences” on page 10-9). If you select 
Disable all schedules in the Schedules List window, this preference is 
disabled and no schedule will run at startup.

Click next to a schedule
to enable or disable it

Select to disable all 
schedules

This schedule is enabled
This schedule is disabled
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Deleting a schedule
To delete a schedule:

1. Choose Schedules from the Setup menu. 

You see the Schedules List window.

2. Select the schedule you want to delete.

3. Click the  button in the toolbar or press the Delete key.

Quitting during a connection
If you try to quit Claris Emailer while a connection is occurring, you see 
a dialog box that allows you to:

1 cancel the connection and quit immediately

1 quit after the connection is finished

1 not quit

Troubleshooting connections
With all the flexibility and capability provided by the Internet and email 
service providers, it is not uncommon to receive error messages 
occasionally. At times, your mail may generate an error at its 
destination, return to you as undeliverable, or even get lost. 
Claris Emailer generates its own error messages and also shows you the 
error messages received from your email services. 

Connection problems produce the most common errors. This type of 
error is not your fault. Your service provider could be having difficulty 
with its server, all available connections could be in use, or the telephone 
connection could be noisy. The most common resolution to an error is 
to resend your email or try to connect again.
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When a connection error occurs, you see a flashing error icon in the 
toolbar and a connection log in the Logs folder. The log continues to 
accumulate any error messages until you open it. After that, 
Claris Emailer creates a new connection log the next time an error 
occurs.

The following table describes common errors and suggested resolutions:

When this happens Do this

Messages are returned 1 Make sure that the message is properly addressed, and resend the message.

Your modem does not connect 1 Turn the speaker on to hear if a connection attempt occurs.
1 Make sure the modem setting in Claris Emailer matches the type of modem you use. If your 

modem is not on the list, try using Hayes as the modem type in the Service Entry dialog box.
1 Try a lower baud rate in the Service Entry dialog box.
1 Redial. Poor connections or bad lines often cause connection problems.
1 Check for missing phone prefixes, such as 9, in your connection information. Check your 

other connection information too.
1 Try again later. You may be experiencing a technical problem or congestion with the 

service provider.
1 Disable call waiting, usually by inserting *70 before the number to be dialed.

This log has been viewed

This log has not been viewed

Click the flashing icon to 
view the latest log

The Logs folder contains
connection logs
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Mail was not sent 1 Make sure that an account is selected in the Accounts list in the Connect Now or Schedule 
Entry dialog box. 

1 Include both a subject and message text. Some services require both.
1 Check for a connection log in the Logs folder.
1 Check the addresses for the message. If you see the  icon next to the message in the 

message list, or next to an address in the Recipient list in the message, enter a proper address 
and try again.

1 Make sure that the message is not marked as a draft . Draft messages are not sent during 
connections. Change the message status by opening the message and clicking either 
Send Now or the  icon and then Queue Message.

1 Make sure the message window is closed. Claris Emailer does not send open messages. (If 
you click Send Now in an open message, the message will be closed and sent.)

1 Open the Service Entry dialog box for your service, and make sure Connect to this service 
is selected.

1 Make sure that Claris Emailer is running. Scheduled connections will not occur otherwise.
1 Try choosing Connect Now from the Mail menu.

A connection error occurs and an 
alert icon appears on the toolbar

1 View the connection log in the Logs folder describing the connection error and take 
appropriate action.

You receive an error message 
from an online service 

1 Seek assistance from the online service.

A PowerBook computer won’t 
connect to a service

1 Select the appropriate modem tool (for example, Express Modem Tool) in the Service Entry 
dialog box.

A connection will not stop 
immediately when you click Stop

1 Wait a few moments. (Some actions cannot stop because of interactions with the 
host computer.)

A message was sent more than 
once

1 No action is required. Some services limit the number of recipients for a single message. 
The message was resent until all recipients received a copy.

A dial-up connection to the 
Internet won’t work

1 Resolve the problem with your Internet connection software. For general information, see 
“Setting up your modem-based TCP/IP connection” on page 3-21. Claris Emailer has no 
control over dial-up connections with the Internet.

The Internet mail you send does 
not contain your name

1 Enter your name in User Name in the Internet Service Entry dialog box.
1 If you connect to an online service, add your name to your user profile with the online 

service.

When this happens Do this



Chapter 5:  Creating and sending messages

Creating and sending messages with Claris Emailer is quick and easy. 
First create a message, give it a subject, address it, and compose the 
message body. Optionally, check your spelling and attach any related 
file enclosures. Then, send the message right away or save it until the 
next connection.

Creating a message
There are three ways to create messages in Claris Emailer.

To create a new message, click the  button in the toolbar, or choose 
New Message from the Mail menu. You see a new blank message 
window.

Tip To create a new message that’s already addressed to your intended 
recipients, click the  button in the toolbar or choose Address Book 
from the Window menu. Select one or more addresses, and then click 
the  button in the toolbar.

You can For more information

Create a new, original message Read this chapter.

Reply to a message you received See “Replying to a message” on page 6-6.

Forward a message you received See “Forwarding a message” on page 6-9.
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Tip You can press the Tab key to move the insertion point between the 
subject, address, and message body areas of the new message window. 
When the insertion point is in the body area, pressing Tab inserts space 
characters in the current line. Pressing 2-Tab returns the insertion point 
to the Subject field.

Enter a subject for the message

Choose a signature to add
closing information to

your message

Enter addresses

Type your message here

Click to show or hide
the Recipient area

Choose an account to send
the message through

Click and then select a folder
in which to file the message

Click to send the message 
at the next connection

Click to send the 
message now

Click to show or hide
the Enclosure area

Click to switch between Queue
Message and Save As Draft modes
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Addressing a message
After you create a message, you can address it by:

1 typing addresses in the Recipient area

1 adding addresses from the Address Book

1 dragging addresses to the Recipient area

Click the triangle next to the  icon to display or hide the Recipient 
area.

An outgoing message can be addressed to a maximum of 250 recipients.

When you finish addressing a message, you see the  icon next to the 
recipient’s name in the Recipient area. This icon indicates that the 
address is complete. If you see the  icon, the address is incomplete. If 
this happens, make sure you entered all the required address 
information.

To Do this

Add another 
recipient

Click in the next empty Recipient cell in the Recipient area, press the 
Return key while the insertion point is in the Recipient area, or click the 

button next to the Recipient area of the message window.

Delete a recipient Click anywhere in the recipient line and then click the  button next 
to the Recipient area of the message window.

Addresses in an
outgoing message

Click to find an address
in the Address Book

Click to add a 
new, blank 
address line to 
this message

Click to delete the selected
address from this message

This icon indicates that the address 
on this line is incomplete

Click to display or hide
the Recipient area
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Addressing a message manually
To address a message manually, type information in the Recipient area 
of the message.

For information about adding and deleting recipients, see the previous 
section, “Addressing a message.”

To enter the Do this

Recipient name Type a name in the Recipient field. As you begin typing the recipient’s 
first name, Claris Emailer fills in the rest of the name for you from 
names stored in the Address Book. Continue typing until the correct 
name for this recipient is entered.

If the recipient is in the Address Book, press Tab to have Claris Emailer 
enter the rest of the addressing information. If the Address Book has 
two or more recipients with the same name, or if the recipient is a group, 
you see the Find Address dialog box (see the next section). If you 
inadvertently enter the wrong recipient, you can type over the 
recipient’s name and addressing information, or delete the recipient and 
add a new one.

Recipient address Type the recipient’s email address in the Address field. 

You do not have to type the @ sign or anything after it, unless you 
choose Internet for the Destination (see below).

Destination Type the name of the recipient’s destination. 

Destinations are shortcuts for entering the information after the @ sign 
in an email address. For example, type America Online if the 
recipient’s address ends in @aol.com. For more information, see 
“Speeding address entry using destinations” on page 2-13.

As you type, Claris Emailer fills in the rest of the destination for you. 
Continue typing until Claris Emailer fills in the correct destination. (If 
you want, you can choose a destination from the pop-up menu instead 
of typing.)

If the recipient has several addresses in the Address Book, the 
destinations they have addresses for are in bold in the Destination pop-
up menu. If you choose one of these destinations, Claris Emailer 
updates the Address field with the correct address. 

If the recipient’s destination does not appear in the Destination pop-up 
menu, choose Internet for the destination and type the entire Internet 
address in the Address field. For more information about creating your 
own destinations, see “Customizing the destinations list” on page 10-1.
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Finding an address in the Address Book
To find recipient addresses in the Address Book and add them to an 
outgoing message:

1. Open the outgoing message.

2. Click the  button in the Recipient area of the message window.

You see the Find Address dialog box, which displays the addresses 
stored in your Address Book. 

3. In the Filter text box, type a few letters of the address you want to find. 

As you enter characters, Claris Emailer reduces the number of 
addresses displayed in the Find Address dialog box to those that 
match the characters you have entered.

You can type lowercase or uppercase letters. Claris Emailer finds all 
the recipients that contain the specified letters in the Name or 
Description field. For example, typing pa finds “Japan University” 
and “Yassilis Papanico.”

Note You cannot enter part of a first name and a last name to create a 
match. For example, entering sal will doesn’t find “Sally 
Willford.”

Click to find an address in the Address Book

Type the letters you
want to search for
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4. Select one or more recipients. 

5. Click Select.

If the selected address is a group, all the entries in the group are added 
to the Recipient list. 

Addressing messages using Macintosh drag and drop
You can address a message by dragging addresses to the Recipient area 
or any gray area in the message window. The addresses can be from any 
text area that supports Macintosh drag and drop (such as the 
Address Book), the text of an email message, text from another 
application that supports drag and drop, or text clippings. 

To find a list of address formats Claris Emailer recognizes, look up 
“address formats” in the Claris Emailer Help system.

When you drag addresses to the Recipient area of the message, you see 
a border around the Recipient area.

For more information about using drag and drop, see “Working with 
Macintosh drag and drop” on page 2-17. For information about making 
addresses into text clippings, see “Exporting addresses” on page 8-15.

Dragging addresses from the Address Book
To drag addresses from the Address Book to a message:

1. Open the outgoing message.

2. Click the  button in the toolbar or choose Address Book from the 
Window menu.

To select Do this

A single recipient Click anywhere on the recipient’s row.

More than one recipient Shift-click the recipients you want to select. To deselect a 
recipient, or to select noncontiguous recipients, 2-click 
the recipients.

The recipient above or 
below the currently selected 
recipient

Press the Up Arrow or Down Arrow key.

A recipient and close the 
Find Address dialog box

Double-click the recipient. (Skip step 5.)
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3. Arrange the windows so that you can see both the Address Book and 
the Recipient area of the message.

4. In the Address Book, select the recipients that you want to add to 
the message.

Shift-click to select more than one recipient. To deselect a recipient, 
or to select noncontiguous recipients, 2-click the recipients.

5. Drag the recipients from the Address Book to the Recipient area or 
any gray area in the message window. 

Dragging addresses from a text area
To drag addresses from a text clipping or a text document to a message:

1. Open the outgoing message.

2. Arrange the windows so that you can see your outgoing message and 
the text containing the addresses.

3. Select the text clipping or text containing the addresses you want to 
add to your message.

4. Drag the text clipping or text to the Recipient area or any gray area in 
the message window. 

(You must drag a text clipping to the Recipient area, or it will be 
added as an enclosure.)

Including carbon copy and blind carbon copy recipients
You can send a message to three types of recipients. You can change a 
recipient’s type by choosing an option from the Type pop-up menu in 
the Recipient area.

Choose When the recipient is

To The primary recipient.

All recipients can see who the To recipients are. 

CC (Carbon Copy) Not the primary recipient, but the recipient may be interested or 
involved in the content of the message.

All recipients can see who the Carbon Copy recipients are. 

BCC (Blind 
Carbon Copy)

Not the primary recipient, but the recipient may be interested or 
involved in the content of the message. A blind carbon copy is 
considered somewhat confidential.

No recipient can see whether there are any Blind Carbon Copy 
recipients. A Blind Carbon Copy recipient cannot see whether there 
are other Blind Carbon Copy recipients.
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Important Not all services support carbon copies and blind carbon 
copies. You may want to check with both the sending and receiving 
services before setting up carbon copies or blind carbon copies. All the 
online services supported by Claris Emailer support both carbon copies 
and blind carbon copies.

In addition, some Internet mail servers may reveal Blind Carbon 
Copy (BCC) recipients if all the recipients are blind carbon copied. To 
prevent this, always include at least one To recipient—for example, 
yourself.

Enclosing files
You can enclose any type of file with an outgoing message by adding it 
to the Enclosure area of the message.

To see the Enclosure area, click the triangle next to the  icon.

Before you send an enclosure, keep this information in mind:

1 You can enclose an entire folder, but you must select the 
Compress files option to the right of the Enclosure area. Alternatively, 
you can use a compression application to convert the folder and its 
contents to a single file. 

1 Be sure to enclose the original file and not an alias to the file.

1 Check with both the sending and receiving services before sending 
enclosures over the Internet. Some services (for example, 
CompuServe) do not support sending and receiving enclosed files 
over the Internet. 

Click to hide or show
the Enclosure area

Files that will be
enclosed with this
outgoing message



Creating and sending messages 5-9
1 Check with the recipients to make sure that they have the applications 
necessary to open the files you’re sending. If you save your files in 
text (ASCII) format, they can be opened in most applications that 
accept text.

1 If you’re enclosing a text file of less than a few pages, you may want 
to include the text in the message body instead of sending it as an 
enclosure.

AppleLink users When you send an enclosure with Claris Emailer, the 
enclosure is compressed as a StuffIt enclosure, not an AppleLink 
package. 

Selecting an enclosure by location
To add an enclosure using a standard selection dialog box: 

1. If you don’t see the Enclosure area, click the triangle next to the 
  icon in an outgoing message window. 

2. Click the  button next to the Enclosure area in the message. 

You see the selection dialog box.

3. Select a file from the dialog box.

4. Click Select. 

Selecting an enclosure by name
To add an enclosure by searching for it by name:

1. If you don’t see the Enclosure area in the message window, click the 
triangle next to the  icon in an outgoing message window. 

2. Click the  button next to the Enclosure area in the message. 

You see the Find Files dialog box.

Choose a folder or disk
to see files and folders

in that location

Select a file from
the scrolling list
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3. Choose the name of the disk you want to search from the Volume 
pop-up menu.

4. Type the name (or partial name) of the file you want to search for.

The search is not case sensitive.

5. Click Find.

You see the search results in the File list.

6. Select the files you want to enclose.

Shift-click to select more than one file. To deselect a file, or to select 
noncontiguous files, 2-click the files.

7. Click Select.

Dragging an enclosure to a message
Follow these steps to add an enclosure using Macintosh drag and drop. 
For more information about drag and drop, see “Working with 
Macintosh drag and drop” on page 2-17. 

1. If you don’t see the Enclosure area, click the triangle next to the 
 icon in an outgoing message window.

2. Arrange the windows so that you can see the desktop and the 
message.

3. From the Finder, select the files you want to enclose. 

4. Drag the files from the Finder to the Enclosure area or any gray area 
in the message window.
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As you drag the files into the Enclosure area, you see a border around 
the area. When you release the mouse, your enclosures are added to 
the message.

Setting options for sending enclosures
To set the way Claris Emailer sends enclosures, select options in the 
Enclosure area of an outgoing message. 

Setting compression options
Compressing enclosed files saves time during the transfer and can 
reduce the charges on some services.

Claris Emailer uses the StuffIt compression technology to compress the 
files. The recipient of the message must have a StuffIt expansion tool to 
expand any compressed files. If the message is received using 
Claris Emailer, enclosures are automatically expanded (by default). 
Because the StuffIt expansion tool is not widely available on computers 
that don’t use the Mac OS, you may not want to use Claris Emailer to 
compress files if the recipient uses a different operating system.

For more information about file compression, see appendix B, 
“Compressing enclosures.”

Note You must compress files if you want to enclose a folder.

To compress enclosed files when the message is sent, select 
Compress files.

Select to compress files

Select an encoding option
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Setting encoding options
Enclosed files are sent using special encoding to ensure that they arrive 
without errors. For more information about encoding, see appendix A, 
“Encoding enclosures.”

To specify an encoding format, choose an option from the Encoding 
pop-up menu.

Removing enclosures from outgoing messages
To remove enclosures, select one or more enclosures in the Enclosure 
area of a message. Then click the  button next to the Enclosure area.

Note When you move an enclosure from an outgoing message, it is not 
removed from your hard disk. 

Adding a signature
You can use a signature to include closing information at the end of your 
messages. For example, your signature could contain your name, 
company, and email address.

To use a signature in a message, you must have created one or more 
signatures. For more information, see “Setting up your signatures” on 
page 10-6.

You can either set up a default signature used for every message for a 
particular account, or you can add a signature on a message-by-message 
basis. For more information about specifying a default signature for 
each account, see the section on setting account options for your email 
service in chapter 3, “Setting up Claris Emailer.”



Creating and sending messages 5-13
To add a signature to an individual message:

1. Open the outgoing message.

2. Choose a signature from the Signature pop-up menu at the bottom of 
the message window.

The signature you choose appears at the end of your message text 
when your message is sent. The signature does not appear in the 
outgoing message window.

Selecting an account to send the message through
If you have more than one account set up in Claris Emailer, you must 
select an account through which you will send the outgoing message.

You set the account through which messages are sent by default in the 
Accounts List window. For more information about setting the default 
account, see “Setting up account information” on page 3-4.

If you want to send a message through a different account, choose the 
desired account from the Send via pop-up menu in the outgoing message 
window.

Claris OfficeMail users If you use Claris Emailer to connect to other 
services in addition to Claris OfficeMail, always choose your 
Claris OfficeMail account from the Send via pop-up menu when 
sending messages to other Claris OfficeMail users on your local 
network.

Choose To display

None No signature in the message

Default for account The default signature that you defined for the account that you 
specified in the Send via pop-up menu. The Send via pop-up 
menu is in the upper-right area of the message window.

Random A random selection from your list of signatures

Internet Config The default signature you defined in your system-wide Internet 
Config setup. For more information, see the documentation that 
comes with Internet Config.

A signature name A specific selection from your list of signatures
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Specifying where the message will be saved
By default, outgoing messages are saved in the Out Box folder before 
they are sent and then moved to the Sent Mail folder when they have 
been successfully sent. 

You can select a different folder to save the outgoing message in. If you 
choose a folder other than the Out Box folder, the message will remain 
where it is after it has been sent.

To set where an open message is filed when you close it, hold down the 
mouse button on the  button in the upper-left corner of the message 
window and choose a folder from the pop-up menu of folders that 
appears. Or, click the  button to select a folder from the Select a 
Folder dialog box. 

The name of the folder you have selected appears to the right of 
the  icon. 

For more information, see “Filing messages from a message list” on 
page 7-8.

Searching for text in an outgoing message
You can perform two types of searches in Claris Emailer:

1 search for occurrences of specified text within an open message

1 search for every message (in a specific folder, or in all folders) that 
contains the specified text

To perform a search, click the  button in the toolbar or choose Find 
from the Edit menu. For more information, see “Searching for text or 
messages” on page 7-11.

Dragging text in an outgoing message
You can drag text within the subject or body areas of a message, or from 
those areas to the desktop or to other messages, by selecting the text and 
then dragging it.

To drag a copy of the text (rather than moving it) within the subject or 
body of a message, hold down the Option key while dragging.
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Using the spelling checker
The spelling checker in Claris Emailer works by comparing words in an 
outgoing message to the spelling dictionaries. Claris Emailer comes 
with a standard main dictionary, but you can create additional personal 
dictionaries, which contain words that you commonly use (for example, 
the spelling of someone’s name). When the spelling checker finds a 
word that is not in the selected dictionaries, it suggests alternatives.

Checking your spelling
Claris Emailer helps you find any spelling errors before you send 
messages. The spelling checker checks only the currently open outgoing 
message window. You can check only one message at a time.

Note You cannot check spelling on an incoming message or connection 
log. Also, the Spelling Checker does not check spelling in the Subject 
field of outgoing messages.

You can check all the text in a message or just text that you select. 

To check spelling in a message:

1. Place the insertion point in the body of the message, or select some 
text in the message.

2. Choose Spelling from the Edit menu and then choose Check Spelling or 
Check Selection.

The Spelling dialog box appears and begins to check the message.

Shows the questionable word in context

Use keyboard shortcut to
replace a word

Shows the word count

Click to replace with the 
word selected in the list 
(changes to Done when 
checking is finished)

Click to add the 
questionable word to 
your user dictionary

Click to hide or show the 
word in context

Click to accept the word as 
is during this spell-
checking session
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Claris Emailer verifies the words you are checking in the main 
dictionary—which was installed with Claris Emailer—and any 
installed user dictionaries. 

1 If Claris Emailer detects a misspelled word, it displays the word in 
the Spelling dialog box and suggests alternative spellings. Select 
the correct spelling from the list and then click Replace to replace 
the incorrect spelling with the correct spelling from the dictionary.

1 If the spelling of a word in question is correct (such as the spelling 
of a name), you can add the word to your user dictionary by 
clicking Learn. Or, click Skip to ignore the word.

1 When there are no more inaccurate spellings, the Done button 
appears in the Spelling dialog box. Click Done to close the Spelling 
dialog box.

Tip To check the spelling of one word, open the Spelling dialog box, 
type the word to check in the Word text box, and click Check.

Selecting or editing a dictionary
You can have more than one main dictionary and more than one user 
dictionary stored on your hard disk. If you want to use a main or user 
dictionary other than the one currently selected, you can select a 
different dictionary. For instance, you can select the dictionary that you 
already use with other Claris applications. You can also edit the terms in 
the user dictionaries.

To select a dictionary, choose Spelling from the Edit menu and then 
Choose Dictionaries. To edit a dictionary, choose Spelling from the Edit 
menu and then Edit User Dictionary.

For more information about selecting and editing dictionaries, look up 
“dictionaries” in the Claris Emailer Help system.

Saving and sending a message
After you create a message, you can:

1 send it as soon as you finish composing it

1 save it and send it at the next connection to a service

1 save it without sending it

1 save it to your desktop as a text document 
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Sending a message right away
After you create a message, you can send it immediately rather than 
filing it and sending it at the next connection. When you send messages 
right away, you can choose to send just one message or all unsent 
messages.

To send a message right away:

1. Click the Send Now button at the upper-right corner of the message 
window.

You see the Send Now Setup dialog box. 

For information about bypassing this dialog box, see “Setting 
outgoing message preferences” on page 10-11.

Note The Send Now button is dimmed if a connection is currently 
running or if you have not specified a recipient for your message.

2. Choose your connection options.

For information about setting connection options, see “Connecting to 
your email accounts right away” on page 4-1.

3. Click Connect.

Your message is closed and sent. 

By default, the sent message is filed in the Sent Mail folder. For 
information about changing where an outgoing message is filed after 
you send it, see “Setting outgoing message preferences” on 
page 10-11.

To send all pending messages right away:

1. Close any open messages that you want to send during this 
connection.

2. Click the  button in the toolbar, or choose Connect Now from the 
Mail menu.

You see the Connect Now Setup dialog box.

3. Choose your connection options.

For information about setting connection options, see “Connecting to 
your email accounts right away” on page 4-1.

4. Click Connect.

Your messages are sent.
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If the outgoing messages were filed in the Out Box folder, they are 
moved to the Sent Mail folder by default. For information about 
changing where an outgoing message is filed after you send it, see 
“Setting outgoing message preferences” on page 10-11.

The next time you want to connect using the same settings, hold down 
the mouse button on the  button in the toolbar and choose 
Connect Again from the pop-up menu that appears. Or, choose 
Connect Again from the Mail menu. Claris Emailer connects without 
presenting a dialog box.

Sending a message at the next connection
To save a message and send it at the next connection:

1. If the button to the left of Send Now is Save As Draft, click the  icon. 
(If the button name is Queue Message, skip this step.)

The button name changes to Queue Message.

2. Click the Queue Message button in the message window. 

The message is saved in the Out Box folder (by default), waiting to 
be sent at the next connection. To change the default folder that 
messages are saved in, see “Setting outgoing message preferences” 
on page 10-11.

Important Outgoing messages saved in the Deleted Mail folder are not 
sent and will be deleted.

The  icon is displayed next to the saved message in the message list, 
indicating that the message will be sent at the next connection. If you 
open a scheduled message in the future, the Queue Message button is 
displayed, reminding you that this is a scheduled message.

Click here… …to change this button 
to Queue Message
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Saving a message without sending it
If you’re not finished composing a message, you can save and close it 
without sending it and continue working on it later. This action stores 
your unscheduled message in a folder that you choose.

To save a message as a draft: 

1. If the button to the left of Send Now is Queue Message, click the 
 icon. (If the button name is Save as Draft, skip this step.)

The button name changes to Save As Draft.

2. Click the Save As Draft button in the message window. 

The message window closes and the message is saved in the Out Box 
folder (by default). 

The  icon is displayed next to the saved message in the message list, 
indicating that the message will not be sent. When you open a draft 
message in the future, the Save As Draft button is displayed, reminding 
you that this message is unscheduled.

To change the default folder that outgoing messages are saved in, see 
“Setting outgoing message preferences” on page 10-11.

Tip To save a message to your hard disk without closing it, choose Save 
from the File menu.

Click here… …to change this button 
to Save As Draft
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Saving a message as text
You can save any message as a text file. The text file can be opened by 
text editors, word processors, and many other applications. 

Saving a message as text does not save the message within 
Claris Emailer. Choose one of the following options to save the message 
within Claris Emailer.

To save a message as a text file:

1. Open the message. 

2. Choose Save As Text from the File menu. 

You see the save file dialog box.

3. Type a name and select a location for the document, and click Save.

For more information about See

Saving an open message without closing it “Saving a message without sending it” on 
page 5-19

Closing and sending a message immediately “Sending a message right away” on 
page 5-17

Closing a message and sending it at the next 
connection

“Sending a message at the next 
connection” on page 5-18

Closing a message and saving it as a draft 
message that will not be sent

“Saving a message without sending it” on 
page 5-19
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Checking the status of messages you send
Folders can contain both incoming and outgoing messages. 
Claris Emailer displays status icons in the message list, giving you 
important information about the message type and whether or not it has 
been sent. After you save or send a message, you can check its status. 

The icons in the  column in the message list show the status of each 
message. 

This icon Shows that the message

Ou
tg

oi
ng Will be sent at the next connection

Has been saved as a draft and will not be sent until you open the message 
and click Queue Message or Send Now

In
co

m
in

g

Is an unread incoming message. The text describing the message appears 
in bold in the message list.

Is an incoming message that you have replied to

Has been partially downloaded and is incomplete

Is partially downloaded, and you have designated it to be fully retrieved 
at the next connection

Is partially downloaded, and you have designated it to be deleted from the 
server at the next connection

Is an auto-file log describing one or more messages that were filed by 
mail actions. Auto-file logs are stored in the Logs folder by default.

Bo
th

Is an outgoing message with an addressing error.
OR
Is an unread connection log. Connection logs are stored in the Logs folder 
by default.

Check these icons for status
information about outgoing mail
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The following indicators also give you information about your 
messages:

1 Incoming messages that have been read (but not replied to) and 
outgoing messages that have been successfully sent do not have icons 
in the  column.

1 Messages that contain one or more enclosures have the  icon in the 
Subject column.

1 Outgoing messages have the word To:  in the From/To column.



Chapter 6:  Receiving messages

This chapter contains information about reading, replying to, and 
forwarding messages you receive, and storing and opening enclosures. 

Collecting your mail
You collect your incoming mail during a connection. Connections are 
described in detail in chapter 4, “Connecting to email services.”

You can immediately retrieve incoming messages from one or more 
email services, or wait until messages are retrieved automatically at the 
next scheduled connection. 

When incoming mail arrives
You can decide how Claris Emailer notifies you when new mail arrives 
on your computer. By default, Claris Emailer plays a tone. When 
Claris Emailer is not the active application, it also displays a flashing 

 icon at the far right of the menu bar. For information about setting 
mail notification options, see “Setting mail notification preferences” on 
page 10-13. 

Messages you receive are stored in the In Box folder by default. You can 
use mail actions to file new incoming mail in other folders. When you 
receive a message, you see the  icon in the Browser for each folder 
that contains new mail. 

To quickly select a folder that has unread mail, hold down the mouse 
button on the  button in the toolbar. You see a pop-up menu of all 
folders containing unread incoming mail and unsent outgoing mail. 
Choose a folder from the pop-up menu to open it. Or, click the 

 button to open the first folder containing unread messages.

For information about See

Retrieving messages immediately “Connecting to your email accounts right away” on 
page 4-1

Setting up a schedule “Scheduling account connections” on page 4-3

Retrieving messages from your 
Claris OfficeMail account

“Receiving mail via Claris OfficeMail” on page 6-10
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The icons in the  column in the message list show the status of each 
message.

The following indicators also give you information about your 
messages:

1 Incoming messages that have been read (but not replied to) and 
outgoing messages that have been successfully sent do not have icons 
in the  column.

1 Messages that contain one or more enclosures have the  icon in the 
Subject column.

1 Outgoing messages have the word To:  in the From/To column.

Working with partially downloaded messages
When you set up the account options for Claris OfficeMail, 
CompuServe, and Internet accounts, you can specify a maximum size 
for downloaded messages. When you receive a message that is larger 
than the size you specified, Claris Emailer downloads a small portion of 
the message (usually the header information and a few lines of text) and 
marks the message with the  icon.

This icon Shows that the message

In
co

m
in

g

Is an unread incoming message. The text describing the message appears 
in bold in the message list.

Is an incoming message that you have replied to

Has been partially downloaded and is incomplete

Is partially downloaded, and you have designated it to be fully retrieved 
at the next connection

Is partially downloaded, and you have designated it to be deleted from the 
server at the next connection

Is an auto-file log describing one or more messages that were filed by 
mail actions. Auto-file logs are stored in the Logs folder by default.

Ou
tg

oi
ng Will be sent at the next connection

Has been saved as a draft and will not be sent until you open the message 
and click Queue Message or Send Now

Bo
th

Is an outgoing message with an addressing error
OR
Is an unread connection log. Connection logs are stored in the Logs folder 
by default.
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When you receive a partially downloaded message, you have the option 
of downloading the full message or deleting the message from the server 
without reading it.

To download or delete a message that has been partially downloaded, 
hold down the mouse button on the  icon in the message list and 
choose an option from the pop-up menu that appears. Or, choose an 
option from the pop-up menu at the upper-right corner of an open 
message window. (The pop-up menu appears only for partially 
downloaded messages.)

Deleting the partially downloaded message If you delete the partially 
downloaded message from Claris Emailer, the full message is deleted 
from the server at the next connection if you have selected the Remove 
mail from server when permanently deleted from Emailer option in the 
account options. If this option is deselected, the full message remains on 
the server, and Claris Emailer partially downloads it again the next time 
you retrieve messages from that account. For more information about 
deleting messages, see “Deleting messages” on page 7-10. 

If you choose this option
The next time you connect to that account, 
Claris Emailer

Leave message on server Does not download or delete the full message

Get entire message at next 
connection

Downloads the full message

Delete message from server at 
next connection

Deletes the message from the server

In a message list In an open message window

Click to
display the

pop-up menu

Click to display the
pop-up menu
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Reading messages
To read a message:

1. In the Browser, select the mail folder that contains the message (by 
default, the In Box folder).

The message list shows the messages in the selected folder.

Tip For information about quickly selecting a folder that has unread 
mail, see “When incoming mail arrives” on page 6-1.

2. Double-click the message you want to read.

You see the message window for the current message.

To go to the next or previous message, click the right or left arrow in the 
upper-left corner of the message window. (Press Option as you click an 
arrow to delete the current message and go to the next or previous 
message.) 

To see the Internet addressing information, choose Show Long Headers 
from the Mail menu. The information in the header pane changes to 
show the full Internet headers for the message. Choose Show Short 
Headers from the Mail menu to return to the default information shown 
by Claris Emailer.

Internet Config users You can launch a URL from Claris Emailer by
2-clicking it in the text of a message. Internet Config starts the 
application you have designated for that type of URL.

Click to show or hide the
Enclosure list

Click to show or hide the
header pane
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Working with enclosed files
If a message you receive has an enclosure, you see the Enclosure list 
when you open the message. You can show or hide the Enclosure list at 
any time by clicking the triangle next to the  icon.

Receiving AppleLink packages You can receive AppleLink packages with 
Claris Emailer. When you receive an AppleLink package, it appears as 
a Claris Emailer enclosure. 

Where enclosures are stored
At the same time you receive an email message in Claris Emailer, any 
enclosures are automatically downloaded to (saved in) the Downloads 
folder in the Claris Emailer Folder. For information about changing the 
default folder where downloaded enclosures are saved, see “Setting file 
and folder preferences” on page 10-13.

To open the folder where downloaded enclosures are saved, choose 
Open Special from the File menu and then choose Downloads Folder. The 
folder is opened in the Finder.

Note When you delete a message that has an enclosure, the enclosure is 
not deleted. For information about deleting an enclosure, see “Deleting 
an enclosure” on page 6-6.

Click to show or hide the
Enclosure list



6-6 Claris Emailer User’s Guide
Opening an enclosure in Claris Emailer
To open an enclosure from within Claris Emailer, double-click it in the 
Enclosure list. Claris Emailer starts the application used to create the 
enclosure. 

Important Claris Emailer cannot open an enclosure by itself. To open an 
enclosure, you must have the application used to create that enclosure. 

Moving an enclosure 
To move an enclosure from within Claris Emailer, drag the enclosure 
from the Enclosure area of the message to a location in the Finder.

To move an enclosure in the Finder, drag the enclosure from the folder 
in which it is located to another location. (By default, enclosures are 
saved in the Downloads folder in the Claris Emailer folder.)

Tip For instructions on changing the default folder where downloaded 
enclosures are saved, see “Setting file and folder preferences” on 
page 10-13.

Deleting an enclosure
When you delete a message that has an enclosure, the enclosure is not 
deleted. 

To delete an enclosure from within Claris Emailer, drag the enclosure 
from the Enclosure area of the message to the trash in the Finder.

To delete an enclosure from the Finder, drag the enclosure from the 
folder in which it is located to the trash. (By default, enclosures are 
located in the Downloads folder in the Claris Emailer folder.)

Note When you delete an enclosure from a message, it is deleted from 
your hard disk but still appears in the enclosure area of the message.

Replying to a message
To reply to a message:

1. Open the message you want to reply to. Or, select the message in a 
message list.

2. Click the  button in the toolbar or choose Reply from the Mail 
menu.
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If there is more than one recipient, the Reply To dialog box appears. 
Select an addressing option in the Reply To dialog box, and click 
Reply. 

Tip To bypass the Reply To dialog box, while you’re still in the 
message, press the Option key as you click the  button. If you 
want to always bypass the Reply To dialog box, see “Setting reply 
preferences” on page 10-11.

In your reply, you can add and remove recipients as you do for a 
message you create. For more information, see “Addressing a message” 
on page 5-3. 

Including text from the original message
You can include part of the original message in your reply. This is 
especially useful if:

1 there is a long delay between the original message and the reply

1 you want your reply to be seen in the context of the original message

1 one or more recipients did not receive the original message

Claris Emailer has a quoting feature you can use to mark the text of an 
original message in a reply. Every line of a quote is preceded by the 
quoting character (>).

Quoted text

Your reply
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Use one of the following methods to add a quote to a reply: 

Adding an attribution line
You can set a preference to display an attribution line above quoted text. 
For instance, you could include an attribution line with this format:

On <date>, <sender> (<sender address>) wrote:

In this example, the attribution line in your reply message might be:

On 1/1/97, Jane Smith (jsmith@aol.com) wrote:

For more information about adding an attribution line, see “Setting reply 
preferences” on page 10-11.

To Do this

Use selected text from the 
original message in a reply

Open the original message, select the text that you want to 
include in the reply, and then create the reply. For 
information on creating a reply, see the previous section.

Copy text from a message (or 
any other text document) and 
then paste it into another 
message

Open a message or other document containing text, and copy 
the text you want to quote. Then position the insertion point 
in the reply and choose Paste as Quotation from the Edit 
menu.

Copy the entire message, 
including details about the 
sender and subject

Open a message, and then choose Copy Entire Message from 
the Edit menu. Then position the insertion point in the reply 
and choose Paste as Quotation from the Edit menu. You can 
also paste the text into any other document that accepts text.

Always quote the entire text of 
a message you are replying to

Select Quote all text of the original message by default in the 
Replies preferences. However, if text in the original message 
is selected when you create the reply, only the selected text 
is quoted.

By default, the insertion point is placed after the quoted text. 
You can set a preference to have Claris Emailer place the 
insertion point before the quoted text. 

For more information, see “Setting reply preferences” on 
page 10-11.
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Forwarding a message
A message you forward contains the complete original message. You 
can edit the text of the forwarded message just as you would a new 
message.

Any enclosures attached to the original message are automatically 
attached to the forwarded message. You can add and remove enclosures 
just as you do for messages you create. For more information about 
adding and removing enclosures, see “Enclosing files” on page 5-8.

To forward a message:

1. Open the message you want to forward. Or, select the message in a 
message list.

2. Click the  button in the toolbar or choose Forward from the Mail 
menu. 

A new outgoing message is created, containing the entire text of the 
original message and any enclosures.

3. Address the message.

You can add recipients just as you do for a message you create. For 
information about addressing the message, see “Addressing a 
message” on page 5-3. 

Filing an open message
To set where an open message is filed when you close it, click the  
button in the upper-left corner of the message window and select a folder 
from the Select a Folder dialog box. Or, hold down the mouse button on 
the icon and choose a folder from the pop-up menu of folders that 
appears.

The name of the folder you have selected appears to the right of the 
 icon. 

For more information, see “Filing messages from a message list” on 
page 7-8.
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Dragging text in an incoming message
You can drag text from the subject or body areas of an incoming 
message to the desktop or to other messages, by selecting the text and 
then dragging it.

Searching for text in incoming messages
You can perform two types of searches in Claris Emailer:

1 search for occurrences of specified text within an open message

1 search for every message (in a specific folder, or in all folders) that 
contains the specified text

To perform a search, click the  button in the toolbar or choose Find 
from the Edit menu. For more information, see “Searching for text or 
messages” on page 7-11.

Saving a message as text
You can save any message as a text file. The text file can be opened by 
text editors, word processors, and many other applications.

To save a message as a text file, follow these steps:

1. Open the message. 

2. Choose Save As Text from the File menu. 

You see the save file dialog box.

3. Enter a name and select a location for the document, and click Save.

Receiving mail via Claris OfficeMail 
Claris OfficeMail is email server software available for purchase from 
Claris. This section applies only to Claris OfficeMail users.

Claris OfficeMail receives your mail from other local users and from the 
Internet (if you have Internet email service). Your mail waits for you on 
the server until your Claris Emailer application retrieves it. 

While Claris Emailer is running, it automatically retrieves and displays 
your mail from Claris OfficeMail as soon as the server receives mail for 
you.
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Claris Emailer does not retrieve your mail under the following 
circumstances:

1 the Claris Emailer application is not running

1 your account information is inaccurate in the Claris OfficeMail 
Service Entry dialog box (such as an incorrect email name or 
password)

1 you deselected Get mail in the account options for the account (for 
more information, see “Setting Claris OfficeMail mail handling 
options” on page 3-12)

1 you disabled the connection to Claris OfficeMail by deselecting 
Connect to this service in the Claris OfficeMail Service Entry dialog 
box

1 the Claris OfficeMail application is not running on the server 
machine

1 your machine is not networked with the server machine

In addition, Claris Emailer does not retrieve your mail automatically 
under the following circumstances (but you can still connect to 
Claris OfficeMail using Connect Now or a connection schedule):

1 the Claris Emailer Notifier file is not in the Claris Emailer 
Files folder

1 the Claris OfficeMail server is started after you start the 
Claris Emailer application on your computer. You must restart your 
computer in order to retrieve mail automatically.

1 you are using a TCP/IP connection—rather than an AppleTalk 
connection—to the server

When Claris Emailer cannot retrieve your mail for one of the reasons 
described above, the mail waits for you on the server machine. The next 
time you successfully connect, Claris Emailer retrieves all the mail that 
is waiting for you.

For information about setting mail notification options for your 
Claris OfficeMail accounts, see “Setting Claris OfficeMail mail 
handling options” on page 3-12.
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What is my Claris OfficeMail email address? 
This section applies only to Claris OfficeMail users.

Anyone in your office who is also using Claris OfficeMail can send you 
email by typing your email name in the Recipient area of an outgoing 
message. Claris Emailer automatically fills in your email address. 

If you are using ClarisLink
If your office is using ClarisLink to connect to the Internet, your 
Claris OfficeMail administrator chooses the domain name that is used in 
the Internet part of your email address. Your email address has one of 
the following formats, where company is your company’s domain name:

YourEmailName@company.clrs.com

or

YourEmailName@company.com

Important Ask your server administrator for your Internet email address.

This email address can be used by people outside your local network 
who have access to the Internet and want to send you email.



Chapter 7:  Working with folders and message lists

Message lists appear in the Browser, in folder windows, in search 
results, and in auto-file logs. This chapter provides information about 
setting up folders and subfolders; filing, prioritizing, printing, and 
deleting messages; and searching for text within messages.

Working with folders
Incoming and outgoing messages are stored in folders. A folder can 
contain both incoming and outgoing mail.

You can view a list of folders by choosing Browser or Folder List from the 
Window menu. The Browser displays folders and messages.

The Folder List window displays only folders.
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Icons on the folders tell you information about the contents of the 
folders.

Special properties of the default folders
There are six default folders that come with Claris Emailer. These 
folders have some special properties.

This icon Indicates

There are unread or unsent messages in the folder.

There are unread or unsent messages in the Deleted Mail folder. 

All messages in the folder will be permanently deleted on a schedule set 
up in the Preferences dialog box (see “Setting file and folder preferences” 
on page 10-13).

The folder contains subfolders. You can view the list of subfolders by 
clicking the triangle.

Folder name Special properties

All default folders Default folders always appear at the top of the Folder list and are a darker 
color than folders you add.

Default folders cannot be deleted or have subfolders.

In Box By default, new incoming mail is filed in this folder.

Out Box By default, unsent outgoing mail is filed in this folder. 

When an outgoing message is sent from this folder, it is automatically 
re-filed in the Sent Mail folder by default.

Sent Mail When an outgoing message is sent from the Out Box folder, it is 
automatically re-filed in this folder by default. 

This folder is emptied on a schedule defined in the Preferences dialog 
box.

Deleted Mail All deleted messages are filed in this folder.

This folder is emptied on a schedule defined in the Preferences dialog 
box.

Read Mail You can set a preference to file incoming mail that you have read into 
this folder. 

This folder is emptied on a schedule defined in the Preferences dialog 
box.

Logs New incoming connection logs and auto-file logs are filed in this folder 
by default. 
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Setting up folders and subfolders
You can add, rename, mark, and delete folders, and create subfolders 
within folders.

You can add as many folders as you want. Give each folder a meaningful 
name, such as Project Status. You can delete only folders you’ve added. 
(You cannot delete the default folders.)

A marked folder is a folder that appears in the Folder pop-up menu—
which appears when you click the  icon in the toolbar or in a message 
window—and in the Marked Folders view of the Folder list in the Browser 
window. By default, all folders are marked.

A subfolder is a folder stored inside another folder. For example, the 
Project X folder might contain the subfolders Customers, Project Info, 
and Meetings. Subfolders have all the same properties as folders and can 
contain subfolders. You can have as many subfolders as you want. 
However, you cannot add subfolders to the six default folders. 

To Do this

Add a folder Choose New Folder from the Folder menu. Then type a name for the folder 
and click OK. 

Add a subfolder Select a folder and choose New Subfolder from the Folder menu. Then type 
a name for the subfolder and click OK. 

You cannot add subfolders to the default folders.

Rename a folder Select the folder and choose Edit Folder from the Folder menu. Rename the 
folder and click OK.

Mark or unmark 
a folder

Select the folder and choose Edit Folder from the Folder menu. Select or 
deselect Appears in Folder pop-up menu and click OK. 

Delete a folder Select the folder and choose Delete Folder from the Folder menu.

You cannot delete a default folder.
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Selecting which folders appear in the Browser
You can decide which folders appear in the Folder list in the Browser. 
By default, all folders appear. 

To view only folders you have marked, choose Marked Folders from the 
View pop-up menu above the Folder list in the Browser window. 

Note When you view only marked folders, the folders you have added 
appear in alphabetical order, with no folder hierarchy.

To view all folders, choose All Folders from the View pop-up menu.

For information about marking folders, see the previous section, 
“Setting up folders and subfolders.”

Resizing the Folder list area in the Browser
You can make the Folder list in the Browser narrower or wider.

To resize the Folder list:

1. Position the pointer over the  between the Folder list and the 
Message list.

2. When the pointer changes to a , drag it left or right until the Folder 
list is the size you want. 

Click and drag here to
resize the Folder list
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Viewing the contents of folders
To view the contents of a folder in the Browser, click the folder name in 
the Folder list in the Browser.

To view the contents of a folder in a separate window, double-click the 
folder name, or select the folder and press Enter.

You see a new window containing all the messages in the folder. You 
can work with the list of messages in this window just like you do in the 
message list in the Browser.

Click a folder to see the
messages it contains

These messages are in
the In Box folder
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Working with messages in message lists
Message lists appear in the Browser, in folder windows, in search 
results, and in auto-file logs. 

The icons in the  column in the message list show the status of each 
message.

This icon Shows that the message

In
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m
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g

Is an unread incoming message. The text describing the message appears 
in bold in the message list.

Is an incoming message that you have replied to

Has been partially downloaded and is incomplete

Is partially downloaded, and you have designated it to be fully retrieved 
at the next connection

Is partially downloaded, and you have designated it to be deleted from the 
server at the next connection

Is an auto-file log describing one or more messages that were filed by 
mail actions. Auto-file logs are stored in the Logs folder by default.

Ou
tg

oi
ng Will be sent at the next connection

Has been saved as a draft and will not be sent until you open the message 
and click Queue Message or Send Now

Bo
th

Is an outgoing message with an addressing error
OR
Is an unread connection log. Connection logs are stored in the Logs folder 
by default.

This message list
appears in a folder

window
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The following indicators also give you information about your 
messages:

1 Incoming messages that have been read (but not replied to) and 
outgoing messages that have been successfully sent do not have icons 
in the  column.

1 Messages that contain one or more enclosures have the  icon in the 
Subject column.

1 Outgoing messages have the word To:  in the From/To column.

Selecting messages
You can select messages in any message list to work with them. 

Sorting messages
You can sort messages in any message list by message status, subject, 
sender/recipient, date, priority, or account. 

To sort a message list, click a column heading. The pointer changes to a 
 when you move it over the column heading. 

To change the sort order, click the sort button in the upper right area of 
the message list. Display  for an ascending sort or  for a 
descending sort.

Resizing columns in a message list
You can resize the columns in any message list.

To resize a column:

1. Position the pointer over the vertical line between two column 
headings. 

To select Do this

A message Click anywhere on the message row.

More than 
one message

Shift-click the messages you want to select. To deselect a message, 
or to select noncontiguous messages, 2-click the messages.

The message above or 
below the currently 
selected message

Press the Up or Down Arrow key.

Every message in the 
current folder

Choose Select All from the Edit menu.
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2. When the pointer changes to a , press the mouse button and drag 
left or right until the column is the size you want. 

Filing messages from a message list
Filing messages in folders helps you organize your email. A folder can 
contain both incoming and outgoing messages. 

By default, incoming messages are filed in the In Box folder, unsent 
outgoing messages are filed in the Out Box folder, and outgoing 
messages that have been successfully sent from the Out Box folder are 
filed in the Sent Mail folder. 

You can move any message to any folder.

Note This section explains how to file a message from a message list. 
You can also file an open incoming or outgoing message from within the 
message window. For more information, see “Filing an open message” 
on page 6-9.

To move messages from a message list to any folder:

1. Select the messages.

2. Drag the selected messages from the message list to a folder in the 
Folder list or to an open folder window.

To move messages from a message list to a marked folder:

1. Select the messages.

2. Hold down the mouse button over the  button in the toolbar.

3. Choose the folder name from the pop-up menu that appears. 

For more information about marked folders, see “Setting up folders and 
subfolders” on page 7-3.

To use the Select a Folder dialog box to file messages:

1. Select the messages.

2. Click the  button in the toolbar.
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You see the Select a Folder dialog box.

3. Select or create a folder to file the messages in.

1 To select an existing folder, click its name in the folder list.

1 To create a new folder to file the messages in, click New Folder. 
You see the New Folder dialog box. Name the folder and click OK.

1 To create a new subfolder to file the messages in, select a folder 
and click New Subfolder. You see the New Subfolder dialog box. 
Name the folder and click OK.

4. Click Select to close the Select a Folder dialog box and file the 
messages.

Labeling messages with priorities
Assigning priorities to your mail helps you identify the importance of a 
message. You can sort messages with a higher priority so they appear at 
the top of their folder. You can also show these messages in a different 
color. 

You set the color and label for priorities in the Preferences dialog box. 
For more information, see “Setting priority preferences” on page 10-14.

All incoming messages are Priority 1 by default.

To assign a priority to a message:

1. Select the message in a message list.

2. Choose Priority from the Mail menu and then choose a priority level 
from the submenu.
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Tip You can also assign priorities to incoming mail using mail actions. 
With mail actions, Claris Emailer sets the priority of incoming messages 
for you, based on criteria you set. For instance, you could have 
Claris Emailer make all mail from your supervisor Priority 2 and 
messages from mailing lists Priority 20. For more information, see 
chapter 9, “Using mail actions.”

Printing messages
You can print any message. You can print the frontmost open message, 
or you can print one or more messages selected in a message list.

To change the page setup before you print:

1. Choose Page Setup from the File menu. 

2. Select your options and click OK. 

For information about creating a default page setup, see “Setting 
defaults preferences” on page 10-9. 

To print messages:

1. Select the messages you want to print.

1 If a message window is open and is the frontmost window, it is the 
selected message.

1 To print one or more messages from a message list, select the 
messages in the list.

2. Click the  button in the toolbar, or choose Print from the File 
menu. 

3. In the Print dialog box, select the options you want, and click Print. 

Tip To bypass the Print dialog box and print a message, choose Print One 
from the File menu. Your message prints using the default print settings.

Deleting messages
By default, when you delete a message it is moved to the Deleted Mail 
folder. If you later find that you deleted the message by mistake, you can 
move it back to another folder.
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Important When you delete a message from the Deleted Mail folder, it is 
permanently deleted from your hard drive. The Deleted Mail folder is 
emptied automatically on a schedule you set in the Preferences dialog 
box. For more information, see “Setting file and folder preferences” on 
page 10-13.

Note When you delete a message that has an enclosure, the enclosure is 
not deleted. For information about deleting an enclosure, see “Deleting 
an enclosure” on page 6-6.

To delete an open message, click the  button in the toolbar.

To delete selected messages, select the messages in the message list and 
then press the Delete key or click the  button in the toolbar.

To delete all messages in a folder:

1. Select the folder in the Browser.

2. Click anywhere in the message list.

3. Choose Select All from the Edit menu.

4. Press the Delete key or click the  button in the toolbar.

Searching for text or messages
You can perform two types of searches in Claris Emailer:

1 search for occurrences of specified text within an open message

1 search for every message (in a specific folder, or in all folders) that 
contains the specified text

To perform a search:

1. Click the  button in the toolbar or choose Find from the Edit 
menu.

You see the Find dialog box. 

Select a scope for
the search

Enter the text you 
want to search for
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2. In the Find text box, type the text you want to search for. 

3. Select one of the options to define the scope of the search.

If you were in an open message, the Find dialog box defaults to 
searching in the current message.

If the Browser was the frontmost window, the Find dialog box 
defaults to searching in the currently selected folder.

4. Optionally, select Search subject only to look for the specified text only 
in the message subject.

5. Click Find to begin the search.

If you are searching within an open message, Claris Emailer 
highlights the first occurrence of the specified text. To find the next 
occurrence, choose Find Again from the Edit menu. Claris Emailer 
beeps if there are no more occurrences in the message.

If you are searching for messages that contain the specified text, 
Claris Emailer presents a message list window containing the 
messages that met your criteria. You can open, delete, print, 
prioritize, or file messages from this window.

To bypass the Find dialog box when searching for text within a message:

1. Select the text you want to search for.

2. Press 2-E to enter the selected text as the search criteria.

The Find dialog box does not appear.

3. Press 2-G or choose Find Again from the Edit menu to find each 
occurrence of the text.
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Use the Address Book to store addresses. The Address Book can contain 
both individual and group addresses. You can import addresses from 
other applications or text files and export addresses to tab-delimited text 
files.

After you add addresses to the Address Book, you can use them to 
address outgoing messages. For more information, see “Addressing a 
message” on page 5-3.

To open the Address Book window, click the  button in the toolbar 
or choose Address Book from the Window menu. You see the Address 
Book window.

Claris OfficeMail users If you are using Claris Emailer with 
Claris OfficeMail on an AppleTalk network, your Address Book is 
automatically updated to include the names and addresses of everyone 
on your OfficeMail server. However, if you are using a TCP/IP 
connection to connect to the OfficeMail server, the Address Book is not 
automatically updated.

Individual address (contact)

Group address

Individual with more than one
email address (click the triangle to

show or hide additional addresses)
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Adding addresses to the Address Book
There are many ways to add addresses to the Address Book. You can 
type them manually, add them from incoming or outgoing messages, 
drag them from text areas, or import them from other files. 

You enter addresses differently depending on the contact’s destination. 
To avoid making errors in addresses, follow these guidelines: 

Important Make sure that you choose the appropriate destination from 
the destinations list. For more information, see “Speeding address entry 
using destinations” on page 2-13 and “Customizing the destinations list” 
on page 10-1.

Adding addresses manually
To add an address to the Address Book manually:

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

You see the Address Book window.

2. Click New Contact. 

You see the Contact Entry dialog box.

If this is your 
destination

Enter this for the 
contact’s address Example

Internet The full Internet address BAddington@sushicorp.com

Any other destination The contact’s account name (to 
the left of the @ sign) only

BAddington

Type the contact’s
first and last names

The description can be a 
company name, a category 
(such as Friend or Family), or 
anything else you want
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3. Enter a name and description for the contact.

4. In the Address column, type the email address.

You do not have to type the @ sign or anything after it, unless you 
choose Internet for the destination (see below).

5. In the Destination column, type the name of the contact’s destination. 

Destinations are shortcuts for entering the information after the @ 
sign in an email address. For example, type America Online if 
the contact’s address ends in @aol.com. For more information, see 
“Speeding address entry using destinations” on page 2-13.

As you type, Claris Emailer fills in the rest of the destination for you. 
Keep typing until Claris Emailer fills in the correct destination. (If 
you want, you can choose a destination from the pop-up menu instead 
of typing.)

If the contact’s destination does not appear in the Destination pop-up 
menu, choose Internet for the destination and type the entire Internet 
address in the Address column. For more information about creating 
your own destinations, see “Customizing the destinations list” on 
page 10-1.

6. If the contact has more than one email address, click the  icon to 
add another address line, and then repeat steps 4 and 5. 

Continue adding lines until you’ve added all of the contact’s 
addresses.

Note To delete one of the contact’s addresses, click anywhere in the 
address line and click the  icon.

7. Click in the  column next to the address that you want to be the 
preferred address. 
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Claris Emailer uses the preferred address by default when addressing 
a message.

8. Click Save.

Adding the sender’s address from an incoming message
To add the address of the sender of an incoming message to your 
Address Book:

1. Open the message containing the address you want to add.

2. Click the  button to the left of the sender’s name.

The Contact Entry dialog box appears.

3. In the dialog box, edit the name and add a description, if necessary.

4. Click Save.

You see this marker next
to the preferred address

Click here to add the sender
to your Address Book
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Adding an address from a text area
There are two ways to quickly add an address that appears in a text area 
to the Address Book:

Quickly copying an address to the Address Book
You can copy an address that appears in the header area of an incoming 
message or in the message body of an incoming or outgoing message. 

To copy an address to the Address Book:

1. Select the text of the address.

To see a list of the address formats that Claris Emailer recognizes, 
look up “address formats” in the Claris Emailer Help system.

2. Choose Copy to Address Book from the Edit menu.

The Contact Entry dialog box appears.

3. In the dialog box, edit the name and add a description, if necessary.

4. Click Save.

Dragging an address to the Address Book
Follow these steps to drag an address from a text area or a text clipping 
to the Address Book. For more information about drag and drop, see 
“Working with Macintosh drag and drop” on page 2-17. 

To see a list of the address formats that Claris Emailer recognizes, look 
up “address formats” in the Claris Emailer Help system.

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Arrange the windows so that you can see both the Address Book and 
the address you want to add. 

Method Advantages

Choose Copy to Address Book from the 
Edit menu

The Address Book does not have to be open.

Drag the address to the Address Book 
using Macintosh drag and drop

This method works with text in other applications 
that support drag and drop and in text clippings. 
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3. Select the desired address.

1 If you are dragging an address from a text area, select the address 
text.

1 If you are dragging an address from a text clipping, select the text 
clipping icon on the desktop.

4. Drag the selected address to the Address Book.

As you drag the address into the Address Book, you see a border 
around the list area. 

1 If you dragged a single address, you see the New Contact dialog 
box when you release the mouse button.

1 If you dragged multiple addresses, they are added as a group and 
you see the Group Entry dialog box when you release the mouse 
button.

5. In the dialog box, edit the name and add a description, if necessary.

6. Click Save.

Importing addresses
You can import addresses into your Claris Emailer Address Book from 
another email program or from a tab-delimited text file.

Importing addresses from another email program
If you have addresses in one of the following email programs, you can 
import them directly into Claris Emailer.

Note For information about importing America Online 3.x address 
books, see the Important Information file in the Claris Emailer Folder.

Email program Address book filename Location

America Online 2.7 or 
earlier

Address Book Online Tools folder in AOL folder

CompuServe 
Information Manager

CompuServe Addresses CompuServe folder in System 
Preferences folder

CompuServe 
Navigator

CompuServe Addresses Navigator folder

Eudora Eudora Nicknames Eudora Folder in System Folder

eWorld Address Book Online Tools folder in eWorld 
folder
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To import addresses from another email program:

1. In Claris Emailer, choose Import Addresses from the File menu.

2. In the dialog box that appears, find the file you want to import.

3. Click Open. 

Importing addresses from a text file
If your addresses are not in one of the email programs listed in the 
previous section, you can import them from a tab-delimited text file. 

At a minimum, your text file should include fields for the following four 
types of data (in this order): first name, last name, company name (or 
description), and address. If necessary, include additional address fields 
for contacts who subscribe to more than one email service.

Note If your text file includes full Internet addresses, Claris Emailer 
automatically chooses the correct destination for those addresses. For 
example, Claris Emailer chooses America Online as the destination for the 
address DanielleB@aol.com. If the destination for an imported address 
isn’t in the Destinations list, Claris Emailer chooses Internet as the 
destination. (For more information, see “Customizing the destinations 
list” on page 10-1.)

If you’ve organized your addresses by service, you may want to add a 
heading and import the contact names without the full Internet address. 
For example, your text file could have a heading for America Online, 
and contain addresses like BAddington instead of 
BAddington@aol.com.

Note Be sure to keep data under the correct column heading. If there’s 
no data in a certain field, add a tab character for that field.

First 
name

Company 
name

Last 
name

Address 1 Address 2 

Addresses

Heading
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Follow these steps to import addresses from a text file:

1. In Claris Emailer, choose Import Addresses from the File menu.

2. In the dialog box that appears, find the file you want to import and 
click Open. 

3. In the Import Addresses dialog box, select Ignore first record if the text 
file contains a heading.

4. If necessary, choose options from the service pop-up menus to tell 
Claris Emailer how to import your data.

 

Choose To

Skip Field Ignore the field and not import it. For example, you can choose this 
option if a field is blank, or contains phone numbers or other data you 
don’t need to import.

No Service Import the address without specifying the service. (Later, you can go 
to the Address Book and specify a service for each imported address.)

A service name Select that service for the field.

Service pop-up menus
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5. Click  and  to preview records to make sure the preview data 
corresponds to the correct Address Book fields.

If the file is not properly formatted (for example, if the last name 
appears in the first name line), click Cancel and create a new import 
file.

6. Click Import.

Creating groups
You can consolidate several contact addresses into a group. When you 
send a message to a group, every contact in the group receives the 
message.

Note Addresses you add to a group are not linked to individual addresses 
in your Address Book. If you edit individual addresses, they do not 
change the addresses in any group. To edit addresses in a group, you 
must double-click the group to open the Group Entry dialog box and 
make the changes there.

To create a group:

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. If there are individual addresses in the Address Book that you want to 
add to the group, select them now.

For information about selecting addresses, see “Selecting entries in 
the Address Book” on page 8-14.
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3. Click New Group. 

You see the Group Entry dialog box. Any individuals that were 
selected when you clicked New Group are automatically added to the 
group.

4. Enter a group name and description.

5. Follow the instructions in the next section for adding addresses to a 
group.

6. Click Save.

For more information about See this section

Adding addresses to the group you 
created

“Adding addresses to a group” on page 8-11

Removing an address from a group “Removing entries from a group” on page 8-13

Sorting the addresses in a group “Sorting addresses in a group” on page 8-13

Deleting a group “Deleting an entry from the Address Book” on 
page 8-15
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Adding addresses to a group
After you have created a group, you can add addresses to it in the Group 
Entry dialog box by typing them manually or by dragging them to the 
dialog box using Macintosh drag and drop. You can drag addresses from 
the Address Book or from any text area.

Adding group addresses manually
To type addresses directly into the Group Entry dialog box:

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Click New Group or double-click the group to which you want to add 
addresses.

3. Click the  icon in the Group Entry dialog box.

4. Type the first and last names of a contact in the Contact Name column.

5. Type the contact’s email address in the Address column.

6. Type the name of the contact’s destination in the Destination column. 

Destinations are shortcuts for entering the information after the @ 
sign in an email address. For example, type America Online if 
the contact’s address ends in @aol.com. For more information, see 
“Speeding address entry using destinations” on page 2-13.

As you type, Claris Emailer fills in the rest of the destination for you. 
Keep typing until Claris Emailer fills in the correct destination. (If 
you want, you can choose a destination from the pop-up menu instead 
of typing it.)

If the contact’s destination does not appear in the Destination pop-up 
menu, choose Internet for the destination and type the entire Internet 
address in the Address field. For more information about creating 
your own destinations, see “Customizing the destinations list” on 
page 10-1.

7. To enter addresses for additional contacts, repeat steps 3 through 6. 
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Dragging addresses to a group
You can drag addresses to a group from a text area, a text clipping, or 
the Address Book. For more information about drag and drop, see 
“Working with Macintosh drag and drop” on page 2-17. 

To see a list of the address formats that Claris Emailer recognizes, look 
up “address formats” in the Claris Emailer Help system.

To drag an address to a group:

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Click New Group or double-click the group to which you want to add 
addresses.

3. Arrange the windows so that you can see both the Group Entry dialog 
box and the addresses you want to add to the group. 

4. Select the desired addresses.

1 If you are dragging addresses from a text area, select the address 
text.

1 If you are dragging addresses from a text clipping, select the text 
clipping icon on the desktop.

1 If you are dragging addresses from the Address Book, select the 
desired contacts. Shift-click to select more than one contact. To 
deselect a contact, or to select noncontiguous contacts, 2-click 
the contacts.

5. Drag the selected addresses to the Group Entry dialog box.

As you drag the addresses into the Group Entry dialog box, you see a 
border around the address area. When you release the mouse, the 
contacts are added to the group.
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Removing entries from a group
To remove an entry from a group:

1. Open the Group Entry dialog box by double-clicking the group’s 
name in the Address Book.

2. Click anywhere in the address line of the entry you want to remove.

3. Click the  icon in the dialog box.

Note If a person in a group also has an individual address in the Address 
Book, removing the address from the group does not delete the 
individual address from the Address Book. 

Sorting addresses in a group
You can sort the entries in a group by name, address, or destination. 

To sort the entries in a group, click the column heading of the column 
you want to sort on. The pointer changes to a  when you move it over 
the column heading. 

Important If you subsequently add a new member to the group, the new 
member is added to the bottom of the list. You can then sort the group 
again, if you want to.

Entry that will be removed
from the group
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Selecting entries in the Address Book
You can select addresses in the Address Book to add them to a group or 
use them to address messages. (For more information, see “Adding 
addresses to a group” on page 8-11 and “Addressing a message” on 
page 5-3.)

To narrow down the number of addresses that appear in the Address 
Book, type a few letters in the Filter text box. To display all the addresses 
again, delete the letters from the Filter text box.

You can type lowercase or uppercase letters. Claris Emailer finds all the 
contacts that contain the specified letters in the Name and Description 
fields. For example, typing pa finds “Japan University” and “Yassilis 
Papanico.”

Note You cannot enter part of a first name and a last name to create a 
match. For example, entering sal will doesn’t find “Sally Willford.”

To select Do this

An address Click anywhere on the address row.

More than 
one address

Shift-click the addresses you want to select. To deselect an address, or 
to select noncontiguous addresses, 2-click the addresses.

The address above 
or below the 
currently selected 
address

Press the Up or Down Arrow key.

Every address in 
the Address Book

Choose Select All from the Edit menu.

A different address 
for a contact with 
multiple addresses

Click the triangle next to the contact’s name to display other addresses 
for the contact. Then select the row containing the address you want. 

Type the letters 
you want to 
search for
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Sorting entries in the Address Book
You can sort the entries in the Address Book by name or description. 

To sort the entries, click the column heading of the column you want to 
sort on. The pointer changes to a  when you move it over the column 
heading. 

To change the sort order, click the sort button in the upper right area of 
the message list. Display  for an ascending sort or  for a 
descending sort.

Deleting an entry from the Address Book
Important You cannot undo this action.

To delete an address or group permanently from the Address Book:

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Select the address or group that you want to delete.

3. Click the  button in the toolbar or press the Delete key.

Claris Emailer asks you to confirm the deletion.

Tip Press Option when deleting to bypass the confirmation dialog box 
and delete the address. If you want to always bypass the confirmation 
dialog box, see “Setting defaults preferences” on page 10-9.

Exporting addresses
After you have entered addresses in your Address Book, you can reuse 
the information in other applications by exporting the addresses. This 
section discusses ways to export addresses from Claris Emailer.

Exporting all the contacts from your Address Book
To export the addresses from your Address Book to a tab-delimited text 
file:

1. Choose Export Addresses from the File menu.

2. Type a name and choose a location for the export file.

3. Click Save.

Important Groups (and the contacts they contain) are not exported.
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Converting addresses in your Address Book to URLs
When you drag entries from the Address Book to the body of an 
outgoing message, to another application that supports drag and drop, or 
to the desktop, the addresses become URLs (Uniform Resource 
Locators).

The URLs appear in the following format:

<mailto: "Jane Smith" jsmith@aol.com>

If you drag entries from the Address Book to the desktop, the URLs are 
contained in text clippings. Later, you can drag a text clipping to an 
outgoing message or back to the Address Book, or send the text clipping 
as an enclosure in a message. For more information about text clippings, 
see “Working with Macintosh drag and drop” on page 2-17.

To convert addresses in the Address Book to URLs: 

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Select one or more addresses from the Address Book. 

Shift-click to select more than one Address Book entry. To deselect 
an entry, or to select noncontiguous entries, 2-click the contacts.

3. Drag the addresses to the desired location.

If you drag You create

One or more contacts to the desktop Individual text clippings containing URLs for 
each address

A group to the desktop A single text clipping containing URLs for every 
address in the group

Addresses to the body of an outgoing 
message

A list of individual URLs

A group to the body of an outgoing 
message

A list of individual URLs
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Mail actions let you organize and manage your incoming mail. When 
you receive a message, you can automatically prioritize it, file it in a 
folder, send a reply, forward the message, or perform many other actions 
using AppleScript.

You can use mail actions in several ways. For example, you can:

1 label messages with priorities

1 file incoming messages from certain people or groups in specific 
folders

1 automatically send a reply message, such as when you are on vacation

1 automatically forward messages from all of your accounts to a single 
account to use, for example, when you travel

Mail actions are applied after all messages are downloaded during a 
connection.

Creating mail actions
Mail actions compare each incoming message with criteria that you 
specify. If the message meets your criteria, the actions you select occur. 
For example, you could create a mail action to test if the subject of a 
message contains Project X. If it does, then the mail action could 
automatically file the message in the Project X folder. It could also send 
an automatic reply saying that you received the message. 

You can create several different mail actions and enable and disable 
them as needed.
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To create a mail action:

1. Choose Mail Actions from the Setup menu.

You see the Mail Actions List window.

Note If you have not created or deleted any mail actions yet, the Mail 
Actions List window contains only the Vacation mail action.

2. Click New.

You see the Mail Action Entry dialog box. 

3. Type a name for the mail action.

It’s a good idea to give the mail action a name that makes it easily 
recognizable. For example, an action named Project X might file all 
project-related mail in a special folder.

Click to create a new 
mail action

Click to place a checkmark
next to the mail actions you

want to enable

Name the mail action

Define criteria for incoming
messages

Define actions that will be
performed if the criteria are met

Enable or disable the mail action
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4. Set the criteria for the mail action by making appropriate selections 
from the pop-up menus and typing text into the text box.

For more information about setting criteria, see the next section, 
“Setting mail action criteria.” 

5. Click Define Actions to specify the actions to be performed on 
incoming messages that meet your criteria.

You see the Action Entry dialog box.

6. Specify the actions you want to occur when the message meets 
the criteria you set in step 4, and then click Save.

For more information about setting actions, see “Setting actions for 
criteria-met mail” on page 9-8. 

7. Click Save.
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Setting mail action criteria
A mail action tests each incoming message using the criteria you select. 
You can apply the criteria to different areas of a message. For example, 
you can test for the sender’s address or for words in the message itself. 
You can use multiple criteria for one mail action.

To set the mail action criteria:

1. In the Mail Action Entry dialog box, choose the part of the message 
you want to test from the leftmost pop-up menu.

You can apply a test to each of the following areas of a message:

Choose To test

From The address of the message sender

To The addresses of the recipients

CC The addresses of the carbon copied (CC) recipients

Reply-to The addresses in the reply-to field. Reply-to fields are primarily used in 
messages sent from an Internet account.

Any recipient The address of any recipient (To or CC)

Subject The subject of the message

Message body The text of the message

Internet header The contents of a particular Internet header. Specify the header in the 
Header text box that appears.

Mail account The account that you used to receive the mail

Mail service The email service through which you received the mail

All mail All incoming messages

Type the text to 
compare 
against the 
message area

Choose the test condition

Choose the message
area to test

Click to set 
multiple criteria
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2. Choose the test condition from the rightmost pop-up menu.

Note You cannot apply every test to all areas of a message. For 
example, you cannot test whether the subject of a message is in the 
Address Book, and you cannot test the contents of the BCC field.

3. In the text box, type the text that you want Claris Emailer to look for.

Important Consider what text you use, as Claris Emailer is not case-
sensitive. For example, Sam tests true for Sam and sam. If you are 
testing for a certain address, you should use a complete email address 
to be most accurate.

4. If you want to create a more complex comparison, click More Choices.

You see the Criteria area for multiple criteria. For more information 
see the next section, “Using multiple criteria.”

5. Click Save to save the criteria.

Choose If the text

Is Must match the specified text exactly

Is not Must not match the specified text exactly

Begins with Begins with the text you enter

Does not begin with Does not begin with the text you enter 

Ends with Ends with the text you enter

Does not end with Does not end with the text you enter

Contains Contains the text you enter

Does not contain Does not contain the text you enter

Is in address book Is in the Address Book. The address can be for an individual or a 
member of a group. This test can be applied only to address fields.

Is in specific group Is in a specific group. Use the pop-up menu to choose the name of 
the group. This test can be applied only to address fields. 

Is in any group Is in any group. This test can be applied only to address fields.
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Using multiple criteria
If a single test is not enough to identify the message accurately, you can 
create additional tests by clicking More Choices in the Mail Action Entry 
dialog box. For example, when you receive email containing Sam in the 
sender’s address, you could apply a second test to look for Project X in 
the subject line. If both tests are true, then you could set a high priority 
to the message and file it in a special folder.

When you use multiple criteria, you can decide what to do if the test is 
true (the incoming message matches the criteria) and what to do if the 
test is false (the incoming message does not match the criteria).

You can have up to 20 test criteria in one mail action.

To use multiple criteria:

1. Create the first test, using the same procedure you would use to create 
a single test.

For more information, see “Setting mail action criteria” on page 9-4.

2. In the Mail Action Entry dialog box, click More Choices.

You see the Criteria area for multiple criteria. 

The first test you entered appears on the first line in the Criteria area.

3. Click  in the If True column and choose an item from the pop-up 
menu that appears.
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You have the following options:

4. Repeat step 3 in the If False column.

5. Add, edit, or delete tests as necessary.

1 To add a test, click the  button. You see the Mail Action 
Criteria dialog box. Set the additional criteria, and then click Save.

1 To edit a test, select the test to edit and click the  button. You 
see the Mail Action Criteria dialog box. Edit the criteria, and then 
click Save.

1 To delete a test, select the test to delete and click the  button.

6. When you are finished, click Save in the Mail Action Entry dialog 
box. 

Note If you want to delete the multiple criteria and revert to a single 
test, click Fewer Choices before you click Save. The multiple criteria 
you created are discarded.

Choose If you want to

Apply actions Apply the defined actions to the message and skip the following 
tests

Don’t apply actions Not apply the defined actions, and skip the following tests

Go to line #N, or 
Go to next line

Not apply the defined actions, but go to the specified line and 
perform the test specified on that line
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Setting actions for criteria-met mail
When an incoming message meets your mail action criteria, you can 
have Claris Emailer perform a variety of actions on that message. 

To choose which actions to perform, click Define Actions in the Mail 
Action Entry dialog box. You see the Action Entry dialog box.

You can perform the following actions:

Action For more information, see

Set priority “Assigning a priority to a message automatically” on 
page 9-9

File message “Filing a message automatically” on page 9-9

Auto reply to message “Creating an automatic reply to a message” on page 9-10

Auto forward message “Forwarding a message automatically” on page 9-11

Add sender to Address Book “Adding the sender to the Address Book automatically” 
on page 9-13

Add sender to group “Adding the sender to a group automatically” on 
page 9-13

Remove sender from group “Removing the sender from a group automatically” on 
page 9-13

Run AppleScript “Running an AppleScript document automatically” on 
page 9-13

Print message “Printing a message automatically” on page 9-14
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Assigning a priority to a message automatically
Assigning priorities to your mail helps you identify the importance of a 
message. You can sort messages with a higher priority so they appear at 
the top of their folder. You can also show these messages in a different 
color. 

By default, all incoming messages are labeled Priority 1.

You can set the name and color of each priority level in the Preferences 
dialog box. For more information, see “Setting priority preferences” on 
page 10-14.

To set a priority automatically:

1. Select Set priority.

.

2. Choose a priority from the pop-up menu.

Filing a message automatically
Filing messages automatically can help you organize your incoming 
messages. 

To file a message automatically: 

1. Select File message. 

2. Hold down the mouse button on the  icon and choose a folder from 
the pop-up menu of folders that appears. Or, click the icon to select a 
folder from the Select a Folder dialog box. 

The name of the folder you have selected appears to the right of the 
 icon. 

For more information about the Select a Folder dialog box, see 
“Filing messages from a message list” on page 7-8.

3. Optionally, select or deselect Create a new auto-file log entry.

Use this option if you want Claris Emailer to create an auto-file log 
for automatically filed messages. 
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An auto-file log is a message that tells you where Claris Emailer stored 
your automatically filed messages. The log is placed in the Logs folder. 
You can set a preference to have log files placed in the In Box folder. 
For more information, see “Setting file and folder preferences” on 
page 10-13.

When you open an auto-file log, it acts like any other message list 
window. You can sort, delete, assign priorities to, and open messages 
from the auto-file log window. 

Important If more than one mail action files the same message, 
duplicates are made and filed into each specified folder. For more 
information, see “Using multiple mail actions” on page 9-14.

Creating an automatic reply to a message
You can have a mail action automatically send a reply to a received 
message. Automatic replies are most useful when you want to 
acknowledge received messages but cannot respond to your mail, such 
as when you are on vacation.

To reply to a message automatically:

1. Select Auto reply to message and click Edit reply.

You see the Mail Action Auto Reply dialog box.

Click to reply to everyone
receiving the message

Click to reply only to the sender

Type a reply message

Click to add or remove
enclosures
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2. Type your reply in the text box.

If you quote the incoming text, you may want to separate it from the 
reply by leaving at least one blank line at the beginning or end of your 
reply. 

3. Optionally, choose one of the message quoting options from the 
Incoming message quoting pop-up menu.

For more information about quoting text, see “Including text from the 
original message” on page 6-7.

4. Click Save.

Note Messages created by a mail action are saved in the Out Box folder. 
You can send these messages manually or use a schedule. If you plan to 
be away from your computer for long periods of time, be sure to create a 
schedule that sends the mail generated by your mail actions.

Forwarding a message automatically
You can have a mail action automatically forward specific messages that 
you receive. Automatically forwarding a message helps you send 
important messages to other people when you’re away. For example, 
you could forward messages with Project X in the subject to a colleague 
while you are on vacation.

To forward a message automatically:

1. Select Auto forward message and click Forward to.

You see the Mail Action Forwarding Recipients dialog box.

Choose To

Do not quote message Not quote the incoming message in the reply

Quote before reply Quote the incoming message before the reply text

Quote after reply Quote the incoming message after the reply text
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2. Enter the names of the recipients of the forwarded message. 

1 In the Individuals tab, enter the names of the individual recipients 
of the message. For more information about entering recipients, 
see “Addressing a message” on page 5-3. 

1 In the Groups tab, click to place a checkmark next to any groups 
you want to send the message to. (For information about creating 
groups, see “Creating groups” on page 8-9.)

When a mail action automatically forwards a message to a group, the 
message is forwarded to all members of the group at the time the mail 
action is performed, not when you set up the mail action.

3. Click Save.

Click to add a recipient

Click to find a recipient in the
Address Book

Select a recipient and click
to delete from the list

Click to go to the
Groups tab

Choose the account to send the message through

Type a recipient’s name

Click to place a
checkmark next to

selected groups

Click to go to the
Individuals tab
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Adding the sender to the Address Book automatically
To add the sender of the message to the Address Book as an individual 
entry, select Add sender to Address Book.

Adding the sender to a group automatically
To add the sender of the message to a group in the Address Book:

1. Select Add sender to group.

2. Select a group from the pop-up menu of groups you have created.

Tip You can use Add sender to group and Remove sender from group to 
manage a simple mailing list.

Removing the sender from a group automatically
To remove the sender of the message from a group in the Address Book:

1. Select Remove sender from group.

2. Select a group from the pop-up menu of groups you have created.

Tip You can use Add sender to group and Remove sender from group to 
manage a simple mailing list.

Running an AppleScript document automatically
You can use AppleScript documents to automate Claris Emailer in a 
variety of ways. For more information about creating AppleScript 
documents, see the documentation that came with your system software.
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To run an AppleScript document as part of a mail action:

1. In the Finder, place the AppleScript document in the AppleScripts 
folder, which is located in the Claris Emailer Files folder in the 
Claris Emailer Folder.

2. In the Action Entry dialog box, select Run AppleScript and choose the 
AppleScript document from the pop-up menu.

Important AppleScript cannot report success or failure to Claris Emailer.

Printing a message automatically
To print an incoming message, select Print message.

The message is printed using the default page setup specified in the 
preferences. For more information, see “Setting defaults preferences” on 
page 10-9.

Editing mail actions
To change a mail action:

1. Choose Mail Actions from the Setup menu.

You see the Mail Actions List window.

2. Double-click the name of the mail action you want to edit.

3. Follow the instructions provided in “Creating mail actions” on 
page 9-1.

Using multiple mail actions
The order of mail actions affects how your incoming messages are 
processed. After all incoming messages are downloaded, the messages 
are processed by your mail actions in the order the mail actions appear 
in the list.

In general, place the most important actions or the ones you always want 
performed at the top of the list. For example, if you always want 
messages from your supervisor prioritized, you can move that mail 
action to the top of the list.
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By default, when a received message meets the criteria of a mail action, 
only that action occurs; no additional mail actions test the message. 
However, if the Stop mail actions if criteria met option is unchecked, the 
message is processed by the next mail action.

If any of your mail actions have the Stop mail actions if criteria met option 
unchecked, the same type of action could occur twice. For example, one 
message might generate two automatic replies or be filed twice. 

Note If two or more automatic filing actions are performed on one 
message, the message is duplicated and filed in each selected folder.

Specifying a hierarchy for mail actions
To change the order of your mail actions, drag a mail action to a new 
place in the Mail Actions list. 

When you drag a mail action, you see a heavy line showing where the 
action will be placed. 

Option selected Option deselected

Message 
meets 
criteria

Specified actions are performed 
and the message is not processed 
by any other mail action

Specified actions are performed 
and the message is processed by 
the next mail action

Message 
does not meet 

criteria

Specified actions are not 
performed and the message is 
processed by the next mail action

Specified actions are not 
performed and the message is 
processed by the next mail action
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Enabling and disabling mail actions
When a mail action is disabled, it is not performed on any incoming 
messages.

Mail actions are enabled by default when you create them. A mail action 
is enabled when you see the checkmark in the  column in the Mail 
Actions List window, and disabled when the  column is empty. Click 
in the  column to enable and disable mail actions.

Deleting mail actions
To delete a mail action:

1. In the Mail Actions List window, select the mail action to delete.

2. Click the  button in the toolbar or press the Delete key.

Importing and exporting mail actions
You can create mail action documents and share them with other 
Claris Emailer users.

To export a mail action to a file that you can share with others:

1. Select the mail action in the Mail Actions List window.

2. Choose Save As File from the File menu.

3. Name the mail action file, choose a location to save the file, and click 
Save.

The file is saved in the location you chose. The name of the saved file 
does not have to be the same as the name of the mail action.

Click next to a mail action
to enable or disable it

Select to disable all mail actions

These actions are enabled
This action is disabled
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To import a mail action that has been saved as a file, drag the file from 
the Finder to the Mail Actions List window in Claris Emailer. The mail 
action is added to the Mail Actions list.

Mail action examples
Use the following mail action examples to help you get started writing 
your own mail actions. 

Example 1: Using the Vacation mail action
Claris Emailer comes with one mail action ready to go (but turned off). 
The Vacation mail action sends an automatic reply to anyone who sends 
you email while you are on vacation. 

To use this mail action, choose Mail Actions from the Setup menu. You 
see the list of mail actions. If you haven’t changed the mail actions yet, 
you see the Vacation mail action with no checkmark next to it. 

To turn the mail action on, click once in the  column. The checkmark 
next to the mail action indicates that the mail action is enabled.

To edit the mail action, double-click it in the list. You can edit the 
criteria used to decide whether to perform the action, or you can change 
the action that is performed. To edit the message that is sent in the reply, 
click Define Actions and then click Edit reply.

For more information, see “Setting mail action criteria” on page 9-4 and 
“Setting actions for criteria-met mail” on page 9-8.

Click here to enable this
mail action
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Example 2: Enhancing the Vacation mail action
The Vacation mail action in Example 1 sends a reply to every message 
you receive while you are on vacation. In some cases, it may send the 
vacation reply to the same person repeatedly. For instance, if a 
co-worker sends you updates on your project for you to read when you 
return, the Vacation mail action sends the vacation reply every time.

Important Before you begin this example, disable the Vacation mail 
action in the mail actions list window.

You can create a series of mail actions that allow you to send your 
vacation reply only once to any particular person.

First, you must create a group in the Address Book that will contain the 
names of the people who send you mail while you are on vacation.

1. Click the  button in the toolbar or choose Address Book from the 
Window menu.

2. Click New Group.

3. For Group name, type Vacation reply sent.

4. Save the group.

The group is empty when you create it. However, if there are people 
you never want to send your vacation reply to, you can add them to 
the group now.

The next time you go on vacation, delete all members of this group and 
turn on your vacation mail actions.

Now you are ready to create the mail action that will send your vacation 
reply. 

1. Open the Mail Actions list by choosing Mail Actions from the Setup 
menu.

2. Create a new mail action by clicking New.

3. For Mail action name, type Vacation reply.

4. In the Criteria area, choose All mail from the leftmost pop-up menu.

5. Click Define Actions.

6. Select Auto reply to message and click Edit reply.

7. Compose your reply and click Save.
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8. Select Add sender to group and choose Vacation reply sent from the pop-
up menu of groups.

Now, everyone you send a vacation reply to will be automatically 
added to the “Vacation reply sent” group.

9. Click Save in the Action Entry dialog box and Save in the Mail Action 
Entry dialog box.

You are now ready to create the mail action that will ensure that you 
send your vacation reply only to those who haven’t yet received it.

1. If it is not already open, open the Mail Actions list by choosing 
Mail Actions from the Setup menu.

2. Create a new mail action by clicking New.

3. For Mail action name, type In Vacation group.

4. In the Criteria area, choose From from the first pop-up menu and Is in 
specific group from the second pop-up menu.

5. Choose Vacation reply sent from the pop-up menu of groups that 
appears.

This mail action is applied to mail from anyone in the “Vacation reply 
sent” group. Remember that anyone who receives a vacation reply is 
added to the “Vacation reply sent” group. 

6. Leave the Actions area blank. 
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7. Make sure that Stop mail actions if criteria met is selected.

Important You must select this option in order for this series of mail 
actions to work correctly.

8. Click Save.

Finally, put these mail actions together by putting them in the proper 
order in your Mail Actions list.

1. If it is not already open, open the Mail Actions list by choosing 
Mail Actions from the Setup menu.

2. Drag the In Vacation group mail action upward so that it appears just 
above Vacation reply in the Mail Actions list.

When you are ready to go on vacation, make sure that both mail actions 
are enabled.

Note You may want to apply other mail actions while you are on 
vacation. For instance, you may still want to prioritize your supervisor’s 
messages and file Project X messages in the Project X folder. If so, leave 
your current mail actions active and add the In Vacation group and 
Vacation reply mail actions after your other mail actions.



Chapter 10:  Customizing Claris Emailer settings

This chapter provides step-by-step instructions for customizing 
Claris Emailer, including:

1 setting up destinations to make typing addresses faster

1 creating location settings so you can use Claris Emailer wherever 
you go

1 creating one or more signatures so you can quickly and consistently 
add closing information to your messages

1 using AppleScript documents to automate operations

1 setting a variety of preferences

Customizing the destinations list 
Claris Emailer routes your mail over the Internet. Claris Emailer lets 
you define shortcuts, called destinations, for commonly used Internet 
domain names. 

For example, “claris.com” is the domain name for Claris Corporation. 
Destinations let you use “Claris” instead of the Internet domain name. 
You’ll find it helpful to create destinations for the places to which you 
frequently send electronic mail.

Shortcuts (destinations) Full domain names
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Adding or changing a destination
You can add or change destinations for any domain name.

Note You should not change the Internet domain names for the 
following destinations: America Online, AppleLink, CompuServe, 
Internet, or RadioMail.

To add or change a destination:

1. Choose Destinations from the Setup menu.

You see the Destinations List window.

2. To add a new destination, click New. To change an existing 
destination, double-click the destination name. 

You see the Destination Entry dialog box.

3. Type the name of the destination.

4. Type the Internet domain name for the destination in the Internet 
domain name text box.

The Internet domain name should contain everything after the @ sign 
in an email address, but should not contain the @ sign. For example, 
“aol.com” is the domain name for America Online accounts.

5. Click Save.

Deleting a destination
Before you delete a destination, be sure the change does not affect 
addresses in your Address Book. 

Important If an address in the Address Book uses the destination you 
delete, that address is no longer valid.

Note You cannot delete destinations for America Online, AppleLink, 
CompuServe, the Internet, and RadioMail.
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To delete a destination:

1. Choose Destinations from the Setup menu.

You see the Destinations List window.

2. Select the destination to be deleted and click the  button in the 
toolbar or press the Delete key. 

Changing location settings
If you use Claris Emailer on a PowerBook computer or removable hard 
disk and travel to different places, you may need to change your 
connection information as you change locales. To do this, create a 
location for each place you use Claris Emailer. When you create 
locations in Claris Emailer, you can quickly change connection 
information at any time. You do this by selecting a new location in the 
Locations List window.

Note If you do not use Claris Emailer in multiple locations or need to 
change any connection information, then you probably don’t need to 
use locations. 

Creating or changing locations
You should create a location for each place where you plan to use 
Claris Emailer that requires different connection information. You can 
also use locations to change connection information, such as the baud 
rate for your modem, even if you do not travel with Claris Emailer. 

To create or change a location:

1. Choose Current Location from the Setup menu, and then choose 
Edit Locations.

You see the Locations List window.
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2. Click New to create a new location. Or, double-click the location 
name to change an existing location.

You see the Location Entry dialog box.

3. Type the new or changed name of the location. For example, you 
could use the city name.

4. Type the local three-digit area code number in the Local area code text 
box.

Important This area code helps you identify the location, but is not 
used when Claris Emailer dials a number.

5. For each service, choose the connection from the pop-up menu on the 
right.

Choose a connection

Click to display a 
pop-up menu of 
connections
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The connections in the pop-up menu were defined when you set up 
connection information for the service. To add or change connection 
information, choose Edit Connections from the pop-up menu. You see 
the Service Entry dialog box for that service. For information about 
creating or changing services, see chapter 3, “Setting up 
Claris Emailer.”

6. Click Save.

Selecting locations
When you select a location, you change the information Claris Emailer 
uses to connect to your email services.

Important If you change your location, be sure that the schedules you 
create are still valid for the new location. For more information about 
schedules, see “Scheduling account connections” on page 4-3.

To select a different location, choose Current Location from the Setup 
menu, and then choose a location from the submenu. The selected 
location is marked with a checkmark in the submenu and the  icon in 
the Locations List window.

You can also select a different location in the Locations List window by 
clicking in the  column next to the new location.

Deleting locations
To delete a location:

1. Choose Current Location from the Setup menu and then choose 
Edit Locations.

You see the Locations List window.

Shows the location
currently in use
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2. Select the location to delete, and click the  button in the toolbar 
or press the Delete key. 

Note You cannot delete the currently selected location.

Setting up your signatures
Use signatures to add closing information for your outgoing messages. 
A signature often includes your name, company name, and mailing 
address. Some signatures also include a phone number, the address of a 
Web page, or a favorite quotation.

You can create several signatures to use for different types of messages. 
For example, you can create personal and business signatures. You can 
also specify signatures to be used by default for messages sent from each 
of your email accounts.

For information about adding a signature to an outgoing message, see 
“Adding a signature” on page 5-12. For information about setting a 
default signature for each account you use, see chapter 3, “Setting up 
Claris Emailer.”

To create a signature:

1. Choose Signatures from the Setup menu.

You see the Signature List window.

2. Click New to add a new signature. Or, to edit an existing signature, 
double-click the signature name in the list.

You see the Signature Entry window.
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3. Type a name in the Signature name text box.

4. Type your signature in the scrolling text area.

5. Click Save.

Using AppleScript documents
You can write AppleScript documents to automate Claris Emailer and 
its interactions with other scriptable applications. You can then run the 
AppleScript documents from mail actions, schedules, or the  menu, 
or set a preference to run an AppleScript document when you receive 
new mail.

To make an AppleScript document available for use from within 
Claris Emailer, you must place it in the AppleScripts folder, which is 
located in the Claris Emailer Files folder in the Claris Emailer Folder.

Sample scripts are located in the Support Files folder in the 
Claris Emailer Folder. For more information about writing AppleScript 
documents, refer to the documentation that came with your computer.

For information about
running AppleScript scripts See

From mail actions “Running an AppleScript document automatically” on 
page 9-13

From schedules “Scheduling account connections” on page 4-3

When you receive new mail “Setting mail notification preferences” on page 10-13
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Setting preferences
You can use the Preferences dialog box to customize the way you work 
in Claris Emailer. For example, you can set how often Claris Emailer 
permanently deletes mail from the Deleted Mail folder. 

To set preferences, choose Preferences from the Setup menu to display 
the Preferences dialog box and then click a category in the Category list 
on the left. Then select the options you want. When you are done setting 
preferences, click OK. 

For information about specific preferences, see the remaining sections 
in this chapter.

By default, the Claris Emailer Preferences file, which keeps track of the 
preferences you set in the Preferences dialog box, is stored in the Claris 
folder in your System Folder. If you use Claris Emailer on a removable 
disk, or if you use more than one copy of Claris Emailer on the same 
computer, you might want to keep a “local” copy of the Claris Emailer 
Preferences file in the Claris Emailer Folder.

To use a local preferences file, copy the Claris Emailer Preferences file 
from the Claris folder in the System Folder into the Claris Emailer 
Folder. The local copy of the preferences file takes precedence over a 
preferences file in the System Folder.

Click a category to
see the preferences

it contains
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Setting defaults preferences
To view or change defaults preferences, choose Preferences from the 
Setup menu and click Defaults in the Category list.

You can use defaults preferences to bypass certain dialog boxes, such as 
the dialog box that asks you to confirm deletions. You can also set 
default options for the page setup and for startup actions.

To Do this 

Connect to a service every time 
you start Claris Emailer

Select Connect using. Then choose Connect Now to connect as 
you would if you chose Connect Now from the Mail menu. 
Or, choose a schedule name to connect immediately using 
the service and account settings in a connection schedule.

Important If you select Disable all schedules in the Schedules 
List window, this preference is disabled and no schedule 
will run at startup. For more information, see “Enabling and 
disabling schedules” on page 4-6.

Have Claris Emailer remember 
the locations of currently open 
windows the next time you 
start the application

Select Restore previous window positions.

Show or bypass the dialog box 
you see when you delete 
messages or other items

Select or deselect Confirm when deleting.

Important If you deselect this option, and then delete a 
message or other item, you cannot cancel or undo the action. 

Show or bypass the dialog box 
you see when you save an 
outgoing message that has no 
subject

Select or deselect Confirm when sending a message with no 
subject.

Show or bypass the dialog box 
you see when you save an 
outgoing message that has no 
body text or enclosures

Select or deselect Confirm when sending a message with no text 
or enclosures.

Show or bypass the dialog box 
you see when you close an 
incoming message that you 
have changed

Select or deselect Confirm when closing a modified incoming 
message.

Specify the page setup options 
that are used when you choose 
Print One from the File menu or 
print a message using a mail 
action

Click Default Page Setup, select the options you want as 
defaults in the Page Setup dialog box, and then click OK.
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Tip You can bypass confirmation dialog boxes and alert messages by 
pressing the Option key when you choose the menu item or click the 
button that opens the dialog box or alert message. For example, if you 
select the preference to show the Confirm Deletion dialog box, you can 
bypass this dialog box by pressing the Option key when you delete an 
item.

Setting incoming message preferences
To view or change incoming message preferences, choose Preferences 
from the Setup menu and click Incoming messages in the Category list.

You can use incoming message preferences to specify how 
Claris Emailer handles mail you receive.

To Do this 

Decompress enclosures when you 
receive them

Select Automatically decompress enclosures. If you 
deselect this preference, the enclosures remain 
compressed. To decompress the files later, you must 
use a decompression application.

Show the headers pane when 
opening incoming messages

Select Show headers by default.

Specify how much information 
appears in the headers pane

Select either Short headers or Long headers.

Set where Claris Emailer stores or 
files your messages

Choose options from the Place new log messages, After 
reading a message, and After replying to a message 
pop-up menus. 
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Setting outgoing message preferences
To view or change outgoing message preferences, choose Preferences 
from the Setup menu and click Outgoing messages in the Category list.

You can use outgoing mail preferences to customize how Claris Emailer 
handles messages you send.

Setting reply preferences
To view or change reply preferences, choose Preferences from the Setup 
menu and click Replies in the Category list.

You can use reply preferences to customize how Claris Emailer handles 
replies to incoming messages.  

To Do this

Turn file compression for outgoing 
message enclosures on or off

Select or deselect Compress enclosures by default.

Show the Send Now Setup dialog 
box when you click Send Now

Select Prompt for connection information. 

Set the default setting of the Send 
Now Setup dialog box, and set the 
behavior if you deselect Prompt for 
connection information

Select either Just send the message or Send the message 
and get all waiting mail.

Set where Claris Emailer files your 
sent messages

Choose an option from the After sending a message pop-
up menu. This option applies only to messages sent 
from the Out Box folder.

To Do this

Always quote the entire text of the 
message you are replying to in your 
reply

Select Quote all text of the original message by default.

Insert an attribution line at the 
beginning of a quote

Select Use attribution line when quoting and create the 
attribution line by typing text and selecting tags from 
the pop-up menu.

You can select the following tags: <date>, <sender>, 
and <sender address>.

For example, you can create this attribution line:

“On <date>, <sender> (<sender address>) wrote:”

In this example, the attribution line in the reply might 
be:

“On 1/1/97, Jane Smith (jsmith@aol.com) wrote:”
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Setting font and color preferences
To view or change font and color preferences, choose Preferences from 
the Setup menu and click Font and color in the Category list.

You can use font and color preferences to specify the font and font size 
used in all message windows, and to set the colors used in quoted text in 
incoming messages.

Set where Claris Emailer places the 
insertion point when you quote text

Select or deselect Put the insertion point after the quoted 
text. If you deselect this option, the insertion point is 
placed above the quoted text.

Display a dialog box to choose 
between “Reply to sender” and 
“Reply to sender and all other 
recipients”

Select Ask whether to reply to sender only or all recipients.

Specify who receives replies by 
default 

Select either Sender only or Sender and all recipients.

Specify which account a reply is 
sent from by default

Select either Send each reply via the account that received 
the message or Send all replies via the default account.

For more information about setting your default 
account, see “Setting up account information” on 
page 3-4.

To Do this

Set the default font and font 
size for messages

Choose a font from the Font pop-up menu, and choose a font 
size from the Size pop-up menu. 

It’s best to choose a monospaced font, such as Monaco or 
Courier, because most mail messages are formatted using 
monospaced fonts. With a monospaced font, you can use 
spaces to line up columns of text. 

The font and font size you choose are used in the body of 
both incoming and outgoing messages. 

Set the colors used for quoted 
text in incoming messages

Click the sample color box for each level of quoted text. 
Then select options from the dialog box for setting colors. 

To Do this
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Setting mail notification preferences
To view or change mail notification preferences, choose Preferences 
from the Setup menu and click New mail notification in the Category list.

You can use mail notification preferences to customize what happens 
when you receive new mail. 

Note You can play only sounds that are currently installed in your 
system. To install a sound, drag it into your System Folder.

Setting file and folder preferences
To view or change file and folder preferences, choose Preferences from 
the Setup menu and click Files and folders in the Category list.

You can use file and folder preferences to set a schedule to empty your 
Deleted Mail, Sent Mail, and Read Mail folders, and to specify a 
location for downloaded enclosures.

The location of the Claris Emailer Files folder is displayed for your 
information. To open the Claris Emailer Files folder from within 
Claris Emailer, choose Open Special from the File menu and then choose 
Emailer Files Folder. The folder is opened in the Finder.

To Do this

See a flashing  icon in the 
upper-right corner of the 
screen when you receive 
messages

Select Blink icon in menu bar.

(You see the icon only when Claris Emailer is open but is not 
in the foreground.)

Hear a tone when you receive 
messages

Select Play sound and choose a sound from the pop-up menu.

Run an AppleScript document 
when you receive messages

Select Run AppleScript and choose an AppleScript document 
from the pop-up menu. For more information, see “Using 
AppleScript documents” on page 10-7.

To Do this

Set where enclosures you receive are 
stored

Click Set, select a folder or disk from the dialog box, 
and then click Select folder.

Permanently delete mail from the 
Deleted Mail folder when quitting 
Claris Emailer

Select Deleted Mail. Then either select All messages or 
select Messages that are ___ days old and enter the 
number of days.
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Setting mail action preferences
To view or change mail action preferences, choose Preferences from the 
Setup menu and click Mail actions in the Category list.

You can use mail action preferences to customize how Claris Emailer 
handles automatic replies and automatic filing.

Setting priority preferences
To view or change priority preferences, choose Preferences from the 
Setup menu and click Priorities in the Category list.

You can use priorities preferences to rename and set the color for the 
priority designations for incoming messages. (You see a message’s 
priority in the message list.)

Permanently delete mail from the 
Sent Mail folder when quitting 
Claris Emailer

Select Sent Mail. Then either select All messages or 
select Messages that are ___ days old and enter the 
number of days.

Permanently delete mail from the 
Read Mail folder when quitting 
Claris Emailer

Select Read Mail. Then either select All messages or 
select Messages that are ___ days old and enter the 
number of days.

To Do this

Specify whether Claris Emailer will 
send automatic replies (generated by 
mail actions) to mailing lists

Select or deselect Do not automatically reply to mailing 
lists.

This preference affects only CompuServe and Internet 
accounts.

Create a log of messages that are 
filed by mail actions

Select Create a new auto-file log entry by default.

For more information, see “Filing a message 
automatically” on page 9-9.

To Do this

Set the color for a priority Click the sample color box next to the priority you 
want to change. Then select options from the dialog 
box for setting colors.

Rename a priority Delete the old name and type a new one.

To Do this
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Setting TCP control preferences
To view or change TCP control preferences, choose Preferences from the 
Setup menu and click TCP Control in the Category list.

Important These preferences apply only if you are using PPP or SLIP 
software and a modem to connect to your service provider.

Claris Emailer cannot terminate (hang up) a dial-up TCP connection by 
itself. If you want to make sure that TCP connections made during 
scheduled connections are hung up, you must do the following:

1 In the TCP control preferences, activate the TCP control plug-in for 
your connection utility. Claris Emailer ships with TCP control 
plug-ins for several common connection utilities.

1 Select Use TCP control in the Schedule Entry dialog box for each 
schedule that requires TCP control. For more information, see 
“Scheduling account connections” on page 4-3.

You can use TCP control preferences to activate TCP control, designate 
a plug-in, and specify whether or not your TCP control plug-in will hang 
up a connection that it did not open. 

To Do this

Activate your TCP control plug-in Select TCP control enabled.

Designate the TCP control plug-in 
to use

Choose a plug-in from the pop-up menu. 

If the TCP Control plug-in for your connection utility 
does not appear in the pop-up menu, make sure that 
the plug-in is located in the TCP Plug-ins folder in the 
Claris Emailer Files folder in the Claris Emailer 
Folder.

Have your TCP control plug-in hang 
up even when Claris Emailer did not 
open the connection

Select Hang up even if connection was already open. If 
you do not select this option, your TCP control 
plug-in will not hang up a connection that it did not 
open.



Appendix A: Encoding enclosures

“Encoding an enclosure” means converting a computer file to a text-
only format that you can send over the Internet. 

Why use encoding?
As messages travel over the Internet, they pass through email gateways 
on different computers. If a gateway receives a message with an 
enclosure (also known as an attachment), but doesn’t understand the 
format of the enclosed file, the gateway guesses the format and encodes 
the enclosure accordingly. If the gateway guesses wrong and encodes 
the enclosure incorrectly, the enclosure might not be readable when it 
reaches its destination.

When you specify an encoding format that is compatible with the 
recipient’s computer, you ensure that your enclosures arrive at their 
destination in the correct format. 

Choosing an encoding format
Claris Emailer provides several encoding formats. Find out what 
operating systems and email services your recipients use, and then use 
the following guidelines to choose an encoding format. (Use the first 
option that applies to your situation.)

If Choose

The recipient’s service is the same as the 
service you’re sending the message through 

Service default.

For instance, use this option when sending 
from a CompuServe account to another 
CompuServe account.

The recipient uses the Mac OS BinHex

The recipient uses an operating system other 
than the Mac OS

Base 64 or UUEncode

Your service or the recipient’s service 
doesn’t support enclosures

BinHex, which appends the enclosure as text 
in the message body



A-2 Claris Emailer User’s Guide
The following table contains detailed information about each option.

Important Both Base64 and UUEncode can lose the information that 
identifies the file as a Macintosh file. When an encoded file is received, 
it must be decoded by the appropriate Base64 (MIME) or UU decoder. 
The resulting file appears on the Macintosh as a generic file. The 
recipient must know which application can read the file, then start that 
application and use it to open the document.

For information on sending an enclosure with a message, see “Enclosing 
files” on page 5-8. For information on working with enclosures you have 
received, see “Working with enclosed files” on page 6-5.

Encoding option Description

Service default This option transfers file information to the recipient with the default 
encoding used by the destination service. When you use this option, 
Claris Emailer software uses the defaults of the destination’s carrying 
service to encode the enclosures. If the carrying service does not 
encode enclosures, Claris Emailer does not encode the files being 
sent.

BinHex BinHex, sometimes known as “.hqx,” translates both the resource and 
data forks of a normal Macintosh file into a continuous string of 
ASCII-text data. This maintains the Macintosh file type, creator, and 
resource information during file transfer. 

A BinHex encoded file tends to grow larger, but it is efficient for 
Mac OS users because the encoded file retains all of the Mac OS file 
characteristics. 

You can decode a BinHex file with several utilities, such as StuffIt 
Deluxe and StuffIt Expander by Aladdin Systems, Inc. Claris Emailer 
automatically decodes BinHex files when it receives them. After your 
enclosure is decoded, it returns to its original file format and you can 
use it with the Mac OS with no further conversion.

Base64 Use this encoding only when sending a file to someone who has a 
MIME-compliant email application. (MIME stands for the 
Multipurpose Internet Mail Extensions standard.)

UUEncode This UNIX standard is similar to the other encoding methods, except 
that it does not preserve the Macintosh data forks. If the file received 
is an application, you must know the file type and creator codes for the 
application and add them to the file with a file resource editing tool 
such as the Apple ResEdit utility. 

To decode UUEncode files, add “.uu” to the filename, and then open 
the file with a decompression utility that can translate UUEncoding 
(such as StuffIt Expander).
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File compression makes it easier to transfer email enclosures and 
reduces the amount of disk space needed by the computers that transfer 
your messages. The amount of reduction in file size depends on the data 
you are compressing, but is typically around 50%.

File compression software works by analyzing the contents of a file and 
creating a special shorthand for it. When the compressed file arrives at 
its destination, the recipient needs to know what software you used to 
compress the file so that the message can be decompressed. 

Claris Emailer uses StuffIt compression software and compresses 
enclosures by default when you send them. Before sending file 
enclosures, it’s important to know what type of decompression software 
the recipient has.

If the recipient of your 
message uses Enclosures you send

Claris Emailer Are automatically decompressed when they are downloaded.

A different email 
application on a Mac OS 
computer

Might have to be decompressed manually. The recipient must 
have one of the following applications to expand any 
compressed files:

1 Any email client that contains the StuffIt expansion software
1 StuffIt, StuffIt Expander, or UnStuffIt 
1 Compact Pro

An email application on a 
computer that doesn’t use 
the Mac OS

Might not be able to be decompressed. You might not want to 
use Claris Emailer to compress files sent to computers that don’t 
use the Mac OS, because the StuffIt expansion tool is not widely 
available on these computers.



Glossary

account 1. A form of access to a computer or network for 
a specific user name and password. Your account settings 
identify you to your email service. You might have more 
than one account per service if more than one person uses 
this copy of Claris Emailer to connect to the service, or if 
you manage more than one account with the service. 

2. A name that you define for an account when setting up 
your account information in Claris Emailer. If you have 
several accounts for an email service, it’s helpful to give 
them different names (for example, Mom’s account and 
Dad’s account).

3. The full address of your POP account, including the 
name of the POP server (for example, 
your_name@POPserver.host.com).

See also address; domain name.

account ID Your AppleLink online service account.

address Characters identifying an email account and its 
location on the Internet (for example, 
your_name@POPserver.host.com). See also account; 
domain name.

Address Book The Address Book stores addresses for 
individuals and groups that you can use to address 
outgoing messages quickly.

Address field The text box you use to enter the address of 
your recipient in an outgoing message. If you have 
defined the recipient in your Address Book, 
Claris Emailer fills in the address for you as soon as you 
have entered a unique string of characters in the 
Recipient field. See also Recipient field.

announce@claris.com The name and address of the 
electronic product announcement mailing list at Claris 
Corporation. See also list server.

AOLnet A type of network that you can use to connect to 
the America Online online service.

AppleLink package A proprietary enclosure format from 
the AppleLink online service. See also enclosure.

AppleScript A scripting language you can use to control 
functions of the Mac OS and of applications that support 
AppleScript (often called scriptable applications).
ASCII character set American Standard Code for 
Information Interchange. A standard character set used 
by most computer systems around the world (often 
extended for different alphabets).

auto-file log An entry in the Logs folder that tells you 
where Claris Emailer stored your automatically filed 
messages. See also mail action.

background A computer process that takes place out of 
sight and usually at a lower priority than processes 
running in the foreground. When you switch to another 
application but leave Claris Emailer running, the 
program is “running in the background” and can still 
make regularly scheduled connections to download your 
email.

Base 64 A method for encoding files that converts a 
computer file to ASCII for sending it across the Internet 
or to an email service, and converts it back to binary so it 
can be read by the recipient. Use Base 64 encoding if you 
are sending file enclosures to people who use operating 
systems other than the Mac OS.

baud rate The number of times per second that a modem 
changes the signal it sends through a phone line. The 
baud rate is related to how fast data is transmitted.

BCC field (Blind Carbon Copy) The text area where you 
specify additional recipients for a message (as opposed to 
the primary recipient). When you send a Blind Carbon 
Copy, no other recipients can see that you included this 
recipient. See also CC field (Carbon Copy); To field.

BinHex A Macintosh encoding method that converts a 
binary computer file to ASCII for sending it across the 
Internet or to an email service, and converts it back to 
binary so it can be read by the recipient. Use BinHex 
encoding if you are sending file enclosures to other 
Mac OS users.

Browser window The main Claris Emailer window 
where you work with lists of mail messages.

CC field (Carbon Copy) The text area where you specify 
additional recipients for a message (as opposed to the 
primary recipients). See also BCC field (Blind Carbon 
Copy); To field.
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Claris Emailer Notifier A file in the Claris Emailer 
Folder that contains the email notifier software for use 
with Claris OfficeMail. See also notifier.

Claris OfficeMail An email server product that works 
with Claris Emailer on a LAN-based network. 
Claris OfficeMail manages and directly transfers your 
messages to other local Claris OfficeMail users. You can 
connect Claris OfficeMail to the Internet with ClarisLink 
or another Internet service provider to send messages 
outside the LAN. See also local area network (LAN).

ClarisLink An Internet service you can purchase to use 
with Claris OfficeMail for email access to the Internet.

client A computer that requests information from another 
computer to which it is connected over a network.

client/server architecture The relationship between two 
networked computers that share resources. The client 
requests services from the server, and the server provides 
services to the client.

Comm Toolbox See Macintosh Communications 
Toolbox.

compression See file compression.

Connect Again A menu item in the Mail menu that 
initiates a connection to email services exactly as you 
specified the last time you chose Connect Now. See also 
Connect Now.

Connect Now A menu item in the Mail menu that initiates 
a connection to email services. If you have accounts with 
more than one email service and you choose Connect Now, 
you can choose which email accounts you want to access 
during this connection. See also Connect Again.

connection error An error message that Claris Emailer 
displays for you in the Logs folder. Most connection 
errors come directly from your email service provider, 
not from Claris Emailer. See also connection log.

connection file In America Online, AppleLink, and 
CompuServe setup, the file that tells your computer how 
to communicate across the network, either through your 
modem or another communication tool (such as a Telnet 
tool).

connection information The connection settings that tell 
Claris Emailer about your modem type and the phone 
number to dial to reach your email service. You might 
have several connections if you connect to your service 
provider from more than one location, such as at home or 
when you travel.

connection log A message that is delivered to you from 
Claris Emailer when a connection error occurs. See also 
connection error.

connection schedule Connection times that you define 
so that Claris Emailer downloads your email from your 
email service at regular intervals. You can specify a 
timed connection schedule, which connects at a specific 
time you designate, or a repeating connection schedule, 
which connects at a specific interval (for example, every 
30 minutes).

contact A record of information about a person or 
organization you keep in touch with. This information 
can include name, email address, and a description. You 
can keep a list of contacts in the Address Book.

criteria See test (in a mail action).

data fork The portion of every Macintosh file that 
contains a user’s data, such as text. See also resource 
fork.

Default send via A setting in the Accounts List window 
that lets you specify a default account for sending email. 
See also Send via.

Deleted Mail folder A folder that stores copies of all mail 
you delete. You can set a preference to delete mail 
permanently from the Deleted Mail folder at regular 
intervals.

Description field A field in the Address Book that lets 
you enter notes about an address. For example, you might 
use the Description field to remind you of a contact’s 
affiliation or association.

destination A shortcut in Claris Emailer for frequently 
used Internet domain addresses. For example, you can 
choose the destination Apple from the Destinations pop-
up menu instead of typing @apple.com after the 
recipient’s name in the Address field.

Destinations file A file in the Claris Emailer Files folder 
that stores the destinations that come with Claris Emailer 
and any destinations that you define.
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dial type The kind of output your phone makes, either 
pulse or tone, when dialing a number.

dialing in Using a modem to dial the phone number of an 
email service so that you can connect and download 
email.

domain name A name for the IP address that describes a 
location of a computer on the Internet. A domain name 
specifies the name of a server at an email service and the 
domain and sub-domains (separated by periods) to which 
it belongs. For example, in the address 
announce@claris.com, claris.com is the domain name. 
Com is an abbreviation for “commercial” and is a top-
level domain used for commercial businesses. See also 
account; address.

downloading Moving your email messages or enclosures 
from a server at your email service provider onto your 
personal computer.

Downloads folder A folder that stores all enclosures 
when they are downloaded from an email service 
provider.

draft messages Messages in progress that you have 
saved to a folder, but not put in the connection queue. 
See also queued messages.

drag and drop Technology available for Macintosh 
System 7 or later that lets you select an item, drag it to a 
qualified area, and release the mouse button to move or 
copy the item. In Claris Emailer, you can drag and drop 
messages, addresses, enclosures, and text (in certain 
areas).

Easy Setup A step-by-step process for setting up or 
changing your service and account information.

email Electronic mail. A system for transmitting 
messages from one computer or terminal to another. A 
message sent from one computer user to another is stored 
in the recipient’s account mailbox until that person logs 
onto the system and reads the message.

email name Your email account name for 
Claris OfficeMail.

email service A service that provides access to an email 
server, which sends and receives messages. See also 
Internet service provider (ISP); online service.

enclosure A file attached to an electronic message.

encoding Converting a file into code so you can send it 
across the Internet or through online services.

encoding format The rules by which a file is encoded 
before being sent across the Internet. Claris Emailer 
supports three encoding formats: BinHex, Base 64, and 
UUEncode.

encrypting Transforming data in a message or file into a 
form that can’t be read without a secret encryption key. 
Encryption increases the security of message or file 
content. Claris Emailer does not encrypt messages.

exporting addresses Saving the contents of the 
Claris Emailer Address Book to a text file to share the 
information with another application.

file compression A process of compacting the content of 
a file enclosure to make the information easier to transfer 
and store as it travels across the Internet.

Filter text box A text entry area in the Address Book that 
you can use to search for characters (such as a name) in 
the Address Book.

find statement  An option used in Claris Emailer Help 
for searching Help contents for specific words. See also 
operator.

forwarding Sending another user a copy of a message that 
someone has sent you. When you forward a message, the 
text of the original message is included in the body of the 
new message you create.

free space The area of unused space on your hard disk.

gateway A computer that provides a connection between 
two networks and reformats data so that it is compatible 
with both networks.

header The rows of text at the beginning of an email 
message that indicate who the message is from, who it’s 
to, when it was sent, and its subject matter.

Help navigator window   The window that appears when 
Claris Emailer Help is first opened. You can search for 
specific words or view Help contents, as in a table of 
contents of a book, in this window.

Help topic window  The window that contains Claris 
Emailer Help information on a specific subject.

host See server.
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importing addresses Adding addresses from another 
mail program’s address book or from a text file to the 
Claris Emailer Address Book.

In Box folder The folder where your new messages are 
stored by default when Claris Emailer downloads them 
from your email service.

initialization string (init string) A group of characters 
sent to a modem to prepare it to make a connection with 
another modem.

Internet The combination of all computers and networks 
that can be reached using an Internet email address.

Internet Config (Internet Configuration System) A tool 
available from online services that allows Internet 
applications to share a common setup.

Internet header See header.

Internet service provider (ISP) A vendor that provides 
direct access to the Internet. The user reaches an ISP 
either by dialing up with a computer, modem, and phone 
line, or by connecting over a dedicated line. Examples of 
ISPs are Netcom and EarthLink. See also email service; 
online service.

IP address A numerical Internet protocol address that 
uniquely identifies each computer linked by the Internet.

LAN See local area network (LAN).

list server A computer that maintains a type of 
automated mailing list used for information exchange 
between a group of people with a common interest. You 
can subscribe to a mailing list that posts messages to all 
subscribers. See also announce@claris.com; newsgroup; 
post.

local area network (LAN) A short-distance data 
communication network (typically within a building or 
campus) that provides sharing of computers, email, and 
peripheral devices (such as printers and modems). See 
also Claris OfficeMail.

local server An email server on a local area network. 

location A method in Claris Emailer for setting up local 
access numbers for remote sites so you can quickly and 
easily collect email when you travel.

logging in Connecting to a computer at an email service 
provider for the purpose of downloading messages.

Logs folder A folder that contains incoming connection 
logs (typically connection errors) and auto-file logs (from 
mail actions) from Claris Emailer.

Mac Comm Toolbox (Macintosh Communications 
Toolbox)  A standardized set of communications tools 
(for file transfer, terminal emulation, and connection 
settings such as modem or Telnet) used by applications 
such as Claris Emailer to adjust connection settings.

Mac OS The operating system for Macintosh and 
compatible computers.

Mac PPP (Point-to-Point Protocol) One implementation 
of the PPP protocol for the Macintosh often used to 
support TCP/IP. PPP establishes, monitors, and 
terminates communications between two devices that are 
usually connected through some kind of serial link. This 
link is often a pair of modems and a phone line, but can 
also be ISDN modems, a serial cable, and so on.

mail action A process in Claris Emailer that compares 
each incoming message to a set of criteria and then 
performs a function, such as filing or forwarding the 
message. See also auto-file log.

mail notification 1. The way Claris Emailer announces 
that you have new email. The default mail notification is 
a flashing icon in the menu bar and an audible tone, but 
you can change the settings.

2. The way Claris OfficeMail announces that you have 
new email and that Claris Emailer should connect and 
download it.

MIME Multipurpose Internet Mail Extension. A standard 
method of formatting messages that lets you send and 
receive mixed-media files (such as text plus color 
pictures, video, sound, and binary data).

modem A device that enables your computer to 
communicate through telephone lines to another modem 
on another computer.

monospaced font A font, such as Monaco or Courier, that 
uses an equal amount of lateral space for each character.

name Your name as defined in the first Easy Setup screen 
in Claris Emailer. Some email services use this name to 
help identify you in messages you send.

network A group of computers or peripheral devices 
(such as printers) that are connected by a 
communications channel.



Glossary G-5
network zones A list of active networks where you can 
choose a Claris OfficeMail server, if one does not appear 
by default when you set up your OfficeMail connection 
information.

newsgroup An Internet discussion group where 
subscribers have email conversations about a topic of 
common interest. See also list server.

notifier A component of Claris OfficeMail that lets 
Claris Emailer know when it receives a message for you. 
See also Claris Emailer Notifier.

online service A type of email service that uses 
proprietary protocols for communication between 
computers. Online services typically maintain databases 
of information that you can access if you have an account 
with the service, and provide access to information on the 
Internet. Examples of online services are America Online 
and CompuServe. See also email service; Internet service 
provider (ISP).

Open Transport (OT) A technology from Apple 
Computer, Inc. that provides enhanced networking.

operator   A function word (such as “and” or “or”) used 
to perform a search in Claris Emailer Help for specific 
topics. See also find statement.

Out Box folder A folder where you can store outgoing 
messages that will be mailed during the next connection. 
Queued messages are saved by default in the Out Box 
folder, but you can save them in any folder and they will 
be sent at the next connection.

password A secret code you specify that restricts access 
to your email service account. A secure password is one 
that is easy for you to remember, but makes use of 
uppercase and lowercase characters and numerals and is 
not a real word (for example, 24’damonEE).

PDN Routing In AppleLink setup, the public data 
network for the transmission of digital data (as opposed 
to voice data) in packets over high-speed channel phone 
lines.

POP server A computer at an Internet service provider 
location that maintains your email account information 
and allows you to connect using Claris Emailer and 
download your messages. See also SMTP server.

Post Office Protocol (POP) A standard application 
protocol for retrieving electronic mail from Internet 
service provider vendors. Claris Emailer uses POP3 
technology. See also protocol; Simple Mail Transfer 
Protocol (SMTP).

posting  Sending a message to a mailing list or 
newsgroup on the Internet. See also list server.

PPP (Point-to-Point Protocol) A protocol that 
establishes, monitors, and terminates communications 
between two devices that are usually connected through 
some kind of serial link. This link is often a pair of 
modems and a phone line, but can also be ISDN modems, 
a serial cable, and so on. See also protocol; SLIP.

preference A way to customize your Claris Emailer 
settings and personalize your email environment. For 
example, you can use preferences to change the tone you 
hear when new email arrives or to turn off the tone 
completely.

preferred address An address that you mark in the 
Address Book as the primary (default) address to use 
when sending a message to a person who has more than 
one address.

priority A label you can apply to a message to help you 
identify or sort messages.

protocol Conventions or rules for communication 
between computers. See also Post Office Protocol (POP); 
Simple Mail Transfer Protocol (SMTP); SLIP; TCP/IP; 
UUCP.

public domain A legal term applying to software 
applications and information that are available free of 
charge on the Internet and through online services.

queued messages Unsent messages that are stored in 
folders and are waiting to be sent at the next connection.

quoting Including text from a previous message.

Read Mail folder A folder where you can store messages 
after you open them. To use this folder, you must set a 
preference.

Recipient field The text box you use to type the name of 
the person you are sending mail to. See also Address 
field.
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replying  Answering a message that someone has sent 
you. 

ResEdit A file resource editing tool from Apple 
Computer, Inc. 

resource fork The portion of every Macintosh file that 
contains system information about the file, such as the 
application that created it. See also data fork.

schedule See connection schedule.

screen name Your account name with the America 
Online online service.

Send via A feature that lets you override the 
Default send via setting in the Accounts List window and 
send a message through a particular account. See also 
Default send via.

Sent Mail folder The default folder that stores messages 
that you have sent.

server A computer that gives information or services to 
another computer connected to it over a network.

service See email service; Internet service provider; 
online service.

Services List window The window you use to select an 
email service and set up or change connection 
information.

signature Text you can append to the end of an outgoing 
message. A signature often includes your name, a 
company name, and a Web page URL.

SLIP (Serial Line Internet Protocol) A protocol that lets a 
personal computer use the Internet protocols over a 
standard phone line and modem. See also PPP; Protocol.

SMTP (Simple Mail Transfer Protocol) A standard 
application protocol for exchanging electronic mail 
between Internet service provider computers. See also 
Post Office Protocol (POP); protocol.

SMTP server A computer at an Internet service provider 
location that exchanges mail with SMTP servers at other 
Internet service provider locations. See also POP server.

Sprintnet A type of network that you can use to connect 
to the America Online online service.

StuffIt An application that compresses enclosures to save 
time and disk space during email transfer across the 
Internet. For your convenience, Claris Emailer includes 
the StuffIt compression software.

surcharge warning A warning that you will have an 
additional charge on your CompuServe account invoice 
if you take a particular action. Claris Emailer warns you 
when such charges might occur, or you can disable the 
warning if you prefer.

System number A country-specific identification 
number for your AppleLink setup.

tab-delimited text file A text file containing columns of 
information separated by tab characters. Many 
applications can export tab-delimited text files, and the 
Claris Emailer Address Book accepts data in this format. 
(This format is also known as tab-tab-return or TTR.)

TCP/IP Transmission Control Protocol/Internet Protocol. 
A set of rules and procedures for linking computers 
across many kinds of networks. TCP/IP is the protocol 
used by the Internet. See also protocol.

Telnet A communications protocol that allows you to log 
in to a remote computer over the Internet.

test (in a mail action) In mail actions, the criteria that 
you set to tell Claris Emailer whether or not to perform an 
action on an incoming message.

text clipping A file created when you drag text from an 
application to the desktop. You can drag text clippings to 
certain areas of applications that support drag and drop. 
See also drag and drop.

To field The text entry area where you specify the 
primary recipient of a message. See also BCC field 
(Blind Carbon Copy); CC field (Carbon Copy).

toolbar A collection of buttons that issue commands for 
the most common tasks in Claris Emailer. Toolbar 
buttons give you different options, depending on the 
window you’re working in.

triangle An icon in Claris Emailer you click to open or 
close part of a window or dialog box. The triangle has a 
different orientation for open or close.

UNIX A multiuser, multitasking operating system.

UnStuffIt An application that decompresses files.
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URL (Uniform Resource Locator) An address identifier 
for a site on the Internet, such as a World Wide Web page 
or an email address.

user identification number (User ID) Your account 
identifier with the CompuServe online service.

UUCP A protocol for transferring data (such as email) in 
batches between two UNIX sites. UUCP is almost always 
used for communication between sites connected by 
modems. See also protocol.

UUEncode A method for encoding files that takes a 
computer file, converts it to ASCII for sending it across 
the Internet or to an email service, and converts it back to 
binary so it can be read by the recipient. Use UUEncode 
encoding if you are sending file enclosures to people who 
use operating systems other than the Mac OS.

volume An internal or external disk connected to your 
system. When you search for a file, you can choose a 
volume by name from the Volume pop-up menu.
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Index

Symbols

@ sign 2-4

A
accelerators. See keyboard shortcuts, 
displaying

account names, described 2-4
account options

Claris OfficeMail 3-12 to 3-13
CompuServe 3-16
Internet service providers 3-18

accounts
adding 3-4
deleting 3-6
described 3-2
editing 3-4
email services 2-2
listing 3-4
scheduling connections to 4-3
sending messages through 
specific 5-13

setting a connection order for 3-6
accounts, setting up

America Online 3-8
AppleLink 3-1, 3-10
Claris OfficeMail 3-11
CompuServe 3-16
described 3-4 to 3-5
Internet service providers 3-17
RadioMail 3-21

actions on received mail 9-1
adding

accounts 3-4
addresses to groups 8-11 to 8-12, 
9-13

addresses to messages 5-3 to 5-8
addresses to the Address Book 8-2 
to 8-9, 9-13

attachments to messages 5-8 to 
5-11

contacts to the Address Book 8-2 
to 8-9

destinations 10-2
enclosures to messages 5-8 to 5-11
adding (continued)
entries to the Address Book 8-2 to 
8-12

folders 7-3
groups to the Address Book 8-9 to 
8-15

locations 10-3
mail actions 9-1
quotes to a reply 6-7
recipients to messages 5-3 to 5-7
schedules 4-3
sender addresses to the Address 
Book 8-4, 9-13

signatures 5-12, 10-6
subfolders 7-3
text to messages 5-1

Address Book
See also addresses; contacts; 
groups

adding addresses from 5-5 to 5-7
adding addresses to 8-2 to 8-9, 
9-13

adding contacts to 8-2 to 8-9
adding groups to 8-9 to 8-15
adding senders to 8-4, 9-13
addressing messages with 5-5 to 
5-7

deleting entries 8-15
described 2-16, 8-1
dragging entries to messages 5-6
exporting addresses 8-15
filtering 8-14
importing addresses 8-6 to 8-9
opening 8-1
searching for an address 8-14

Address Book toolbar button 2-11
addresses

See also contacts; groups; 
recipients

adding to the Address Book 8-2 to 
8-9, 9-13

converting to URLs 8-16
deleting 8-3, 9-13
deleting from groups 8-13
described 2-4
dragging 2-17, 5-6 to 5-7, 8-5, 
8-12

exporting 8-15

addresses (continued)
filtering in the Address Book 8-14
finding 5-5, 8-14
formats of 5-6
from other applications 8-6 to 8-9
grouping 8-9 to 8-15
importing 8-6 to 8-9
maximum number of 5-3
preferred 8-3
selecting 5-6
showing and hiding 5-2, 6-4
sorting 8-13, 8-15
using in other applications 
(exporting) 8-15

addressing messages
choosing a destination 5-4
described 5-3
to Claris OfficeMail 2-7, 6-12

alert, for incoming messages 10-13
America Online

accounts, setting up 3-8
address book 8-6
connecting to 3-6, 4-1
connection files 3-7
importing addresses from 8-6
retrieving mail from 4-1
scheduling connections to 4-3
sending mail via 5-13
service, setting up 3-6
TCP/IP connection 3-7

annotations, in onscreen Help 1-8
announce@claris.com, described 2-4
APOP authentication 3-20
AppleLink

accounts, setting up 3-1, 3-10
address book 8-7
connecting to 3-9, 4-1
connection files 3-9
and enclosures (outgoing) 5-9
and enclosures (incoming) 6-5
retrieving mail from 4-1
scheduling connections to 4-3
sending mail via 5-13
service, setting up 3-9

AppleScript
and schedules 4-4
described 10-7
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AppleScript (continued)
mail actions with 9-13
menu 10-7
running when mail arrives 10-13
using with Claris Emailer 10-7

arrows, next or previous message 6-4
ASCII text files. See text files
assigning priorities 7-9, 9-9
attaching files. See enclosing files
attachments. See enclosures
attribution lines, for quoted text 6-8, 
10-11

authentication, for Internet 3-20
auto-file logs

deleting 7-10
described 9-10
icon for 5-21
viewing 9-10

B
backing up, messages 2-8
Base64

Claris OfficeMail and 3-12
described A-2
encoding messages with 5-12
Internet accounts and 3-19

BCC (blind carbon copy) 5-7
beep, for incoming messages 10-13
BinHex

Claris OfficeMail and 3-12
described A-2
encoding messages with 5-12
Internet accounts and 3-19

blind carbon copies 5-7
Browser

See also filed messages
displaying 7-1
message status icons 2-9
opening 7-1
resizing columns 7-7
resizing Folder list 7-4
viewing selected folders 7-4

browsing through messages 6-4
buttons

See also toolbar
displaying keyboard shortcuts 
for 1-10

toolbar 2-10

bypassing alert messages 10-9

C
carbon copies 5-7
categories. See prioritizing
CC (carbon copy) 5-7
changing locations 10-3
changing status of outgoing 
mail 5-18, 5-19

checking spelling 2-12, 5-15 to 5-16
Claris customer assistance 1-1
Claris Emailer

automating 10-7
connection log 4-7
customizing 10-1
described W-1, 2-1
flashing icon 6-1
folders 7-2
icon 2-9
new features W-1
onscreen Help 1-2 to 1-9
overview W-1
quitting during a connection 4-7
setting up 3-1
sounds 6-1
starting 2-9
troubleshooting 4-7
using in different locations 10-3

Claris OfficeMail
account options 3-12 to 3-13
accounts, setting up 3-11
addressing messages 2-7, 6-12
and the Address Book 8-1
choosing a server 3-11
connecting to 2-6, 3-10, 4-1
default encoding 3-12
receiving messages 6-10
retrieving mail from 4-1
scheduling connections to 4-3
sending mail to 5-13
sending mail via 5-13
service, setting up 3-10
troubleshooting 6-11

Claris technical support 1-1
ClarisLink

addresses 6-12
described 2-6, 3-1

client, described 2-2
client/server, described 2-1

clippings, text. See text clippings
clock icon 5-18, 5-21
closing the Browser 2-9
collecting mail

at scheduled times 4-3
manually 4-1

colors
for priorities 10-14
for quotes 10-12

columns, resizing 7-4, 7-7
communication

between computers 2-2
over the Internet 2-1

composition window 5-2
compressing files 5-11, B-1
compression

described 2-8, B-1
setting 5-11

CompuServe
account options 3-16
accounts, setting up 3-16
address book 8-6
connecting to 3-14, 4-1
importing addresses from 8-6
retrieving mail from 4-1
scheduling connections to 4-3
sending mail via 5-13
TCP/IP connection 3-15

confidential recipients. See blind 
carbon copies

Connect Again menu item 4-2
Connect Now menu item 4-1
Connect Now toolbar button 2-10
connecting

again 4-2
errors while 4-7
getting your messages 4-1
immediately 4-1
now 4-1
quitting during 4-7
scheduling connections 4-3
through email services, 
described 2-5

when you start 
Claris Emailer 10-9

connecting to
America Online 3-6
AppleLink 3-9
Claris OfficeMail 2-6, 3-10
CompuServe 3-14
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connecting to (continued)
email services 3-1, 4-1
Internet service providers 3-17
RadioMail 3-20

Connection Error toolbar button 2-11
connection files

America Online 3-7
AppleLink 3-9

connection logs
deleting 7-10
troubleshooting 4-7 to 4-9

Connection type pop-up menu 4-3, 
4-5

connection types, understanding 4-3
connections

executing 4-1 to 4-6
executing on a schedule 4-3
repeating 4-3
scheduling 4-3 to 4-5
status of 4-7
timed 4-3
timing 4-3

contacts
See also Address Book; addresses
adding to the Address Book 8-2 to 
8-9

creating groups 8-9
deleting from the Address 
Book 8-15

contents, in onscreen Help 1-3
copies, of sent mail. See Sent Mail 
folder

copying
entire messages 6-7
text in messages 5-14, 6-7

Courier font 10-12
creating new messages 5-1
criteria, in mail actions 9-4
customer assistance 1-1

D
data, encoding for transfer 2-8
database backup 2-8
date received (incoming 
messages) 10-10

decompression 10-10
default

dialog box options 10-9

default (continued)
folders 7-2
font 10-12

default encoding
Claris OfficeMail and 3-12
Internet accounts and 3-19

Default send via, described 3-5
definitions, viewing in onscreen 
Help 1-9

Delete toolbar button 2-11
Deleted Mail folder

and deleted messages 7-10
properties of 7-2
schedule for 10-13

deleted messages, retrieving 7-10
deleting

accounts 3-6
addresses from messages 5-3
addresses from the Address 
Book 8-3, 8-15

destinations 10-2
enclosures (incoming) 6-6
enclosures (outgoing) 5-12
folders 7-3
groups 8-15
locations 10-5
mail actions 9-16
messages 7-10, 10-13
recipients from outgoing 
messages 5-3

schedules 4-6
Description field 8-3, 8-10
destinations

adding or changing 10-2
deleting 10-2
described 2-13
specifying in addresses 5-4, 8-3

dialog boxes
bypassing 10-9
onscreen Help for 1-9

dictionaries, for checking 
spelling 5-16

directory. See Address Book
disabling

mail actions 9-16
schedules 4-4, 4-6

disconnecting from a service 4-7
disk space B-1
displaying

error messages 4-8

displaying (continued)
headers pane 6-4
Internet headers 6-4
messages 6-4

documentation, overview 1-1
documents. See files
domain names 2-4
download options

Internet service provider 3-13, 
3-19

downloading
enclosures 6-6, 10-13
messages 4-1

Downloads folder 6-5, 10-13
draft message icon 5-21
draft messages 5-19
drag and drop. See Macintosh drag and 
drop

dragging
addresses 5-6 to 5-7, 8-5, 8-12
enclosures 5-10, 6-6
mail actions 9-15, 9-17
text 5-14, 6-10
text and objects 2-17
text clippings 5-7, 8-6

E
Easy Setup, described 3-1
editing

accounts 3-5
Address Book 8-2 to 8-12
folders 7-3
incoming messages 6-4
locations 10-3
mail actions 9-14
schedules 4-3
service information 3-3

electronic mail. See filed messages; 
incoming messages; outgoing 
messages

email. See filed messages; incoming 
messages; outgoing messages

email accounts, setting up 3-4 to 3-6
email services

described 2-2
disabling 3-4
for outgoing mail 5-13
scheduling connections to 4-3
setting up 3-2 to 3-4
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Emailer, Claris. See Claris Emailer
emptying folders 7-11, 10-14
enabling

mail actions 9-16
schedules 4-6

enclosing files 2-8, 5-8 to 5-12
enclosure icon 5-22
enclosures

adding 5-8 to 5-12
BinHexing 5-12, A-1 to A-2
compressing B-1
default folder for 10-13
deleting (incoming) 6-6
deleting (outgoing) 5-12
downloading 6-5, 10-13
dragging (incoming) 6-6
dragging (outgoing) 5-10
encoding 2-8, 5-12, A-1 to A-2
finding (incoming) 6-5
finding (outgoing) 5-10
formats for A-1 to A-2
forwarding 6-9
moving 6-6
opening 6-6
options for 5-11

encoding
Base64, described A-2
BinHex, described A-2
choosing formats A-1
Claris OfficeMail, specifying 
in 3-12

described 2-8, A-1
Internet accounts, specifying 
in 3-19

recommendations A-1
Service Default, described A-2
specifying 5-12
UUEncode, described A-2

entering addresses
in messages 5-1 to 5-6
in the Address Book 8-2 to 8-9

error logs. See connection logs
errors

error messages 4-8
icon for 5-21
receiving 4-7
troubleshooting 4-7

Eudora, importing addresses from 8-6
eWorld, importing addresses 
from 8-6

exclamation point icon 5-21
Execute Schedule menu item 4-6
executing

connections 4-1 to 4-6
mail actions 9-1, 9-16
repeating connections 4-5
schedules 4-3 to 4-6

expanding compressed files 
(enclosures) 5-11, B-1

exporting
addresses 8-15
mail actions 9-16

F
features, new in Claris Emailer W-1
Fewer Choices button

in mail actions 9-7
in onscreen Help 1-6

file compression. See compression
file enclosures. See enclosures
file formats

for enclosures 5-9, 5-11, A-1 to 
A-2

for importing addresses 8-6 to 8-7
retaining in enclosures 2-8, A-2

file logs. See auto-file logs
File Message toolbar button 2-11
filed messages

See also Browser; incoming 
messages; outgoing messages

backing up 2-8
default font 10-12
deleting 7-10, 10-13, 10-14
dragging 2-17
finding 7-11 to 7-12
forwarding 6-9
labeling 7-9
moving 7-8 to 7-9
opening 6-4
printing 7-10
prioritizing 7-9
reading 6-4
sorting 7-7
viewing 2-14, 7-5

files
compressing 5-11, B-1
enclosing 2-8, 5-8 to 5-12
encoding 5-12, A-1

Filing Cabinet. See Browser
filing messages

automatically 9-9
described 2-17
from message lists 7-8 to 7-9
incoming 6-9
outgoing 5-14

Filter text box 2-16, 5-5, 8-14
filtering

incoming mail 9-1
messages 9-1

Find tab, in onscreen Help 1-5
Find toolbar button 2-11
finding

addresses 5-5, 8-14
enclosures 5-10
messages 7-11 to 7-12
text 7-11

flashing Claris Emailer icon 6-1
folders

as enclosures 5-8, 5-11
creating 7-3
default 7-2
deleting 7-3
described 7-2
emptying 7-11, 10-14
filing messages 7-8 to 7-9, 10-10 
to 10-11

marked 7-3
renaming 7-3
setting up 7-3
subfolders 7-3
viewing contents 2-14, 7-5
viewing in Browser 2-9, 7-1
viewing in Folder List window 7-1
viewing selected 7-4

font
color for priorities 10-14
for messages 10-12
monospaced 10-12

formats of addresses 5-6
formats, file. See file formats
Forward toolbar button 2-11
forwarding messages 6-9, 9-11
frequency, of connection 
schedule 4-3

G
getting help 1-2 to 1-9
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getting your messages
manually 4-1
on a schedule 4-3

glossary, using 1-9
groups

See also Address Book; addresses
adding senders automatically 9-13
creating 8-9 to 8-15
deleting addresses from 8-13, 9-13
deleting from the Address 
Book 8-15

described 2-16
sorting 8-13

H
headers of messages, hiding and 
showing 6-4

Help navigator window 1-2
Help topic window 1-2
Help. See onscreen Help, using
hiding

address area 5-2
alert messages 10-9
enclosures 5-8
message headers 6-4
onscreen Help window 1-3
the address area 6-4

History Window, accessing in 
onscreen Help 1-8

host, described 2-2

I, J
icons

address 5-3, 5-22
AppleScript menu 10-7
Claris Emailer 2-9
enclosure 5-22
flashing, Claris Emailer 6-1
incoming messages 6-1
message status in Browser 2-9
outgoing messages 5-21
preferred address 8-3
Queue Message 2-13
Save As Draft 2-13
text clippings 2-18

immediately sending a message 5-17
importing addresses

from other applications 8-6

importing addresses (continued)
from text files 8-7 to 8-8

In Box folder 2-14, 6-1, 7-2
including quotes in a reply 6-7
incoming messages

See also filed messages; outgoing 
messages

adding sender to the Address 
Book 8-4, 9-13

beep for 10-13
browsing through 6-4
copying text from 6-7
date and time received 10-10
default font 10-12
deleting 7-10
dragging 2-17
editing 6-4
filing 6-9, 7-8
filing automatically 9-9, 10-10
filtering 9-1
finding 7-11 to 7-12
forwarding 6-9, 9-11
handling 9-1, 10-10
icons for 6-1
labeling 7-9, 9-9
opening 6-4
printing 7-10, 9-14
prioritizing 7-9, 9-9
quoting 6-7
reading 6-4
receiving 2-14, 6-1, 6-2
replying to 6-6, 9-10
saving as text files 6-10
seeing a list of 6-1, 7-5
setting handling preferences 10-10
sound, changing 10-13
troubleshooting 4-7 to 4-9
viewing 2-14, 6-4

index, in onscreen Help 1-4
Internet

ASCII character set 2-8
connecting to 4-1
described 2-1
domain name 2-4
headers 6-4
POP 2-3
protocols 2-2
retrieving mail from 4-1
sending messages via 5-8
SMTP and POP 2-3

Internet config
signatures, America Online 3-8

Internet config (continued)
signatures, AppleLink 3-10
signatures, Claris OfficeMail 3-12
signatures, CompuServe 3-16
signatures, Internet service 
providers 3-19

signatures, RadioMail 3-21
using 3-18

Internet domain names
described 2-4
entering for setup 3-18
shortcuts for 2-13

Internet service providers
account options 3-18
accounts 3-17
connecting to 3-17, 4-1
described 2-2
retrieving mail from 4-1
scheduling connections to 4-3
sending mail via 5-13
setting up for 3-2 to 3-4, 3-17

K
keeping copies of sent mail. See Sent 
Mail folder

keyboard shortcuts, displaying 1-10
keywords, in onscreen Help index 1-4

L
labeling messages 7-9, 9-9

See also prioritizing
LANs 2-6
Leave mail on server option

Claris OfficeMail 3-13
Internet service provider 3-19

list servers 2-4
local area code 10-4
local area networks 2-6
locations

adding 10-3
changing connection 
information 10-4

deleting 10-5
described 10-3
editing 10-3
listing 10-3
selecting 10-5
using 10-3
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Logs folder 7-2
logs. See auto-file logs; connection 
logs

long headers, showing 6-4

M
Macintosh drag and drop 2-17
MacTCP, setting up 3-22
mail. See filed messages; incoming 
messages; outgoing messages

mail actions
advanced tests 9-6
and AppleScript 9-13
comparing text 9-5
creating 9-1 to 9-14
criteria 9-4
deleting 9-16
described 2-15, 9-1
disabling 9-16
dragging 9-15, 9-17
editing 9-14
enabling 9-16
examples of 9-17
executing 9-1, 9-16
exporting 9-16
naming 9-2
ordering 9-15
preset 9-17
prioritizing 9-15
setting criteria 9-4
setting up 9-1 to 9-14
sharing with other users 9-16
sorting 9-14 to 9-15
turning on and off 9-16

mail filters. See mail actions
mail handling

See also mail actions
setting preferences for 10-10

mail notification, setting options 
for 3-13, 10-13

mail. See messages
mailing lists. See groups; list servers
managing windows 1-3
marked folders 7-3
message headers, hiding and 
showing 6-4

message lists
deleting messages 7-10
printing 7-10

message lists (continued)
resizing columns 7-7
searching 7-11 to 7-12
sorting 7-7
viewing 7-5

message priorities
assigning 7-9, 9-9
setting 10-14

message recipients. See addresses; 
recipients

messages. See filed messages; 
incoming messages; outgoing 
messages

Methods pop-up menu 3-15
MIME, described A-2
mobile computing 10-3
modems

accessing email services 
through 3-21

connecting with 2-5
hanging up 10-15
troubleshooting 4-8

Monaco font 10-12
monospaced fonts 10-12
More Choices button

in mail actions 9-6
in onscreen Help 1-6

moving
address to the Address Book 8-5
addresses to a group 8-12
addresses to a message 5-6 to 5-7
enclosures (incoming) 6-6
enclosures (outgoing) 5-10
messages to folders 7-8, 10-10 to 
10-11

text 5-14, 6-10

N
name, of a recipient 5-4, 5-5
naming

folders 7-3
groups 8-10
mail actions 9-2
schedules 4-5

networks
accessing Internet through 3-17
connecting with 2-5

new features of Claris Emailer W-1
New Message toolbar button 2-11

new messages 5-1
See also incoming messages

Next button, in onscreen Help 1-8
next message, viewing 6-4
notes, adding to onscreen Help 
topics 1-8

notification 3-13

O
online help. See onscreen Help, using
online services

described 2-2
destination 5-4
scheduling connections to 4-3
setting up for 3-2 to 3-4

onscreen Help, using 1-2 to 1-9
opening

Address Book window 8-1
Browser window 7-1
enclosures 6-6
folders 2-14
messages 6-4
onscreen Help 1-2

options
See also preferences
for accounts 3-4
for enclosures 5-11

order of mail actions 9-15
Out Box folder 7-2
Outgoing Message window 5-2
outgoing messages

See also filed messages; incoming 
messages

adding and removing 
enclosures 5-8 to 5-12

addressing 5-3 to 5-8
addressing to Claris OfficeMail 
users 2-7, 6-12

creating 5-1
default font 10-12
filing 5-14
filing automatically 10-11
icons for 5-21 to 5-22
personalizing 5-12
pre-addressed 5-1
saving 5-16 to 5-20
saving as text files 5-20
saving without sending 5-19
sending 5-16 to 5-20
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outgoing messages (continued)
signatures in 5-12, 10-6
status of 5-21
troubleshooting 4-7 to 4-9
with no subject or body 4-9, 10-9

P
Page Setup dialog box 7-10, 10-9
page size and orientation 7-10, 10-9
paperclip icon 5-22
partially downloaded messages 6-2
pasting text as a quotation 6-8
pencil icon 5-19, 5-21
platforms, communicating 
between 2-2

plug-ins, TCP control 10-15
POP (Post Office Protocol), 
described 2-3

pop-up definitions, viewing in 
onscreen Help 1-9

Post Office Protocol, described 2-3
postponing messages. See Save As 
Draft

PowerBook
computers 10-3
modems 3-14

PPP settings 3-21
pre-addressed messages 5-1
preferences

changing 10-8
displaying 10-8
for signatures 10-14
setting 10-8 to 10-15

preferred address 8-3
previewing addresses to be 
imported 8-8

Previous button, in onscreen Help 1-8
previous message, viewing 6-4
Print One menu item 7-10
Print toolbar button 2-11
printing messages 7-10, 9-14
prioritizing

described 7-9
incoming messages 7-9, 9-9, 
10-14

mail actions 9-15
messages 7-9

prioritizing (continued)
preferences for 10-14
setting up priorities 10-14

problems, troubleshooting 4-7
protocols, described 2-2

Q
queueing messages 5-18
quitting

during a connection 4-7
onscreen Help 1-3

quoting
a message 6-7
attribution lines for 6-8
in automatic replies 9-11

R
RadioMail

accounts, setting up 3-21
scheduling connections to 4-3
service, setting up 3-20

ranges, selecting 7-7
Read Mail folder 7-2
reading messages 6-4
received messages. See incoming 
messages

recipient types
blind carbon copy (BCC) 5-7
carbon copy (CC) 5-7

recipients
See also Address Book; addresses
adding to a message 5-3 to 5-7
deleting from outgoing 
messages 5-3

finding in the Address Book 5-5
maximum of 5-3
types of 5-7

registering your software 1-1
related topics, displaying in onscreen 
Help 1-8

removing
addresses from messages 5-3
addresses from the Address 
Book 8-15

enclosures (incoming) 6-6
enclosures (outgoing) 5-12

renaming
priorities 10-14
text clippings 2-18

repeating connections
described 4-3
setting up 4-3 to 4-5

Reply toolbar button 2-11
replying

automatically 9-10
to a message 6-6
with a quote 6-7 to 6-8

resizing columns 7-4, 7-7
retrieving messages. See connecting
return address, setting

Internet service providers 3-18
returned messages 4-7
running a schedule 4-3, 4-6

S
Save As Draft

icon 5-21
option 5-19

saving
See also exporting addresses
addresses in the Address Book 8-4
groups 8-10
mail actions 9-3
messages 5-16 to 5-20, 10-9

schedules
adding 4-3
deleting 4-6
described 4-3
editing 4-4
enabling and disabling 4-6
executing 4-3, 4-6
frequency of 4-3
naming 4-5
repeating 4-3
running 4-3, 4-6
selecting accounts 4-5
timed 4-3
using multiple 4-3
using TCP control with 4-5

scheduling
connections 4-3
outgoing messages 5-18

scripts. See AppleScript; mail actions
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searching
for addresses 5-5
for enclosures 5-10
for text 7-11
onscreen Help 1-5

selecting
addresses in a message 5-6
addresses in the Address 
Book 8-14

enclosures 5-9
noncontiguous items 7-7
a preferred address 8-3
unread mail folders 6-1

Send Now button 5-17
send via

described 5-13
setting default 3-5

senders, adding to the Address 
Book 8-4, 9-13

sending
compressed files 5-11, B-1
enclosures 5-8 to 5-12
messages 4-2, 5-16 to 5-20
showing status 5-21

Sent Mail folder 7-2
sequence

of account connections 3-5
of mail actions 9-14 to 9-15

server
described 2-2
for Claris OfficeMail 3-11

server, storing messages on
Claris OfficeMail 3-13
CompuServe 3-17
Internet service provider 3-19

Service Default, encoding 
formats A-1 to A-2

service providers. See Internet service 
providers

services, setting up
America Online 3-6
AppleLink 3-9
Claris OfficeMail 3-10
CompuServe 3-14
Internet service providers 3-17
RadioMail 3-20

setting
date and time 10-10
default send via 3-5
message priorities 7-9, 9-9, 10-14

setting (continued)
options for enclosures 5-11
preferences 10-8

setting up
See also Easy Setup
connections 4-1
destinations 10-1
email accounts 3-4 to 3-6
email services 3-2 to 3-4
locations 10-3
mail actions 9-1
preferences 10-8
priorities 10-14
repeating connections 4-3
schedules 4-3
signatures 10-6

short headers, showing 6-4
shortcuts. See keyboard shortcuts
showing

addresses 5-2
alert messages 10-9
dialog boxes 10-9
enclosures 5-8
error messages 4-8
incoming messages 6-1
message headers 6-4
sending status 5-21
when a message is received 10-10

signatures
choosing 5-12
setting up 10-6

skipping alert messages 10-9
skipping large messages

Internet service providers 3-13, 
3-19

SLIP settings 3-21
SMTP server 2-3
sorting

groups 8-13
messages 7-7
the Address Book 8-15

sounds
Claris OfficeMail and 3-13
for incoming messages 6-1
setting 10-13

spaces, entering with Tab key 5-2
spelling checker 2-12, 5-15 to 5-16
starting

Claris Emailer 2-9, 10-9
onscreen Help 1-2

status
of connections 4-7
of messages you send 5-21

storing
addresses 8-2
groups 8-9 to 8-15
messages, in folders 7-8, 10-13, 
10-14

StuffIt 5-11, B-1
subfolders

creating 7-3
described 7-3
opening 2-14

switching messages 6-4

T
Tab key, in message body 5-2
TCP control

described 10-15
turning on and off 4-5, 10-15

TCP/IP
connection to America Online 3-7
connection to CompuServe 3-15
PPP settings 3-21
SLIP settings 3-21

terminology, in onscreen Help 1-9
tests. See mail actions
text

See also text files
copying in reply 6-7
dragging 2-18, 5-14, 6-10
finding 7-11 to 7-12
font and size (message 
body) 10-12

moving to the Address Book 8-5
pasting as a quotation 6-8
saving messages as 5-20, 6-10
searching for 7-11

text clippings 2-18, 5-6, 5-7, 8-16
text color

for priorities 10-14
for quotes 10-12

text files
See also text
dragging to outgoing 
messages 5-10

exporting to 8-15
importing addresses from 8-7
saving messages as 5-20



Index I-9
time received (incoming 
messages) 10-10

timed connections 4-3
timed messages. See queueing 
messages

tone, for incoming messages 10-13
tool tips 1-10, 2-10
toolbar

See also buttons
described 2-10
displaying in onscreen Help 1-9
displaying onscreen Help for 1-10
names of buttons 2-10

traveling, using Claris Emailer 
while 10-3

troubleshooting
Claris OfficeMail 6-11
connection errors 4-7

turning on and off
mail actions 9-16
schedules 4-6

typing
addresses in a message 5-4
addresses in the Address Book 8-2
text in a message 5-1

U
Unprocessed Mail toolbar 
button 2-10

unread mail, selecting folders 6-1
unscheduled mail 5-19
unscheduled message icon 5-21
UnStuffIt B-1
URLs

converting addresses to 8-16
launching 6-4

Use TCP control checkbox 4-5
user ID, described 2-4
users. See addresses; contacts
using addresses from other 
applications 8-6 to 8-9

UUEncode
Claris Office Mail and 3-12
described A-2
encoding messages with 5-12
Internet accounts and 3-19

V
vacation message, creating 9-17

W, X, Y, Z
World Wide Web 2-2
writing messages 5-1



Scroll to see more 
information

Click to close
the Browser

Click any column to sort messagesDrag to widen the folder list display area

Click to show or hide
subfolders

Envelope icon indicates that
the folder contains unread

or unsent messages

Message list icons indicate
status of message

Click to change sort order

The Browser

Message window
Click to display the next
or previous message in
the list (if the message

has been saved)

Hold down mouse 
to select a folder to 
file this message in

Name of folder this 
message will be filed in

Click to switch between the Queue 
Message and Save As Draft buttons

Trash can icon indicates
that the Deleted Mail folder
contains unread or unsent

messages

Message list status icons
This icon Indicates that the message

In
co

m
in

g

Is an unread incoming message

Is an incoming message that you have replied to

Is a partially downloaded message

Is partially downloaded and will be fully retrieved 
at the next connection

Is partially downloaded and will be deleted from 
the server at the next connection

Is an auto-file log for a mail action

Ou
tg

oi
ng Will be sent at the next connection

Has been saved as a draft

Bo
th Is an outgoing message with an addressing 

error or an unread connection log

Search 
for text

Print messages

File 
messages

Create a new messageConnect now

Display
connection log

DeleteDisplay the 
Address Book

Forward a
message

Show folders with 
unprocessed mail

Reply to a
message

Toolbar

Close the
toolbar

Click to shrink or 
expand toolbar

Click to queue message for next connection (or save 
message as a draft, if Save As Draft button is displayed)

Click to send message immediately

Click to find an address in the Address Book

Click to add a new, blank address line

Click to delete a selected address (button is 
activated when address is selected)

Click to
show or
hide the
recipient

area

Click to
show or
hide the

enclosure
area

Choose an account to send this 
message through



Quick Reference

Keyboard and mouse shortcuts
Most key combinations are displayed in the menus. To use a key 
combination, hold down the first key and then press the next key or 
click the mouse as indicated. For example, to quit Claris Emailer, 
press 2 and then press Q.

To display keyboard shortcuts for buttons in an active Claris Emailer 
dialog box or window, hold down the 2 key for a few seconds.

Working with messages

Incoming messages

Reply to a message 2-R

Forward a message 2-J

Switch between short and long headers Shift-2-H

Outgoing messages

Create a new message 2-N

Save a message to the current folder without 
closing it

2-S

Move the insertion point to the next text entry 
area

Tab

Insert spaces to indent text to the next 
tab stop in the message body area

Tab

Check spelling in a message 2-=

Paste text as a quotation 2-’

Find an address in the Address Book Shift-2-F

Change a message to queued state Shift-2-Q

Change a message to draft state Shift-2-D

Save a message and close the window Enter

Send a message now Shift-2-K

Both incoming and outgoing messages

Display the next message in a list 2-]

Display the previous message in a list 2-[

Delete the current message and display 
the next one

Option-2-]

Delete the current message and display 
the previous one

Option-2-[

File a message Option-2-F

Copy the entire message as text Option-2-C

Print an open message 2-P

Print one copy of the open message Shift-2-P

Copy an address from a message to the 
Address Book 

Shift-2-C
Display or hide the address area Shift-2-R

Display or hide the enclosure area Shift-2-E

Working with message lists

Open selected message(s) Enter, Return, or 
double-click

File a message Option-2-F

Delete a selected message 2-D or Delete

Move the selection up one row Up Arrow

Move the selection down one row Down Arrow

Extend the selection up one row Shift-Up Arrow

Extend the selection down one row Shift-Down Arrow

Scrolling

Scroll up one page Page Up

Scroll down one page Page Down

Displaying windows

Display the Browser 2-B

Display the In Box 2-1

Display the Out Box 2-2

Display the Address Book 2-4

Display the Folder List window 2-L 

Connecting to your email service

Connect now 2-K

Connect again Option-2-K

Miscellaneous actions

Add a new item Shift-2-N

Delete a list item 2-D or Delete

Create a new group in the Address Book Shift-2-G

Cancel a dialog box Esc

Enter selected text into the Find field of the 
Find dialog box

2-E

Check or uncheck a selected list item Right Arrow or 
Left Arrow

Start Claris Emailer Help Help or 2-? 

Working with messages
U96600-026A
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